PREFACE

Thank you for purchasing the GP Screen Editor Software, "GP-PRO/PB III
for Windows Ver. 5.0" for use with Pro-face’s GP series programmable
operator interfaces.

Please read this manual carefully in order to use this software properly, and
be sure to keep this manual handy for future reference.

o ——————————————— — — — — ——— — — — — — —

(1) The copyrights to all programs and manuals included in the GP-PRO/
PB III for Windows Ver. 5.0 (hereinafter referred to as "this product")
are reserved by the Digital Electronics Corporation. Digital grants the
use of this product to its users as described in the "Software Operating
Conditions" documentation, included with this product's CD-ROM.
Any actions violating the above-mentioned conditions are prohibited
by both Japanese and foreign regulations.

(2) The contents of this manual have been thoroughly inspected. How-
ever, if you should find any errors or omissions in this manual, please
inform your local GP representative of your findings.

(3) Regardless of article (2), the Digital Electronics Corporation shall not
be held responsible for any damages or third party claims resulting
from the use of this product.

(4) Differences may occur between the descriptions found in this manual
and the actual functioning of this product. Therefore, the latest infor-
mation on this product is provided in data files (i.e. Readme.txt files,
etc. ) and in separate documents. Please consult these sources as well
as this manual prior to using the product.

(5) Even though the information contained in and displayed by this prod-
uct may be related to intangible or intellectual properties of the Digital
Electronics Corporation or third parties, the Digital Electronics Corpo-
ration shall not warrant or grant the use of said properties to any users
and/or other third parties.

(6) The specifications set out in this manual are for overseas products
only. As a result, some differences may exist between the specifica-
tions given here and for those of the identical Japanese product.

— e o e e e

o ———— — — — — — — — —— — — —— — — —— — — —— — — — — — —

© 2000 Digital Electronics Corporation. All rights reserved.

For the rights to trademarks and trade names, see “TRADEMARK RIGHTS”.

—_———————————————e—e—e——e————————— e ——— — — —~
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TRADEMARK RIGHTS

All company or product names used in this manual are the trade names,
trademarks (including registered trademarks), or service marks of their
respective companies.

This product omits individual descriptions of each of these rights.

Trademark / Trade Name Right Holder
Microsoft, MS, MS-DOS, Windows,

Windows 95, Windows 98, Windows NT,
Windows Explorer, Microsoft Excel 95,

Microsoft Corporation, USA

Windows 2000
Intel, Pentium Intel Corporation, USA

Digital Electronics Corporation
Pro-face

(in Japan and other countries)
Ethernet Western Digital Electric Corporation, USA
IBM. VGA, IBM Compatible International Business Machines

Corporation (IBM), USA

The following terms differ from the above mentioned formal trade names
and trademarks.

Termused in this manual | Formal Trade Name or Trademark
Windows 95 Microsoft® Windows®95 Operating System
Windows 98 Microsoft® Windows®98 Operating System
Windows 2000 Microsoft® Windows®2000 Operating System
Windows NT Microsoft® Windows NT® Operating System
MS-DOS Microsoff® MS-DOS® Operating System
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HOW TO USE THIS MANUAL

B Structure of the Manual CD-ROM

The "Operation Manual" is the first of four manuals for this product and
explains how to use the "GP-PRO/PB III for Windows Ver. 5.0" software
(hereinafter referred to as "this product"). Please refer to all of the manuals
named below when using this product. These manuals can all be found as
PDF files in your “Manual CD-ROM” (#2).

In addition to these manuals, data files containing supplemental information
on updated functions are also provided.To read these additional data files,
click on the [Start] button in your Windows OS main screen and select the
[Programs]—[ProPB3Win] menu. Then, click on the [Read Me] selection.

For detailed information about GP series products, please refer to each GP's
"User's Manual". (Optionally available)

Vol. 1 Operation Manual |pescribes this products operation procedures and all

(this manual) standard functions. (provided as PDF data)

Vol. 2 Tag Reference Describes the function of and detailed setings for all GP-

) Manual PRO/PBIII Tags. (provided as PDF data)

. Describes this products pre-made Parts and symbols.
Vol. 3 Parts List
© ! (provided as PDF data)

Vol. 4 PLC Connection  |pescribes the methods for connecting the GP to other,

) Manual supported manufacturer PLCs. (provided as PDF data)

Screen Data Layout Sheets are useful for designing tag address settings, etc.
and example sheets are installed as part of the GP-PRO/PBIII for Windows
standard installation.

The following two layout sheets, "Device Allocation Table" and "Tag Lay-
out Sheet", are in Microsoft Excel 95 format and are located in the PDF
Manual CD-ROM.

The following folder and file names are used.

Folder Name File Name Contents
propbwin/sheet Device1E .xls Device Allocation Table
TAG1E xIs Tag Layout Sheet
TAGZ2E xlIs
TAG3E xls
TAG4E xIs

For information on the use of Microsoft Excel, please refer to the Excel
software's Users manual.
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B GP Series Product Names ™

The GP-PRO/PBIII functions and settings available will vary, depending on

Preface

the model of GP used. Use the following table to identify your GP.

GP 70
series

Series Product Model
Name
GP-H70L GPH70-LG11-24V
GP-H70 series GPH70-LG41-24VP
GP-H70S GPH70-SC11-24V
GPH70-SC41-24VP
GP270-LG11-24V
GP-270L GP270-LG21-24\P
GP270-LG31-24V
GP-270 series
GP270-SC11-24V
GP-270S GP270-SC21-24\P
GP270-SC31-24V
GP370-LG11-24V
GP-370L GP370-LG21-24\P
GP370-LG31-24V
GP-370 series GP370-LG41-24\P
GP370-SC11-24V
GP-370S GP370-SC21-24\P
GP370-SC31-24V
GP370-SC41-24\P
GP470-EG11
GP-470 series GP-470E GP470-EG21-24VP
GP470-EG31-24V
GP570-SC11
GP-570S GP570-SC21-24\P
GP570-SC31-24V
GP570-TC11
GP-570 series GP-570T GP570-TC21-24VP
GP570-TC31-24V
GP-570L GP570-LG21-24V
GP-570WM GP570-TV11
GP-571T GP571-TC11
GP-57JS GP57J-SC11
GP-675T GP675-TC11
GP-675 series GP675-TC41-24VP
GP-675S GP675-SC11
GP-870 series | GP-870VM GP870-PV11
GP-37W2 series | GP-37W2B GP37W2-BG41-24V

*1 For information about available models in your country, please contact your local

distributor.

v

GP-PRO/PB III for Windows Ver. 5.0 Operation Manual




Preface

GP 70

] Series Product Name Model
series
P377R-TC11-24V
GP-377R series GP-377RT GP3 ¢
GP377R-TC41-24V
GP477R-EG11
GP-477R series GP-477RE
GP77R GP477R-EG41-24\VP
series -
GP-577RT GP577R-TC11
GP577R-TC41-24\P
GP-577R series GP577RSC11
GP-577RS
GP577R-SC41-24\P
GP-2400 GP2400-TC41-24V
GP2500-TC11
. GP-2500T
GP 2000 series GP2500-T C41-24V
GP-2600T GP2600-TC11
GP2600-TC41-24V

B Chapter Breakdown

This manual contains 12 chapters and an appendix.
The following is a general description of each chapter:

€ CHAPTER 1: FUNDAMENTALS OF GP-PRO/PB III FOR WINDOWS
This chapter describes GP-PRO/PBIII operations from start to finish. Also
explains the overall structure of the GP-PRO/PBIII Project Manager and
Screen Editor areas.

@ CHAPTER 2: CREATING BASE SCREENS
This chapter describes the basic operations and terminology used for draw-

9% ¢

ing functions, such as “Part”, “Tag”, “Library”, and “D-Script”.

€@ CHAPTER 3: DRAWING APPLICATIONS: CREATING AND USING
SCREENS
This chapter describes the procedures for creating and using various screens,
such as the M, T, K, X, and I screens, which enable you to create high-
quality images and provide advanced-level functionality.

€ CHAPTER 4: SCREEN AND PROJECT MANAGEMENT
This chapter describes the procedures for editing and saving created screens
and project files, and information management procedure.

€@ CHAPTER 5: CREATING AND EDITING ALARMS
This chapter describes the alarm creating and editing procedures.

€@ CHAPTER 6: GP INITIAL AND SYSTEM SETTINGS
This chapter describes the initial setup procedure required to use a GP series
display unit.

€@ CHAPTER 7: TRANSFERRING SCREENS

This chapter describes the procedure for sending created screens to a GP
series display unit.
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€ CHAPTER 8: SIMULATION
This chapter describes the procedures for simulating the operation between a
GP series panel and a PLC.

@ CHAPTER 9: PRINTING
This chapter describes the procedure for printing created screens.

€4 CHAPTER 10: ADVANCED FEATURES
This chapter describes the procedures for using GP-PRO/PBIII’s advanced
functions such as sound output, filing data (recipe) and logging functions,
and CF Card usage. For the detailed information, refer to Volume 3, Tag
Reference Manual.

€ CHAPTER 11: PROJECT MANAGER HIERARCHICAL DISPLAY
This chapter describes the procedures for using the Project Manager in
hierarchical display mode.

€4 CHAPTER 12: DATA COMPATIBILITY
This chapter describes the procedure for converting existing screens created
with older generation screen editor software (e.g. GP-PRO, GP-PRO II, GP-
PRO III, Parts Box) with GP-PRO/PB III for Windows.

€ APPENDIX

* Error Messages
Lists the error messages that will be displayed during operation of this
product.

* Troubleshooting
Provides a trouble diagnosis and necessary actions to cope with errors or
abnormal operations.

* Address Conversion Tables
Lists the addresses for each manufacturer’s product.

* Software Trouble Report
Write down any trouble you might have with this product here, and send it
to us by facsimile.

vi
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MANUAL SYMBOLS AND TERMINOLOGY

This manual uses the following symbols and terminology.

If you have any questions about the contents of this manual, please contact
your local GP distributor.

Also, If you have any question about your personal computer or Windows,
please contact your PC distributor or manufacturer.

B Safety Symbols and Terms

This manual uses the following symbols and terms to identify important
information related to the correct and safe operation of this product.

Symbol Description
Indicates a potentially hazardous situation that could result in serious injury
or death.

WARNING

Indicates a potentially hazardous situation that could result in minor injury or
equipment damage.

CAUTION
A Indicates a potentially damaging action or dangerous situation that could
! result in abnormal equipment operation or data loss.
Important
= Indicates instructions or procedures that must be performed to ensure
Carefull | correct product use.

Indicates instructions or procedures that must not be performed.

E)l¢

B General Information Symbols and Terms

This manual uses the following symbols and terms for general information.

Symbol Description

@V\ote' Provides hints on correct product use, or supplementary
\gj information.

Indicates an item's related information (manual name, page
number).

Refers to keys on the computer keyboard.
m Keyboard Compatibility List

W Reference .4

IBM . e .
Compatible Indicates a PC that can run the Windows™ operating system.
PLC Abbreviation for Programmable Logic Controller. Includes

programmable logic controllers and sequencers.
Generic name for the "GP Series" of programmable operator
interface made by the Digital Electronics Corporation.
GP For a list of compatible GP products please see "Compatible
Products and Environmental Specifications".

1.2.1 m GP-PRO/PBIIl Features

X1v
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B Keyboard Compatibility List

This manual uses the following symbols to indicate computer keyboard

keys.

The key names used by your computer keyboard may differ. Please use the

chart below for reference.

Type| PS/2 Compatible

Symbol 101 Keyboard
Esc Esc

Tab
Ctrl

T Shift
Alt

Delete

space Backspace

B Typical User Configuration

This manual's description of this software's operating procedures and fea-
tures is based on the PC system configuration shown below.

If you use a different configuration, the PC and GP screens, as well as the
names used for pre-made Parts may differ. In this case, please substitute the
equivalent screen and part names of your system for those given in this

manual.
Hardware/Software Specification Remarks
Personal Computer Windows compatible
Memory 32MB
Mouse Windows compatible mouse
0S Windows 95/98/NT (4.0 or higher)/2000
Host PLC Mitsubishi MELSEC AnAseries (Link) Link type connection
GP GP-477RE/GP-2500T
Recommended Cable:
Connection between RS.2320 GEVY—CBO2 |
the GP and PC Made by Digital Electronics
Corporation

GP-PRO/PB III for Windows Ver. 5.0 Operation Manual

XV



Preface

PRECAUTIONS

B CD-ROM Usage Precautions

To prevent CD-ROM damage or malfunctions, please observe the following
instructions:

Do not remove the CD-ROM from the CD-ROM drive while the drive’s
operation lamp is lit.

Do not touch the CD-ROM recording surface.

Do not place CD-ROMs in a place where they may be exposed to extremely
high or low temperatures, high humidity, or dust.

B Product Usage Precautions

To prevent program malfunction or accidents, be sure to observe the follow-
ing instructions:

/AN .

Warning

:

Touch panel switches should NOT be used for a
device’s Emergency Stop Switch. Generally
speaking, all industrial machinery/systems must
be equipped with a mechanical, manually oper-
ated emergency stop switch. Also, for other
kinds of systems, similar mechanical switches
must be provided to ensure safe operation of
those systems.

Do not turn off your personal computer’s power switch during the execu-
tion of a program.

After you create a screen with this product and transfer it to the GP unit, do
not send the same screen from the GP to a DOS version of this screen
editor software (e.g. GP-PRO/PB Ill, GP-PRO lIl).

Do not change the contents of this product’s project files using the Text
Editor software.

Do not send a screen to a GP unit if that GP does not support the functions
provided by your screen editor software.

@ General GP Restrictions

The GP-PRO/PB III for Windows software displays screen data using your
personal computer’s fonts and graphic functions. Therefore, there may be a
slight difference between the data displayed on your personal computer and
the data displayed on the GP unit after that screen data is sent to the GP.

XVi
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When a GP unit is vertically installed, the panel’s coordinates will differ from those
used on the screen editor software. Therefore, when you enter screen coordinates
using tags or D-Script, please consider the GP’s orientation.

(0. 0) on the screen editor software

(0. 0) on the GP series’ panel

€ Software and GP Setting Controls

Certain functions and setting supported by the GP unit are not supported
by the GP-PRO/PB III for Windows program, and vice versa.

Full size characters in screen data drawn in a Japanese version drawing
environment may no displayed correctly in an English version drawing
environment. If you intend to use the screen data in an English version
drawing environment, use only 1-byte alphanumeric characters.

[Setting and functions items set via the GP unit
(Not by GP-PRO/PB III for Windows) |

- Language Font selection
- GP Date/Time settings
- GP Self-Diagnosis Function

[Functions and setting items supported by GP-PRO/PB III for Win-
dows only (Not by the GP unit)]

The following settings are included in the “GP System Settings” area:

“Checksum Verification” settings

“Buzzer Output” settings

Screen Change according to standby mode time

Screen Change Order in hierarchical display mode

Shift to OFFLINE mode settings

“K-tag” processing settings

GP unit’s internal memory (LS area) backup function settings
“Error Display Reset”

“Watchdog”

Control word address settings in “CF Card Data Save”

“Q-tag” settings (Display format, Print Settings, and Alarm Trigger
Count Write’s Start Address/Processing Performed at GP power-ON/
Perform External Operations/Q-tag: Time Character addition (format)
Communication Monitoring Period settings (Designate transmis-
sion wait time)

Data address setting for CF Card free space indicator

Data Backup settings

Display Colors setting

Serial code reader (LS storage start address/Read complete bit
address/Data storage setting)
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@ PLC Feature Restrictions (with GP-PRO/PBIII for Windows ML Ver. 5.0)

The following GP-PRO/PBIII for Windows 5.0 features, even though they
can be set using the GP-PRO/PBIII software, are currently not supported for
the following PLCs. Be sure to check that your type of PLC supports the
features you wish to use on the GP prior to creating your GP-PRO/PBIII for
Windows project data.

PLC Types
Items SIEMENS Rockwell <Allen-Bradley> Modicon
ST20PP | gy | oaes | R aser | Sove | P

Data Transfer Settings @) X X X @) @) X

Operation Envir. Settings (@) X X X X X X

Use System Area (@) (@) (@) X (@) (@) (@)

Use Read Area @) @) @) X @) @) @)

32 Bit Access (o) (o) X O (o) o) o)

E, K-tag indirect settings (@) X X X @) @) X

K-tag char. col. Settings (o) (o) X (0) (@) (@) (@)

H-tag Readout after start X X X X X X X

S-tag Readout after start X X X X X X X
Trend Graph group display's

PEC gsetti:g i X X X X X X X

D-Script Memory Copy X X X X X X X

D-Script Offset Address X X X X X X X

Filing Data X X X X X X X

Logging Data X X X X X X X

Write Cancel X X X X X X X

2-Way Driver X X X X X X X

Q : Supported X : Not supported:

€ Protocol Usage Restrictions (Details)

Data Transfer Settings

Performs the GP’s online transfer settings.
Operation Environment Settings

Designates the System Start Address, etc. and general operation environ-
ment items for the GP when it is in RUN mode.
Use System Area

Designates the GP’s System Area.usage conditions.
Use Read Area

Designates the GP’s Read Area.usage conditions.
32 Bit Access

Performs 32-bit read/write for all 32 bit addresses.
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E,K tag indirect settings

Sets the E and K tag indirect setting mode (for the storage address used for
display data).

K-tag char. col. Settings

This setting allows the input/display of 5 characters or more.

H-tag Readout after start

Uses this feature to display specific screen data.

S-tag Readout after start

Uses this feature to display specific text data.

Trend Graph group display’s PLC setting

Displays the PLC device designated for the data’s storage address.
D-Script Memory Copy

Copies all of a single device’s memory data at one time.

D-Script Offset Address

Designates an address’ offset amount.

Filing Data

Designates the Filing Data feature (where previously designated data is sent
to a PLC via a “recipe”. Can contain information used for a machine’s
operation) operation data and settings.

Logging Data

Designates the Logging Data feature (where a previously designated PLC
device area’s data is sent to the GP’s Sytem Area at the designated time, or
in reponse to a trigger bit) operation data and settings.

Write Cancel

When an error occurs during write operation, allows the write operation to
be canceled, and changes to OFFLINE mode.

2-Way Feature

Reads in data to the GP, via the Pro-Server software.

GP-PRO/PB III for Windows Ver. 5.0 Operation Manual

X1X



Preface

@ General GP-PRO/PBIII for Windows Functions

Be aware that even if a function can be set in GP-PRO/PB III for Windows,
there is the possibility that it may not be supported by certain GP units.

Tag Reference Manual

The functions available with your GP unit will vary, depending on which GP
series it is. Before creating a screen, be sure to confirm that all the functions
you wish to use are supported by your GP unit.

GPH70 GP | GP GP | GP | GP | GP
GP|GP | GP | GP | GP GP [GP | GP | GP | GP
Items GP370 570 | 870 37W2 | 2400 | 2500 | 2600
270 | 470 | 570 | 571 | 675 377TR | 477R | 577R | 377L | 377S

GP57JS VM| VM B T T T
Full color (64-color) display | x X[ x[x]O|O|x|x|O|x|[O|x]O0| x|O0|0|O0O
3-speed blinking X [ x]Ix|x|[O|O|x|x|[O|x|O|x|O|x|Of[O|O
Data sampling O |[x|o|o|o|o|o|ojo|o|ololo|o|olo]o
LS area backup O |[x|o|o|o|o|o|o|o|[o|o|lo|o|o|olo]o
Trend graph (tag)backup | x | x |@ |® |O|O|x|x|O0|0O|O|O|O]| x |O|O]|O
Trend h “block
d.re"‘,’,rap““‘g’“ x |x|elelolo|x|x|olololo|lo|x]|olo]|o
isplay
T h | -
rend graph (tag) lower o |x|olo|lo|lo|lo|lo|lo|o|o|lo|lo|lo|olo|o
section painting
Changi | ing K-t
b“a"g'"g““"s'"g “l o |x|olo|lo|o|lo|lo|lo|lo|lo|o|lo|lo|o|lo]o
E- E K-tag: Indi
tag, gtag, Ktag:Indirect |y 1ololo|ololo|lo|lolo|lolo]lo|olo]o
color setting
E-tag, g-tags: Indirect
designation of relativevalue] O [ x |O[O O[O |O|O|O|O|O|O|O|lO|O|0O]|O
range
E"“‘g’E'tag’s't"g:T"'“g o |x|ololololo|lolo|lo|lo|lolo|lo|ololo
ackground colors (Bg)
-tag: Color diffi tiati
gtag: Color differentiation | | v lo|o|o|o|o|lo|lo|olo|lo|o]lolo|o]o
in graph display
D-script Additi Drawi
- diions Prawing, v | v lo|o|olo|ololo|lololololololo]o
ath Functions)
Drawing function (Htag) | O | x |O|O|O|O|0O|0O|O|O|O|O|O|O|O|O]O
T-tag: Radio switch function| O x[O|O|OlO|O|OlO|O|JO|lO|lO|lO|O|O|O
Inchi tput switch (Tih-
t“°'"g°.”"“w'°" x |x|lolo|lo|lo|lolo|lo|lo|lo|x|x|x|olo|o
ag and Tiw-tag)
Q-tag: Backup x |[x|e|le@e|O|O|x|x|O|O|O|lO|O|O|O[O]O
-tag: Setting displ
for;gate'"g'spay o |x|olo|lo|lo|lo|lo|lo|lo|lololo|lol|lolo]o

Q : Supported ® : Depends on model X : Not supported:
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GPHT0 GP|GP |GP | GP | GP GP| GP GP [GP | GP [ GP | GP GP | GP | GP | GP
ltems GP370 570 | 870v 37W2 | 2400| 2500 | 2600
GP57JS 270 | 470 | 570 | 571 | 675 vl 377R|477TR(577R|377L | 377S B T T T
Q-tag: Display by second O | X|O|O|O[O|]O|]O|O|O]|]O|O|]O|]0O|0]0]|0
Q-tag: Setting print color X | X|Xx|o|lo|o|lo|lo|o?x|o|X|X|X|o|O]|O
Tank graph (premadeparts)) O | X [O|O|O[O|O|O|O0O]|]O|O[O|O0O|] O |O|0O|O
Met h -mad
p:n‘:')grap(prem“ o |x|o|lo|o|o|o|o|o|o|o|o|lo|o|o|o]O
Vid indow displ * *
g X |x|x|x|x|x|olo|x|x|x|x]|x]|Xx]|xX|o%o®
Setting Direction of Screen
Printout X [ X[X|X[X]OIX[X[|X|X[X[X]|X]| X[X]|X]|O
Interrupt/cancel hard-copy *9
printout X | X[O|O[O|O|O[O |0O|O(X|X]| X[O]O]|O
Set “OFFLINE” mod itch
o mes ™ o |o|o|o|o|o|o|o|o|lo|lo|lo|lo|lo|o|o]|O
eature off
Q-tag: Sub-display O | X|O|O|O|O|]O|]O|O|O]|]O|O|J]O]0O|0O0]0]|0
Q-tag: Grouping of alarms
into a block X I XXX X|X|X]|X]O[O]|O|O|]O|[O |O|O]|O
A-tag: Indirect designation
of text screen or sub-display| X [ X[ X[ X[ X | X[X]I X[O[|O|O|O|O| O |O0O|10O0|0O
screen
Filing data function X | X[X]|X[X]|X][X[X]O]O[O|[|O|]O| X[O]O]|O
Data logging function X | X|X|X]|X]|X]|X]| X]O[O]|]O|O]O| X ]|]O[O]O
Sound output function X [ X[X[X[X|X]|X]| X|0?o"Mo" x| x| Xx|o|o|O
CF Card compatibility X |IX[X[X|X[X|X|X|o?%oM"o? X|X| X |0|O|O
Global D-script X | X|X|X]|X]|X]|X]| X]O[O]|]O|O]O|O]|]O[O]O
Compatible with Pro-Server | X [ X [ X [ X [ X | X | X | X |0%0®30% X | X| X |O|O|0O
Compatible with LS area for
simulation X [ X[X|X[X]|X][X[X]O]O[O[O]|O]|O|[O]|O]|O
GP resetting due to write
error X I XXX X|X|X]|X]O[O]|O|O|]O|[O |O|O]|O
Compatible with transfer
speed of 115.2Kbps X [ X[X|X[X]|X][X[X]O]O[O[O]|O]|O|[O]|O]|O
Creation of composite parts
for Filing Data X [ X[X|X[X]|X][X[X]O]O[O[O|O| X[O]|]O]|O
D-script: Bit dual stat
v X |x|x|[x|x|[x|x|x|o|lo|o|o|o|o]|o|o]|oO
Q : Supported ® : Depends on model X : Not supported:
*] A large-size multi-unit S is necessary to enable this function.
*2 A middle-size multi-unit E is necessary to enable this function.
*3 A large-size multi-unit E or GP Ethernet I/F unit is necessary to enable this function.
*4 A VM unit is necessary to enable this function.
, * If a project file with 64-color data (intended for 64-color compatible GP units)
" X is sent to a different type GP unit, this data will be converted to 8-color data.
/AsA. As a result, some types of objects and filled areas may not be displayed.
importan

» Objects and images that use colors other than the basic 8 color pallet colors
may flicker on the GP-675S, GP-377S, and GP-577RS units.
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GPH70 GP | GP GP | GP | GP
GP | GP | GP | GP | GP GP | GP | GP | GP | GP | GP37
Items GP370 570 | 870 2400 | 2500 | 2600
270 | 470 | 570 | 571 | 675 377TR| 4TTR | STTR | 377L | 377S | W2B
GP57JS VM| VM T| T (T

D-script: Memory block

X I X|X[X|IX|X[X|IX]O[O]O[O|O|O|O|[O]|O
initialization

D-script: Loop function X [ X[ XX X|X|X]|X]|]O]O]|]O[O[O[O|O]|]O]|O
cerm Mdesselet | x| x| x| x|x|x|x|x|o|o|o|o|lo|lo|o|o|o
esignation

D-script:Temporary address

(can be used up to 90 X | x|x|x|x|x|x]|x|]O]O]|]O|O[O[O|O|O]|O
addresses)

Filing function:Can be

designated up to 10,000 X | x| x|x|x|x|x]|x|]O]O]|]O|O[O|x |O|]O]|O

pieces of data

Filing function: Multiple
folders

Filing function: Stores the
cursor position.

Filing function: PLC data

transfer completion Bit X X|Xx|x|x|x|x]|x]|]O]O|O0O|lO0O|[O0Ofx]|]0O]l]0O0]|O
Address
Logging function: Loo
fgg.g P X | x| x[x|[x[x[x]x]O]O[O[O]O| x |O|O|O
unction
Logging function: Total LS
dggg X | x[x|x]|x|[x|[x]|x]O[|O|O|]O]O|x |O]0O0]0O
ata write
CF Card free capacity w9 | x| ~*1
storage X | x| x|x|x|x|x|x|O°l0O"O'|x|[x|x|O|]O]|O
4-state lamp (pre-made
parts)”“’ x |x|x|x|x|x|x|x|o|lo]o|lo|lo|o|o|lo]|o
T-tag: Add/Sub function O ololo|lOolOolOololOolOlOlOIO (@) OlOo|O
T-tag: Grouping with auto
o o x [x|x|[x|x|x|x|x|o|lo|lo|o|o|o|o|o|oO
T-tag: Interlock Touch
Available Conditions (bit X X x|[x|x|x|x|[x|O|l|O|O]J]O|]O|O|O]|]O|O
OFF)
Offline shift (pre-made

b x |x|x|x|x|x|x|x|o|lo|lo|lo|lo|o|ol|lo]|o
parts)
Q-tag block printing x |[x|x|[x|x|x|[x|x|0o?|lOo|O|x|x|x|O|O]|O
Q-tag external operation X X|x|x|x|[x|x]x]O[O|O|]O|]O[O|0O0|]0O0]|O0O
A-tag blank line display X X|x|x|x|[x|x]x]O[O|O]|]O|]O[O|O|]0O0]|O0O
Expansion of LS area X X|x|x|x|[x|x]x]O[O|O|]O|]O[O|0O0]|]0O0]|O0O
Alarm message: Can be

g x [x|x|[x|x|x|x|[x|o|lo|lo|o|o|o|o|o]|oO
used up to 512 messages
Backlight SAVE function on
- x |x|x|x|x|x|x|x|o|lo|o|o|lo|o|o|o]|O
display OFF
Backlight burnout detector X XIXIxIxIxIxIx|Ol x| x!1O|lO| x[O|]O]|O
Internal 2-Port function X XIXxXIxIxlIxIxlIx|OlO|]O|O|lO|O[O]|O]|O0O

Q : Supported ® : Depends on model X : Not supported:

*1 A large-size multi-unit S is necessary to enable this function.

*2 A middle-size multi-unit E is necessary to enable this function.
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Preface

€ New GP-PRO/PBIII for Windows 5.0 Functions and GP Availability

Items

GPH70
GP370
GP57JS

GP
570

<
=

GP
870

<
=

GP
377TR

GP
47T7R

GP
5TTR

GP
3771L

GP
3778

GP37
Ww2B

GP
2400
T

GP
2500
T

GP
2600
T

GB-WEB compatibility

X

X

0?0730

PLC Simulation via Ethernet

>
X

Factory-Set IP address

settings for data transfer

D-Script I/0 function

Serial-code reader
compatibility

Bar-code reader
compatibility

256-color display

Q-tag: up to 2048 messages

format digits

Q-tag: Expansion of time

Japanese FEP

buzzer)

T-tag: momentary (one-shot

255

Number of logging words:

X | X X X [X|X| X | X [X] X [X

X | X IX]| X |IX|X| X | X |X| X |[X]|X
X | X X X [X[X| X | X [X] X [X]X
X | X X X XX X | X [X] X [X]X

X | X |IX]| X |IX|X| X | X |X| X |X]|X

X | X IX]| X |IX|X| X | X |X| X [X]|X

X | X |IX]| X |IX|X| X | X |X| X |[X]|X

X | X X X [X[X| X | X [X] X [X]X

X | O |X| O [X|X| X | X [X]| X [X
X | O X[ O [X[|X] X | X |X]|] X

X | O |X| O |X[X]| X | X |X[| X

X | O X[ O [X[X] X | X |X]| X |X[|X
X | O |X| O |[X|O| X | X [X| X [X

X | O |X]| O [X|X| X | X [X]| X [X]|X

O| O |0l O |00l O| O|0O] O |0Of|O

O| O[Ol O|O|O] O| O O] O |O]|O

O| O |0l O |00l O| O |0O] O |0Of|O

O : Supported

@ : Depends on model

X : Not supported:

*2 A middle-size multi-unit E is necessary to enable this function.

*3 A large-size multi-unit E or GP Ethernet I/F unit is necessary to enable this function.

foe:
2]

The differences in the functions of the GP37W2 and GP377S/L are as follows:

e No SRAM feature

* No brightness setting
* No detection of backlight burn-out

GP-PRO/PB III for Windows Ver. 5.0 Operation Manual
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FUNDAMENTALS OF GP-PRO/PB lil for WINDOWS

T his chapter describes GP-PRO/PB III for Windows’ basic operations
such as how to start and quit the software. It also explains the Project
Manager and Screen Editor areas, which are used for the majority of screen
creation work. Also, a number of tools are introduced here, such as online
help, which provide explanations of GP-PRO/PB III for Windows’ functions
and operations.

) I PR From Start to Finish
) Project Manager
) IR U PP Screen Editor

N GP-PRO/PB III Manuals and Help




1.1 From Start to Finish Chapter 1 - Fundamentals

m From Start to Finish

This section describes the GP-PRO/PB III for Windows program’s operation
flow from start to finish.

Usage Pattern |

Start — project file with the — screen with the — and quit the — and quit the

Create/Select a Create/Edit a Save the screen, Save the project,

Project Manager. Screen Editor. Screen Editor. Project Manager.

m Getting Started

B Starting GP-PRO/PB III for Windows

The following explanation assumes your PC is turned on and the Windows
desktop has appeared.

PROCEDURE REMARKS

(1) Click on the [Start] button, and point to the [Pro- | If you double-click directly on a
grams]| - [ProPB3Win| menu. Then, click on the | previously made project file

[1. Project Manager| command.

% Programs

Documents

(*.PRW file) via the Explorer soft-

Bacoessoies | * ware, GP-PRO/PB 111 for Windows

H

L4

will automatically start.
E[‘% 2.File Corvverter

M MS-D0S Prompt || 82 3 Rebuid

@ ‘windows Explorer L'_'E]-; 4 Pack Tool

}:) 5. Project Compare
1@ Guided Tour

@ ReadMe

‘iﬁ Urirstall

RO

oAV ICIOY
ad

] I T SUBISHI MELSEC-AnN{CPU)

& none

1 = ™

e Select Editar

: P
W Arm P Setup [Transfer
5 E]
Simulation ||| |Print Change

Pr. Mngr
& [
Pro—Control | Exit
FReady

1-2

GP-PRO/PB III for Windows Ver. 5.0 Operation Manual



Chapter 1 - Fundamentals 1.1 From Start to Finish

m Creating/Selecting/Saving a Project ]

A project file (PRW file) normally contains multiple screens intended for the
operation of a certain system. GP-PRO/PB III for Windows creates one
project file for the operation of one system, enabling system management by
project file units.

You can send the screen data of one project file or individual screens of the
same project file to the GP unit. Screens of different project files cannot be
used simultaneously on the GP unit.

B Creating a New Project

When you create a new project, you must designate the GP and PLC type
information, according to your current application.

€ GP Type

Select your GP’s type.

HOW TO USE THIS MANUAL, W The GP Family of
Products

When your GP will be installed vertically instead of horizontally, be sure to
select a vertical type GP. The Screen Editor will automatically create a
vertical drawing area for you.

Series name GP Model Name GP Type selection
: GP-H70L GPH70L
GP-HT0 serles GP-HTOS GPRTOS
: GP-270L GP270L
GP-270 series GP2705 GP2703
: GP-370L GP370L
GP-370 serles GP-3705 G370
GP-470 series GP-470E GP470
GP-570S GP-570T
GP-57JS GPoT0
GP-570 series _
GP-570W GP570W
GP-571T GP571T
GP-675 series GP-675T GP675
GP-675S
GP-870 series GP-870W GP870WM
GP-377 series GP-377L GP377L
GP-377S GP377S
GP-37W2 series GP-37W2 GP37W2
GP-477R series GP-477RE GP477R
GP77R series | GP-577R series | GP-577RT GP-577RS GP577R
GP-377R series GP-377RT GP377RT
GP-2400T GP2400
GP2000 series GP-2500T GP2500
GP-2600T GP2600
@ PLC Type

Select the type of PLC to be connected to your GP unit.
PLC Connection Manual

GP-PRO/PB III for Windows Ver. 5.0 Operation Manual 1-3



1.1 From Start to Finish Chapter 1 - Fundamentals

PROCEDURE REMARKS

(1) Select the Project Manger's [Project] menu - [New]

]
command, or click on |..

.25 Factory A.prw : Manulacturing Process Screen - Project Man:
Project  Sereen/Setup Uity Help
0 =
Hew Select Editor
T &
wlarm (GP Setup ransfer
S = EE]
Simulation Print hange
. Mngr
& T
. Version 5.0/
. e
. (=] Gr2s00
58] MITSUBISHI MELSEC-Anh(CPU)
B none
— . ..
4 When entering a description, you

(2) Enter a description and select the GP (Display) and | canuseup to 60 single-byte char-

PLC types. Then, clickon|[ o |, acters.

To set the PLC

Hew .
_— type, see “PLC Connection
[Marufacturing Pracess Sereen | L S Man ual ,,.

Display Type: Cancel B
JP2500 4]

PLLC Type:
[MITSUBISHIMELSECAnN(CRU) ]|

Extend 510 Type:

Jnune Ji” | Help ]

(3) The GP-PRO/PBIII for Windows system will then | |[¢ screen creation procedure is
ask you if you wish to create a screen. If you click on also described in "1.1.3 Opening/

: Closing/Saving a Screen”.
the button, the Screen Editor will start and & &
you can begin laying out your screen.

Launch Editor

@ Do you wart to launch the Editor 7
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Chapter 1 - Fundamentals

ﬁ?te:
X2

1.1 From Start to Finish

If you attempt to create another project file without saving a newly created
project file, the system asks if you wish to save the current file. If you click on

the button, the [Save As] dialog box appears. If you click on the

button, the system opens a new screen without saving the current
project file.

1.1.2 B Saving a Project File under a Different Name

Project Manager

B Selecting an Existing Project

Used to select the

Select the Project Manger's [Project] menu - [Select] command, or click on

=4

Select

. When you select a project, the following setting screen appears:

Used to create
a new folder

Used to display

the folder of the Used to display

folder containing the  preceding level / a file list
target project file /
-
Used to display
Lists the current a detailed file
folder and existing actring Process gy list

project files

Used to select the expan-
sion SIO protocol

)Y Reference 4

and Serial-code readers in
“Tag Reference Manual”

(Is grayed out when the GP
type is not the GP2000 series)

| Displays the

File name: JFactnryAprw /t/r/gpan I projeCt file name
Files of ype: [ Windows Project Files [-prw] Fl [ _cenee selected from the

list

You can specify
the project file by
typing the file

4 name

Bar-code

Drescription : J Marufacturing Process Screen

Display Type: GRZE00

PLC Tppe: J MITSUBISHI MELSEC-4nHICPU)

Extend 510 Type: nane |

Displays the project file’s Used to select the
comment and the selected project file type desired
GP unit and PLC types

@ File Types

Important

Kot
2

You can select either a project file created with the DOS version of GP-
PRO/PB III (DOS project file: *.PRO), or a project file created with GP-
PRO/PB III for Windows (project file: *.PRW).

If you specify the GP type as “GP570VM” in a DOS project file,
and the GP type is not recognized as “GP570VM” in GP-PRO/PB
Il for Windows, then re-register the GP type as “GP570VM” in
the Windows version.

Double-clicking on the file (project file: *.PRW) itself in Explorer automati-
cally starts GP-PRO/PB III for Windows and opens the file.

GP-PRO/PB III for Windows Ver. 5.0 Operation Manual
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1.1 From Start to Finish Chapter 1 - Fundamentals

B Setting Extend SIO
Only GP 2000 series units can use the Extend SI1O feature.

This setting is only available when a GP2000 series unit is selected. If an
earlier type GP is selected, this menu item is grayed out.

Project |

Hew... Chrl+M
Select... Chil+5
Save Az

Delete...

Froperties. ..

CF Card Output Folder...

Lhange GF Type.. To modify this setting,
ChangePLLTwpe. 7 click on this selection.
Change Ext_S10 Type. .

Tranzfer...

Sirnulatiar. .

€ Extend SIO Icon
* In the Project Manager screen

These settings can be activated only when the GP type is a GP2000 series
unit. If another GP type is selected, the settings are grayed out. The default
value is “none.” Double click on the “none” icon to see the Settings window.

GP2500
MITSUBISHI MELSEC-AnM{CPL)

rmne

€ Modifying the Extend SIO Selection

This window appears when you click on the icon button shown above or
select the feature from the pull-down menu. The default value is “none.”

Change Extend 510 Type

Eutend S10 Type:

] I | Cancel | | Help |
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€ New Project
The Extend SIO type can also be set in the “New” screen.
This item is grayed out when the GP type is not a GP2000 series unit.

Hew
Dezcrphtion :
JFau:t-:ur_l,l ) ] ' ak |
[GP2s00 ]
FLC Type:

|MITSUBISHI MELSEC-AnM(CPU] Eﬂ

Ewtend 510 Tupe:

] none Ji] | Help

iGeneral 510 Protocal

Senal BCR [KTAG)

€ Save As

The Extend SIO type can be also changed via the Save As feature’s Select
screen.

This item is grayed out when the GP type is not a GP2000 series unit.

Select
Lok, jr; J@ database
File narme; JFactory Ao ] m
Filez of type: JWindows Praject Files [*.prw) E] " Cancel
Description : J t anufacturing Process Screen ]
Displsy Type: [ G250 ]
FLC Type: J MITSUBISHI MELSEC-AnN{CFU) ]
Eutend 510 Type: J none ]
&
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1.1 From Start to Finish

Chapter 1 - Fundamentals

PROCEDURE

REMARKS

(1) Select the Project Manger [Project] menu’s [Select]

=

command, or click on

Select

(2) Select a project file from the list that appears, or

type the project file name.
Select “Factory A”

Select

4=

uring Process. prw

File name: JFactnr_l,l A prey

Files of bype: J\N’indnws Project Files [* prw] Jﬂ‘ " Cancel

J Manufacturing Process Screen

Description

Display Type:

|
Jspzsnn |
PLC Type J MITSUBISHI MELSEC-AnNICPU] |
] |

Extend 510 Type: | none

To type a
_— file name
via the
keyboard,
type the
file name
here.

(3) Click on the button to open the selected

file.

To select a project file located in
another folder, find a desired file
from the “Look in: (File location)”.

To select a file created with the
DOS version of GP-PRO/PB 111, se-
lect “DOS Project File (*.pro)” in
“File Type:”.

When you double-click on the file
name selected in step (2), you can

skip the command.

To create a screen,
refer to 1.1.3 Opening/Closing/
Saving a Screen.

1-8

GP-PRO/PB III for Windows Ver. 5.0 Operation Manual



Chapter 1 - Fundamentals

Il Saving a Project

1.1 From Start to Finish

When the data of an existing project file is changed, the changes will be automati-

cally saved.

However, if you attempt to create a another new project file without first saving your
current project file, the GP-PRO/PBIII will ask if you wish to save the current file. If

you click on the button, the [Save As] dialog box will appear.
1.1.2 W Saving a Project File under a Different Name

M Saving a Project File under a Different Name
You can save an existing project file under a different name or with different GP

type/PLC type settings.

PROCEDURE

REMARKS

(1) Select the [Project | menu - [Save As | command in
the Project Manager.

(2) The comment, GP type and PLC type of the cur-
rently opened project file are displayed.

Enter the desired file name, and enter the items to be
changed.

Save As a8

Save jr J &) database

&

Factory & pr
 anufacturing Process prw

File name: JManulaclunng Process pra | | Save I

Save as ype: JW’indows Praject Files % prw) E| Cancel

Diescription : JManufaclunng Process Screen |

Display Type:  [GP2500 Ja|

PLC Type: JMITSUBISHI MELSEC-ArMICPLU] Jz”

Extend 510 Type: Jnnne Jz”

The file name can contain up to 255
characters (including the path-name
and extension.)

]
Important

Before changing the GP
type, check the preset data,
since the drawing area and
functions vary depending on
the type of the GP unit.

4.2.7 Changing a
Project’s GP Type

iz

Important
Once the PLC type is
changed, you must change
the addresses of the Parts,
Tags, D-Scripts and alarms,

and perform the GP system
setup again.

4.2.8 Changing
Your Project’s PLC Type

GP-PRO/PB III for Windows Ver. 5.0 Operation Manual



1.1 From Start to Finish Chapter 1 - Fundamentals

PROCEDURE REMARKS
(3) Click on the button to save the file. To open another

project file, see “1.1.2 B Creat-
ing a New Project or B Selecting
an Existing Project”.

If a project file with the same name exists, GP-PRO/
PBIII will ask if you want to replace (overwrite) the ex-
isting project file with the project file you are attempt-

ing to save. To close GP-PRO/
If so, click on the button. If you do not wish to PBIII for Windows, see “I.1.4

overwrite the existing project file, click on the g”m’z’g GP-PRO/PBIII for Win-
button. ows .

C:proPB 3zhdatabaseh Production. pon
Thiz file already exists.

Replace exizting file?

* When a Vertical GP unit is replaced with the horizontal type, or
! vice-versa, the displayed screen will rotate 90° relative to the
important  original data. In this case, you must edit the displayed data
using the [Rotate] command. After editing, be sure to check

the displayed data.
Example) |
ABC I |:>
Q
i)
<
Horizontal type Vertical type

* When a high-resolution type GP unit is replaced with a low-reso-
lution type, high-resolution data can not longer be displayed. If
the low-resolution type GP unit is again replaced with a high-
resolution type and the same project file is used, the data will
once again be displayed.

* The maximum number of characters used for an alarm summary
in the low-resolution type is different from that of the high-reso-
lution type. When an alarm message created with the high-resolu-
tion type is used in a low-resolution type, data extending beyond
the message area will not be displayed.
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Chapter 1 - Fundamentals

1.1 From Start to Finish

m Opening/Closing/Saving a Screen

After selecting a project file, you can create a screen. First, you must move
from the Project Manager to the Screen Editor, and open a screen. This
section describes the procedures for opening, closing, and saving a screen.

B Opening a New Screen

PROCEDURE

REMARKS

(1) Select the Project Manger's [Screen/Setup] menu -

[Editor] command, or click on | |.

The Screen Editor’s opening screen will appear.

[- 15T

Window _Help

2 KDk Ya Y Zoom

[a]s[e[ofa[elr[s[olnl[klw L 1 [mw[w[plalr]s [¥]* |mu(ulviwix] —
O — 2 20 E—

e |

(2) Select the Screen Editor [Screen] menu’s - [New]
command, or click on .

(3) Select the screen type.

Ok,
| Cancel

Screen Type:

Ease Screen

Test Screen

(4) Click on the button to create the desired

type of screen.

A screen corresponding to the designated GP type will
appear.

El
Telel=lalalale

L
HEHEH

)
=l

Js[e[o[a[E[FTS[IHI [ k[t [1MM[n[Pla[R[S [Tt [-[o]v [W[X]

T JReady [ o]

When the Screen Editor has already
been started, skip step (1).

Selecting the [Screen] menu’s -
[Open] command or clicking on
and entering an unregistered

screen number can also be used to
open a new screen.

Enter the screen number and title
when saving the screen.

1.1.3 W Saving a
Screen under a Different Name

Up to twenty screens can be simul-
taneously opened.

Multiple types of windows can be
opened on any one screen at the
same time.
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1.1 From Start to Finish

B Opening a Previously Saved Screen

Chapter 1 - Fundamentals

PROCEDURE

REMARKS

(1) Select the [Screen/Setup] menu’s - [Editor] com-

mand, or click on |-, | in the Project Manager.

The Screen Editor’s opening screen will appear.

(2) Select the [Screen] menu’s - [Open] command or click
on [

(3) Use this screen to select a screen name from the list,
or select the screen type and enter the screen number.

When checking the [Preview] check box, the selected
screen image can be viewed in the dialog box.

Openscren |
Praject File: Praject 1.pna
Screer: B
IIIIHEEIIIII
g
e |
5| & ]

Open Screen

Project File: Froject 1.pna

.

Screen:

l

Open

Copy

Y

Change I

Wiy

Delete

[ !ﬂ Preview
NN
AN

Preview Check Box

When the Screen Editor has already
been started, skip step (1).

When you double-click on the de-
sired screen number in step (3), you
can skip the operation of the

button.

If you enter a screen number that
has not been registered in the list, a
new screen will be opened and that
number will be assigned to it.

When selecting multiple screens, a
screen with the smallest screen
number of them will be displayed.
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Chapter 1 - Fundamentals 1.1 From Start to Finish

PROCEDURE REMARKS

(4) Click on the button to open the screen.

The selected screen will be opened.

I, Drawing Board - Project 1

i Parts

Link Select Change Order

T | s020%) JResay

i Start] [€ Exploring - Disk1 [[#14_0Ch1-10-1- . [[BRProject 1 pow

ﬁ}\ Up to twenty screens can be open at the same time.
ote:
S

To select several screens simultaneously, while pressing the |Shift | key, click on a
screen and drag the mouse over desired adjacent screens; or, you can select

screens individually by clicking on them while pressing the key.

Opensereen |

Pioject File: Project 1.pmw

Soreen:

Open

Copy

Change:

Wigw

Delete

O Preview

Screen Type Close

Base Screen I-1 Hel

il

T 1 o000 Jresdy

[ Start][& Exploring - Diskcl [[#14_0Ch1-11-1 - |[BBProject 1 pw
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1.1 From Start to Finish

B Saving a Screen

Chapter 1 - Fundamentals

PROCEDURE

REMARKS

(1) Select the [Screen] menu- [Save] command, or click

on in the Screen Editor

(2) The current screen will be saved overwriting the pre-
vious one.

After the screen is saved, it will re-
main open.

To open another
screen, see 1.1.3 B Opening a New
Screen.

To quit GP-PRO/
PBIII for Windows, see 1.1.4 Quit-
ting GP-PRO/PBIII for Windows.

When you attempt to save a new
screen, the [Save As] dialog box
will appear.

1.1.3 B Saving a
Screen under a Different Name

B Saving a Screen under a Different Name

PROCEDURE

REMARKS

(1) Select the [Screen] menu - [Save As] command in
the Screen Editor.

(2) The type, number, and title of the current screen is
displayed.

You can change the setting of a desired item; however,
the screen’s type cannot be changed.

Save As

Project File:  Manufacturing System
Screen Type: Basze Screen

Screen:

D escriptior: JDperation b omitor ]

Operation b onitor
12 Aggregate 2 Summary
13 Trouble

14 Kepboard Input

A “,” (comma) cannot be used in a
description.

After the screen is saved, it will
remain open.

If the screen is saved as a different
screen number, the screen of the
updated number will be displayed.

To open another
screen, see 1.1.3 B Opening a
New Screen or B Opening a Pre-
viously Saved Screen.

To quit GP-PRO/
PBIII for Windows, see 1.1.4
Quitting GP-PRO/PBIII for
Windows.

1-14
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1.1 From Start to Finish

PROCEDURE

REMARKS

(3) Click on the button to register the above

settings.

If a screen with the same number exists, the system asks
if you want to replace the existing screen with the screen
you are attempting to save.

If so, click on the button. If you do not wish to
overwrite the existing screen, click on the but-

ton.

Scieen Alieady Exists!

@ Do wou wish to Dvenite?
-

B Closing a Screen

PROCEDURE

REMARKS

(1) Select the [Screen] menu - [Close] command in the

Screen Editor.

(2) The screen will close.

If you attempt to close an updated screen without saving
it, the system asks if you wish to save the current screen.

If you click on the button, the system saves
the updated data. If you click on the button,

the system closes the screen without saving the updated
data.

Drawing Board

You can also close the screen by
clicking on the [X] button at the up-
per right corner of the window
(drawing area).

When you attempt to save a new
screen, the [Save As] dialog box ap-
pears.

1.1.3 B Saving a
Screen under a Different Name

To open another
screen, see 1.1.3 @ Opening a New

Screen.

To quit GP-PRO/
PBIII for Windows, see 1. 1.4 Quit-
ting GP-PRO/PBIII for Windows.
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m Quitting GP-PRO/PBIII for Windows ]

B Quitting the Screen Editor

PROCEDURE REMARKS

(1) Select the [Screen] menu - [Exit] command, or click
on in the Screen Editor.

(2) The Screen Editor will close.

If you attempt to close the Screen Editor without first | When you save a new screen, the
saving the currently edited screen, GP-PRO/PBIII asks | [Save As] dialog box appears.

if you wish to save the updated screen. If you click on 1.1.3 W Saving a
the button, GP-PRO/PBIII saves the updated | §ereen under a Different Name

data. If you click on the button, GP-PRO/PBIII
quits the Screen Editor without saving the updated data.

Drawing Board

B Quitting GP-PRO/PBIII for Windows

PROCEDURE REMARKS
(1) Select the [Project] menu - [Exit] command, or click | Once you have opened the Screen
5 Editor, you must either quit it, or

on in the Project Manager. go to the Project Manager.
1.1.4 B Quiting

2) The Project M ill quit.
(2) The Project Manger will qui the Screen Editor

If you attempt to close the Project Manager without sav-
ing the currently opened screen’s updated data, GP-PRO/
PBIII asks if you wish to save your project’s data. If you

click on the button, GP-PRO/PBIII saves the

updated data. If you click on the button, GP-

PRO/PBIII quits (closes) without saving the updated

data.
Drawing Board
@ Save changes to Screen; Unhitled1?
o[ me ][ cancel |
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m Project Manager ]

All GP-PRO/PB III for Windows system level settings and functions are
controlled via the Project Manager.

@ Project Manager Areas and Functions ]

Here, each of the Project Manager’s features is explained. To begin working
with GP-PRO/PBIII for Windows, simply click on the desired button.

a. Title bar &, Factory A prw - Manufacturing Process Screen - Project Manager
JFroiect  Sersen/Setup | Uity | Help
b. Menu bar [ E
Ei Se
c. Pull-Down menu - ||i&
filarm )“" CF Card Toul.
e. Function Buttons — | Feck T
[l
Bimulation | |Print %hange
v Mngr
[E [
Pro-Cortralfl |Exit
[{@] MITSUBISHI MELSEC-ANN{CPU)
[& none:
d. Status Bar o 4

a. Title Bar:
Displays the current project’s file name and title.
b. Menu Bar:

Displays the menus used for the operation of GP-PRO/PBIII for Windows.
When you select a desired menu using the mouse or keyboard, one of the
pull-down menus described below will appear.

c. Pull-Down Menu:

When you select a desired item on the menu bar, its pull-down menu ap-
pears. These menus includes a variety of commands.

d. Status Bar:

Displays GP and PLC types as well as GP-PRO/PBIII operation related
messages.
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e. Function Buttons

These buttons indicate the GP-PRO/PB III for Windows program’s main
functions (e.g. Creating Screens/alarm, Printing). You can start each func-
tion by simply clicking on that function’s button. You can also start these
functions by selecting the corresponding command from the Project
Manager’s pull-down menu.

Selects an existing Use the Screen Editor to
project | / create or modify screen
Creates a new project ~[[] = | [ data
e oot |Editc|r Transmits screen and GP

| system setting data to the
GP unit

Creates Alarm Editor \m— u =
alarms | View or change GP

related settings

jarm P Setup

Performs Simulation \@ =
with the GP unit simulation | [Print

Switches the Project Manager
to Hierarchical (Explorer-like)
Display mode

& Chapter 11 PROJECT MAN-
Switchesto — | " AGER HIERARCHICAL DIS-
Pro-Control PLAY

Prints out Screen Editor screens

Quits the GP-PRO/PBIII
for Windows program
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1.3 Screen Editor

m Screen Editor

GP operation and display screens are created in the Screen Editor.

E Screen Editor Item Names and Functions

The names and functions of the GP-PRO/PBIII for Windows editor’s screen
items are as follows:

a. Title Bar k. Screen Data List
b. Menu Bar _
1=
h. Tool Bar - R I E e ] -
LIVE wowsuen s, -] j. Selection
c. Pull-down et et Tool Box
Menu Preyiew . Tlo
% NE=E o]
. v 1 B |- 5 i. Zoom Box
d. Drawing 20 % -
v Screen Data Box IB|Screen Data [x]
Area "
Tool Bar 5
* Status Bar — h. Tool Bar
e. Screen [ Zoom Box o
Center Mark
Ml Pats [F) Tags [ Objects
f. Grid Points
- Ol Link Selest Change Order

g. Status Bar

E[F[s[e ]|

0 N Ready \

L=

[ N

. Title Bar

Displays the project file name, screen number and title.

. Menu Bar

Displays the menus used to operate GP-PRO/PBIII for Windows. When you
select a desired menu using the mouse or keypad, the pull-down menu (c)
appears.

. Pull-down Menu

When you select a desired menu from the menu bar, the pull-down menu
appears. This menu includes various commands.

. Drawing Area

Here, you can create a screen for your GP unit. The size of the screen you
see here is designated via the “GP Type” setting you entered when you first
created the project file.

Depending on the size of your PC’s display, the screen’s entire display area
may not be displayed. In this case, simply scroll up or down to view the
entire screen.
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e. Screen Center Mark

Indicates the center of the screen. This mark is not displayed when the data
is sent to the GP unit.

f. Grid Points

Used as reference points when you draw or paste an object in the drawing
mode. Grid points will not be displayed on the GP unit’s screen. The Option
area’s “Snap” function allows you to position your screen objects using a
pre-made grid. You can also set the interval and display ON/OFF status of
the grid points.

SABEEEEK 2.9.1 Grid/Snap
g. Status Bar

Displays information related to the current screen and provides messages
explaining the screen operation you are currently performing.

[958, 22 720%) || Send the selected object(s) to the front i [MTOM-5I0 100%
Coordinates 'Amount of Screen Description of the . ,
Display area’s

of current memory currently currently selected  Project’s y are
mouse used (Ratio ofused  command PL(j: type ngnltf_lcatlotr]/
position screen area to entire reduction ratio
screen)
h. Tool Bar

The Tool Bar provides easy to use icons for drawing and editing. Clicking
on one of these icons performs that command. The Tool Bar can either be
hidden or displayed, and individual Tool Bar areas can be moved freely
around the Screen Editor screen, i.e. top, bottom, left, or right.

The following Tool Bar areas are available:

Main Tool Bar

Edit Tool Bar

Draw Tool Bar

Option Tool Bar

Grid/Snap Tool Bar

Tag Tool Bar

Parts Tool Bar

Parts State Change Tool Bar

i. Zoom Box
Shows the cursor’s current position at three times magnification.
j- Selection Tool Box

Used to select objects to be edited (Parts, Tags and figures). Using the
commands included in this tool box, you can select objects using a variety
of methods.

k. Screen Data List
Lists the settings and layout conditions of the objects (Parts, Tags and
figures) that have been arranged on the screen. You can select a desired
object from the list.

SABTTEK 2.9.4 Screen Data List
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@ Display Area (50%, 100%, 200%) |

You can enlarge or reduce the drawing area by selecting a magnification/
reduction ratio.

To change the display area, select the or icon on the tool bar, or
select the [50%], [100%], or [200%] command from the [View] menu.

mgptiun Draw Tags

Tag List »
Bartis Ligt ...

Laad Sereen List ...

Load Seieen esting
Cross-Reference List .. »

Preview

50 %
v 100 %
200 %

V\Sﬁn Data Box

Tool Bar »
v Status Bar
v Zoom Box

Zoom out Zoom in

Zoom out: Used to reduce the current display area to 50%.
Zoom in: Used to enlarge the current display area to 200%.

ﬁk\t . In the [S0%] display mode, the created screen data is reduced. In this case,
0L&: the displayed screen data may be different from the actual data. We recom-

mend you to use a [100%] or larger display area.

E Tool/lcon Display ]

The Tag tool box, Parts tool box, tool bar, and status bar can be designated
as either shown (displayed) or not shown (not displayed). Each time you
select the [View] menu's [Screen Data Box], [Status Bar], or [Zoom Box],
as well as the [Tool Bar] command's [Main], [Edit], [Draw], [Option],
[Grid/Snap], [Tag], [Parts], or [Parts State Change] sub-commands, these
View/Hide settings will toggle ON or OFF.

[ view]

TagList ... 3
B Lizh....

Load Sereem i ..

Laad Serzem et
LCrogs-Feference List ... »

Preview

a0

v 100%
Z

v Screen Data Box

v Statusz Bar v Edit
v Zoom Box v Draw
v [ption
v Glid/Snap

v Tag
v Parts
s State Change
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EZ» GP-PRO/PB Il Manuals and Help

While you are learning how to use the GP-PRO/PBIII for Windows soft-
ware, please refer to the following learning aids:

- Related User Manuals

- Guided Tour (Animated Explanation Video)

- On-line Help Topics

- Digital’s Home Page

For the help concerning the operation of the Windows operating system, see
the Windows software’s manuals and help screens.

B Using GP-PRO/PBIII for Windows Manuals

The following manuals have been created for the GP-PRO/PB III for Win-
dows software.

Installation Guide: Describes this software’s installation procedures as well
as how to PDF manuals.
Operation Manual: Provides detailed program operation information.

Tag Reference Manual:  Provides detailed descriptions of this software’s
active image Tags, special and advanced func-
tions.

PLC Connection Manual: Describes connection methods used between the
GP and the host (PLC), as well as the necessary
operating environment settings.

Parts List: Lists all the pre-made Parts included in the GP-
PRO/PB III for Windows software.

B Using the Guided Tour

The Guided Tour explains the outline of GP-PRO/PBIII for Windows to new
users. You can learn the features, functions, and operating procedures of GP-
PRO/PBIII for Windows.

B Using the Help Feature

If you have any problems or questions during GP-PRO/PB III for Windows
operation, you can view the explanations for each feature and setting via
each window’s Help button, or from the main menu’s Help feature.

B Using the Home Page

Users can obtain the latest GP-PRO/PBIII for Windows information by
accessing the Digital Electronics Corporation Home Page at “GP-PRO/PBIII
for Windows Members Club”.
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EZE) Viewing the Guided Tour ]

This section describes how to start the Guided Tour.

Turn on the power switch of your personal computer. After the Windows
desk top is displayed, perform the following:

(1) Insert the CD-ROM into the CD-ROM drive. The opening screen for the
GP-PRO/PB III for Windows will be displayed automatically.

(2) Click on “Guided Tour.”
(3) The Guided Tour will be started.

"':' Install

I]EE[[IH.-

- . N i
w

1 editor software — ‘.

POWER GP

ﬁé\te: If the Guided Tour does not start automatically, click on the "GUIDE. EXE"
X2 file stored in the master CD's main directory.
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m Browsing Help Topics ]

A

]
Important

To display the help screen, select the [Help] menu or click on the
button in the dialog box.

- When multiple screens are loaded or many Tags and Parts have
been registered on the screens, the PC’s system memory may
not be sufficient to display the help screen.

- If you jump from one topic to another on the help screen, an
error message may be displayed. When this happens, simply
quit and then re-start help.

B Searching for a Topic and then Display Help

Select the [Help Topics] command from the [Help] menu, or press the [F1]
key. A list of help topics will be displayed.

You can search for a topic by either trying to find it from the table of con-
tents, or entering a keyword for that topic.
@ Searching for a Topic from the Contents Menu

To select a topic from the contents menu, double-click on the [Contents] tab.
Follow the screen instructions to search for a desired topic.

Help Topics GP-PRO/PE3

Conten's | inde< | Find |

Click a :opic, and :hen cic< Dispay. Orchck anather tak, such & Indes.

@ Piojzct tanager

B iy
B tep
@ Screen
® Tax:
@ Parts
@ Setup
@ Alarm
@ Transher

' Display I| Pt | cence
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1.4 GP-PRO/PBIII Manuals and Help

@ Searching for a Topic by a Keyword

To enter a keyword, click on the [Index] tab.

Search for a desired topic according to the instruction indicated on the

screen.

(When you enter initial characters of the keyword, the topics specified with

these initial characters are also automatically listed)

Help Topics: GP-PRO/PB3

| Cortents]; Index ;| Find |

1 Type the first few letters of the word vou're looking for.

2 Click the index entry vouw want, and then click Display.

Alias [
Change GP

Change PLC

Change Project Manager

Corvert Address
Copy Screen
Delete Project
Drevice Maonitar
What iz it?
Dizplay Type
Editar
GP Type
GP-PC communication
Mew Project
MNew Screen
PC-GP communication

Presiem E

|| Dizplay ||| Brift... ||| Cancel |

B Calling up Help from a Dialog Box

When you click on the button in the dialog box or press the [F1]
key during execution of a command, a description of the currently-executed

command will be displayed.

Bit Switch Settings [BS_001] [<]

General Settings | Shape/Color [| Label |

Diescription Operation Bit Address
] [romo0 CE

it
onitor Bit Address

<0000

Function

&9 Bit Set

i) Bit Reset

i Momentary
20 Bit Invert

Interlock
Interlock Address

<0000 Bl

Touch available condition

0 B By L B0

)
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@ Browsing the Home Page ]

]
Important

The procedure to connect to Digital Electronic Corporation's home page
"GP-PRO/PBIII for Windows Members Club" is described here.
To browse the home page, you must have hardware environ-
ment to access the Internet. You also must have a browser to
view the home page, and subscribe to an Internet provider.

To view the home page, register yourself as a user in “GP-
PRO/PB Il for Windows Members Club.”

Please understand that Digital Electronics Corporation can-
not respond to any questions about your Internet connection.

Operating procedures

[Connect to Click on the

Home Page]

[Help] —» Add/Edit/Delete _

Connect home page

button.

Used to specify the
execution file of the ~|_Browser
browser to be started

Outline of the Home Page Connection screen:

Home page
C/program. } Used to add a home
page address
Home page

_4ddlit”} | Used to edit a regis-

Displays the regis-
tered home page
address (title)

Used to connect to

the specified home ™ |

page

©Edt

’ Delete

Connect home page

‘. Cloze H Help

tered home page
address and title

Used to delete a
registered home
page address

B Registering a Home Page Address

The address of Digital Electronics Corporation’s Home Page “GP-PRO/
PBIII for Windows Members Club” has been preregistered in your GP-PRO/
PBIII for Windows software. When you click on the button, the
address setting dialog box appears.

When you first visit the Member’s Club page, you will be prompted for a
registration number (from your software’s User Registration Card), and will
be given a password.

N How to Register a Home Page Address

B Deleting a Home Page Address

Any registered home page address can be deleted. When you select the
home page address to be deleted and click on the button, the
confirmation dialog box appears. If you click on the button, the

selected home page address will be deleted. If you click on the
button, the deleting operation will be canceled.
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B Editing a Home Page Address

1.4 GP-PRO/PBIII Manuals and Help

The registered home page address or title can be changed. When you select the home
page address to be edited and click on the button, the address setting dialog
box appears (same as for the home page addition procedure), enabling you to change
the title and address of the home page. If Digital Electronics Corporation’s home
page address is changed in the future, please edit the currently registered address.

B Connecting to the Home Page

PROCEDURE

REMARKS

(1) Select the [Help] menu - [Connect to Home Page]
command in the Project Manager.

(2) Specity the execution file name (*.exe) of the browser
to be started.

Home page
Broweser ]
JC.-’proglam.f kJ
Horne page

Members CIub || Add List
E@m@eh@meﬁ.gﬁ Close || Heln

(3) Select the target home page address.

Home page
Eroweser _
JE.-’proglam.-" |
Home page

Members Club k " fudd List
. Conmeet home: pags: Close | Help

(4) Click on the

The browser is started, and you will be connected to the
home page.

connect horme page | button to start connection.

l&-2-2 B 8|8.828 8 4 4 -8 |

770 [B o Fmproacozont BRI
— 3
- Welcome to Pro-face in Europe ----
K H %
# Pyntace ™
S
2 Gangpe .
T W

p _...!.slub:\ swt-‘l_i!’n,.'m

- Other Reglonal Sites —

To specify a different folder, click

on the button.

If a browser has not been specified,
the following dialog box appears.
Specify a browser, and re-start the
connecting procedure.

Project Manager

A

Intermet browser Mat Selected et
Pleaze zelect a Browser.
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B How To Register a Home Page Address
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PROCEDURE

REMARKS

(1) Select the [Help] menu - [Connect to Home Page]
command in the Project Manager.

(2) Click on the button.

Home page

Browser
‘C-\ngramFiIEs\Nelscape Nawgalnr\Pm” || Search |

Connect home page lm Help

(3) Enter a home page title and address to be registered

and click on .

The specified home page address will be registered.

Home page address

Lok p
Title | Pro-face Home Page || m

Address | httpitwnary. proface.com ||
Help

s

Home page

Browsear
|C:1F‘rugram Files\Metscape NavigatorIF‘m" ” Search |

Home page

CFROFDMMempersCin R

o
Delete

Connect home page Close Help

l

1-28

GP-PRO/PB Il for Windows Ver. 5.0 Operation Manual



p CREATING BASE SCREENS

T o create Base screens, the Editor area’s Part, Draw, Tag, and Menu Bar

commands can all be used. Also, Edit commands can be used to

modify any Parts, objects or Tags that you have created. In addition to
editing these screen objects, the procedures for registering Library Items and

Windows are also explained.

P8 N Efficient Drawing Techniques
GP-H70 Screen

Object Editing
Registering Windows

D-Script/Global D-Script
Data Sampling

DXF Conversion
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2.1 Parts Chapter 2 - Base Screens
Parts such as Switches, Lamps, and Graphs can be placed on Base screens.
Each Part’s attributes such as setting Addresses and colors will be desig-
nated via the dialog box. Switches and Lamps can be selected while viewing
their images via the Browser. After designating all the necessary Part at-
tributes, decide their position and size on the object drawing area.

The [Parts] menu’s commands are effective only on Base screens.
Usage Pattern |
Decide on Select the specific Specify its Place it
[Parts] —» atypeof — Partfrom the Ap VTS5 onthe
ttributes
or Part Browser Screen
Select a desired icon from the Parts Tool Bar.
B GP-PRO/PBIII for Windows Part Type Summary
Each of the Parts used in GP-PRO/PB III is listed below.
Icon Name Function Reference
@ Bit Switch Used to change a PLC’s Bit Address 2.1.1 Bit Switches
data.
:@ Word Switch | Changes a PLC’s Word Address data. 2.1.2 Word Switches
||§ Function Used to go back to the previous screen, | 2.1.3 Function
Switch to switch screens, and to reset the GP. Switches
% Toggle Switch | Turns the PLC’s Bit Address ON or OFF. | 2.1.4 Toggle
Switches
@ Lamp Turns ON or OFF, according to whether | 2.1.5 Lamps
the PLC’s Monitor Bit is ON or OFF.
— 4-State Lamp | Switches the 4 states of the lamp, 2.1.6 4-State Lamps
| m according to whether the PLC’s two
Monitor Bits are ON or OFF.
Ei Bar Graph Displays the PLC’s Word Address data | 2.1.7 Bar Graphs
in a bar graph.
ﬁ Pie Graph Displays the PLC’s Word Address data | 2.1.8 Pie Graphs
| in a pie graph.
E Half-Pie Graph | Displays the PLC’s Word Address data | 2.1.9 Half-Pie Graphs
in a Half-Pie graph.
"i Tank Graph Displays the PLC’s Word Address data | 2.1.10 Tank Graphs
as absolute values in a Tank graph.
Meter aDlns’,Izltae):.s the PLC’s Word Address data | 2.1.11 Meters
1@“ Trend Graph Displays the PLC’s Word Address data | 2.1.12 Trend Graphs
as absolute values in a trend graph.
' Keypad Used to enter a PLC’s Word Address 2.1.13 Keypads
data.
E Keypad Input | Displays data input via the keypad. 2.1.14 Keypad
Display Displays
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Icon Name Function Reference
=] | Alarm Display | When monitored Bits are turned ON, a 2.1.15 Alarm Displays
|ﬁ list of “Basic” Alarm summary

messages appear that have been
previously registered in the Alarm
Editor.
Filing Data Displays data registered in the Filing 2.1.16 File Name
L@ Display Data list by specifying the Display
corresponding file number.
Logging Displays PLC data loaded in the data 2.1.17 Data Logging
% Display logging settings by specifying the Display
address for the corresponding block
number.
Numeric Displays the PLC’s Word Address 2.1.18 Numeric
Display numeric data as an absolute value. Displays
= Message Displays a previously registered 2.1.19 Message
ABC Display message, according to PLC Word Displays
Address data changes. A maximum of
16 messages can be displayed in a
single Message Display.
Date Display | Displays the current date, using the 2.1.20 Date Displays
~=E GP’s internal calendar.
Time Display | Displays the current time, using the 2.1.21 Time Displays
GP’s internal clock.
— Picture Displays a single registered Library 2.1.22 Picture
all Display image (only graphic data), according to Displays
PLC Word Address data changes. A
maximum of 16 different Library images
can be displayed in a single Picture
Display. (One at a time)
B Entering a Comment
If desired, a comment can be entered for a Part.
General Settings | Shape/Color || Label | Applles the
Up to 20 || (Description Operation Bit device com-
alphanumeric [ ] ment

(single-byte)
characters or
10 Chinese
(double-byte)
characters can
be entered

Browser...

State | On ] O

ity
Monitor Bit Address

0000
Funetion
2 Bit Set
i Bit Reset
0 Momentany
3 Bit Invert

Interock

Interlock Address

[E¥] [ronno |

Touch available condition

2 Bil Oy b BisENG

|| Flace I” Cancel ||| Help |
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@ Reflection of a Device Comment

If you click on the IE [Apply Device Comment] button after entering an
address, the device comment entered using the Symbol Editor is automati-

cally searched for, and the comment corresponding to the entered device
appears in the Description field.

4.2.5 Symbol Editor

B Entering Addresses

Here, Addresses that are operated for Parts’ functions and that are monitored
are designated.

Bit Switch Settings [BS_001] [x]

General Settings | Shape/Calar || Label |

Diescription Operation Bit Addreszs
state [On 01 Wonitey Enter the address data
Maritor Bit Address here
<0000 :
Function
18 Bit Get
0 Momentary
2 Bt Irwert
Interlack
Interlock. Address
[E¥] o000 |
Taouch available condition
& Biy@g, 2 Biy DI
|| Place I || Cancel | || Help |

€ Entering from a keyboard

Click on the address entering field, and the cursor will appear there, which

indicates data entry is now effective. Then, enter device and address data via
the keyboard.
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€ Entering from a pop-up keypad

Click on the pop-up keypad icon, and the pop-up keypad will appear, allow-
ing you to enter numeric data and addresses on the screen via the mouse.

Bit Switch Settings [BS_001]

' General Settings Shape/Calor | Label ]

Activates the

Diescription Operation Bit Address K d
| pop-up keypac:

D M aritar
To move the pop-up
keypad to the desired
position, drag its title bar. To close the pop-up
Bit Address keypad, click here.

To display the device —___|

names in a list, click here. || Jx\ﬂ 00000 4»— Display

Backspace key /—-E'Bac:k O~

Hexadecimal Lﬂ|5 C [8 3 ear key
number entry key M|E F Li"E =
1] 2] = Enter key

[ol e ]

€ Entering from a pull-down list

Click on the [¥] box next to the Address entering field, and a pull-down list
appears including symbols selected via the Symbol Editor and device com-
ments together with corresponding Addresses. Selecting a symbol or device
comment from the list designates an Address.

4.2.5 Symbol Editor

Bit Switch Settings [BS_001]
" General Settings | Shape/Colar [ Label |

Description Operation Bit Address ‘

] (%] <0000 ~ B

#0002 - Test Line
D #0003 - Start Purmp
[ — Fedtatal SN~ zpan (HF

%e: A Part’s specified address can be entered so that it is displayed during Base
N gereen creation.

Property Settings

Regardless of whether addresses are designated as either displayed or not
displayed during Base screen creation, they will not be displayed on the GP
panel after screen transfer.

GP-PRO/PB III for Windows Ver. 5.0 Operation Manual 2-5



2.1 Parts Chapter 2 - Base Screens

B Selecting a Part Shape
Click on the General Settings Area’s button in the dialog box,

and the Shape Browser (hereafter called “Browser”) will be displayed.
The Browser’s Part Shapes are stored in a Part File (PDB file), separate
from the main Project File (PRW file). Searching through different pre-
made Part files allows you to easily find useful Part Shapes for almost any
application.

Click on a Part number and then the button, or double-click
directly on the Part number to select a Part Shape. (Browser disappears)

Part File and Part Shape lists for each file are included in the GP-PRO/PBIII
for Windows Parts List Manual.

ﬁéte:
X

Shape Browser

Clicking here
scrolls
through the

~ Part Shapes
in this file

The ID number
of the Part

Shape is dis-
played here.

Reverse video
(highlighting)
indicates it is

SW_3D002 |

Calls up a list
of the other
L~ Part files

SW_3D004 || SW_3D005 | PDE File...

seIeCted Current PDE File : Jc::\propb3win\pdb\op4-3d01 .pdb
Title: [Sw_30001 E|" Help
Shows the ID number of the Shows the Path-name of the
currently selected Part Shape currently open Part File
@ PDB File

Click on the button, and a list of the Part files will appear. After
clicking on a Part File, the information displayed will change to reflect that
file. Next, click on the button and the selected PDB File’s Part
Shapes will appear in the Browser.

Shows the Moves to the next higher Creates a
currently file directory level new folder
open folder Displays file
HE names and details
Opd-mc0l.pdb DOp4-sp01 pdb
] A [#] Opgmmi pdb [ pob pdb ™ Displays file names
Lists the ggjg:g;g:‘; in summary form
names of all 8] Opd-sc01 pb
the PDB [ Opd-smi1.pdb
files in this
folder Fiensme:  Opd-3d01 \ | [ open |
Files of type:  [PDE fies [-PDE] \ Fll [ cancel
Shows the Description: |35 o] \ ]
currently / )\
selected — \ '
PDB file’s Shows the name of the currently selected PDB file. A
comment name can also be entered here to select a file
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ﬁé\te: When the GP-PRO/PBIII for Windows software is first installed, all Part
1 Files will be included in a folder named PDB and automatically installed in
the same directory/folder as the GP-PRO/PBIII for Windows program. If
desired, these Part Files can be moved to other folders and, to find a Part File
that has been moved, use the [Look in:] area to display Part Files located in
other folders.

Bl Selecting Colors

Specity Part colors using the Shape/Color setting screen. The setting items
will differ depending on the Part, i.e. the border type, ON/OFF states,
graphs, and label colors.

Tiling patterns can be selected for some of the Parts, Lamps, and Graphs.

‘word Switch Settings [W5_001]

' General Settings ' Shape/Color | Label ]
Border Calor

EIEEOEEDONwe ]

Calar

Fo 1) D O O o B
Bo M) )1 E B ]

Pattern

O

. Place H Cancel H Help

@ Colors

Color setting methods will differ for each model, i.e. monochrome, 8-color,
64-color and 256-color settings.

GP-571T, GP-675T, GP-675S, GP-377S, GP-377RT, GP-577RT, and GP-
577RS are 64-color models. GP2000 series units are 256-color models.

A After transferring a Project File created using 64-color (256-

! color) data to a 64-color (256-color) incompatible GP panel,

important the 64-color (256-color) data will be automatically changed to
monochrome data. In this case, some object elements, such
as fills or patterns, may not be displayed as they were origi-

nally drawn.

Objects and image data created using colors (on the color
palette) other than the basic 8 colors among the 64 colors

may flicker on the GP-675S, the GP-377S, or the GP-577RS
depending on their colors.

@EE T == =

Color bar Color palette

(58 5.7/ I T e
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<When using an 8-color or monochrome GP unit (incompatible with 64-
color screens)>

There are 8 colors available in the color bar. Use this bar to select the
foreground (Fg), background (Bg) and other colors. On a monochrome GP
screen, black, blue, green, and cyan will be displayed as black (same as
background); red, magenta, yellow, and white will be displayed as white.

Fo I NN [ I ] ]
B 0 N O IO O 1] B

Color GP unit BK| BL|GR[CY|RD|MG] YL|WH

Black (not | White (dis-
displayed) | played)

Monochrome GP unit

<When using a 64-color GP unit>

There are 64 colors available via the color palette. Use the palette bar to
select the foreground (Fg), background (Bg) and other colors.

T =
General Settings | Shape/Color | Label |
Border Color co'or palette
i m]
Calor
Fo I8 I ) o )
Bo 1N I I
Browser... Pattain
“ Place ||| Cancel ||| Help
After converting 64 color data to After converting 64 color data to
8 color data, each color will be monochrome data, each color
displayed like this: will be displayed like this:
BK|BL|GR [cY|RDMG| YL [wH BK[BK[BK | BK [WHWHWHWH|
1] o o | [ AR I I o | ] W AEm

EYI 15 15]

[26][45 150151 | I [ 29][s0][51] ]

EAEAse][5o (a0 61 2 [¢3] 56| 57 | I A A
BK|BL |BK|BK |BL|BL|GR | GR BK|BK BK|BK |BK |BK |BK |BK
CY|CY|GR |CY |BK|BK|BL | BL BK|BK BK|BK |BK|BK |BK |BK
BK|BK |BL |BL |GR|GR |CY |CY] BK |BK BK |BK |BK|BK |BK |BK
GR|GR|CY |[CY |RD|RDMG|MG| BEK | BK BK|BK |[WHWHWH|WH|
RD|RDMGMG|YL|YL[WH/WH WHWHWH WHWHWHWH|WH
YL|YL WH|WH|/RD|MG|RD |RD WH{WHWH WHWHWHWH WH
MGMG|YL | YL (WHWH|YL |WH WH{WHWH WHWHWH[WH| WH|
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2.1 Parts

<When using a 256-color GP2000 series unit>

GP2000 series units have 256 colors available, via the color palette. Use the
palette bar to select the foreground (Fg), background (Bg) and other colors.

I I ) o 1 ]

“| *Use the Project

— Manager area’s

I [ K K [GP Settings]

S 04|
[d

| window to desig-
nate that you will

use 256 colors.

€ Blink

Blink settings will also differ slightly depending on whether a single speed
Blink GP model or a three speed Blink GP model is used. Digital’s three
speed blink models are the GP-675S, GP-675T, GP-377S, GP-377RT, GP-
577RS, GP-577RT and GP2000 series units. Other GP models have only
one blinking speed. When 256-colors are selected in a project, the “Blink”
feature cannot be used for any of that project’s screens.

<Using a three speed Blink type GP>

Next to the Check Box, there is a Button that will display a range of 3
speeds and “No Blk” (indicates no blinking). When one of the blink speeds
is selected, the color bar is displayed in a darker color and the specified Part

will blink on the GP screen.

Lamp Settings [LA_001]

General Settings
State

Shape/Color | Label |

Border Calor

ENEDECCNE

OFF Calar Hilglalk........
E -

rENEIEECCN

Bar I ) ) ) ISR

<Using a single speed Blink type GP>

Blink speed settings

The normal blink speed is “Mid.”
“Fast” is twice as fast as “Mid”
and “Slow” is half as fast as
“Mid”. When “No BIk” is se-
lected, the Part will not blink.

When the Blink (Blk) Check Box checked [#] , the color bar is displayed in a
darker color and the specified Part will blink on the GP’s screen.

Fg ] | Blink Check Box

Bo I 1] B[]

When the GP model is changed from a three speed Blink type to a single
speed type, the “Mid” and “Slow” speeds will be changed to the single
speed GP’s “Blink” speed, and “No Blk” and “Fast” will be changed to “No
BIk”. The blinking rate for a single speed GP model is equal to the “Mid”

setting of the three speed type.

Lamp Settings [LA_001]
General Settings

State

Shape/Color | Label |

Border Color

ENE D EEN

OFF Colar

No Blk [No blink
Mid Blink
Fast No blink
Slow Blink

I
FQQQJEJJ!@DDI
B I I ) O NS4
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ﬁé\te: When either text characters or Mark backgrounds (Bg) are specified as

S Black, and the BIk (Blink) feature is turned on, they will become transpar-
ent; so that even when overlaid on other objects, the rear object’s color is also
visible. For a 64 color GP unit, this feature is valid only when the blink speed
has been specified as “Medium”. This function is useful when overlaying text
on Switches, Lamps, and other objects. For a 256 color GP, when “Transpar-
ent,” the last color on the color palette, is selected, the specified item will be
transparent.

For example:

Latiel

Snitch —

Bio ) I 1) ek D O O O O [ e ¥

Specifying a Label’s However, specifying the Label’s
background color as background color as Black and
Black does not allow you turning on Blk (blink), causes
to see the background the background color to be-
color. come visible.

N 3 9
___“ClIr.” =Clear

@ States

Only Parts which can have two states are displayed with this feature. Dis-
play colors for Parts can be specified separately for each state; for example,
a Bit Switch can be displayed as red in the OFF state and green in the ON
state. Click on either state button to select it, and specify that state’s color
using the color bar.

B Alarm Settings

In both graph and numeric value displays, Alarms can be set up.

First, click on the [Alarm Settings] tab at the top of the Dialog box. When
checking the Alarm Display box (Check mark [ appears), the Alarm setting
items will appear.

Bar Graph Settings [BA_001]

]
| General Settings || Giaph Settings || Shape/Calar]| Alarm%%/ Sets the AIarm
3
JE— I Vall:le s Format
@ Do to fixed or
& et variable

Alarm Colar

e JEJ!IDEI!IEI'
llles WEEOmECNE e | Sets the Alarm
colors used

Sets the minimum —|
and maximum
Alarm values

[ Peoe I conce |[ Her |

€ Alarm Type

The Alarm value can be specified as either direct (fixed value) or indirect
(variable value) by simply clicking on the appropriate circle.
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€ Alarm Range

Here, you can specify the maximum and minimum Alarm values.

When the Alarm value has been specified as indirect, the maximum and
minimum values can also be specified as indirect. In this case, the Word
Address number used to store these values will be automatically assigned
continuously from the Word Address currently specified.

The following example uses “n” to denote where the Word Address’ display
data is stored:

<Indirect Alarm Settings>

Alarm Fange
M Val 0 ..—| Word Addresses are automatically
.y aluE [ allocated in sequence, starting
= from the Address designated
Max. Walue |30 = | ° '9

<Relationship between display data’s storage address and Alarm register

address>
With 16 Bit data With 32 Bit data

n Display Data n ]

n+1 |Data value - Max. n+1 ~ Display Data .

n+2 |Data value - Min. n+2 | Data value - Max.
n+3
n*4 | pata value - Min. -
n+5

¢ Alarm Color

Here, you can select the colors used for an Alarm display.
2.1 Parts W Selecting Colors

B Creating Labels

Here, a Label means the text characters shown on the faces of the Switch
and Lamp button Parts. Labels can be registered via the Part’s Setting

dialog box. Label

As with Parts, Label display colors can be created for each of a 2-state Part’s
states; up to 4 lines of text can be used for each state.

<OFF state> <ON state>

When a lamp’s Text Display changes
(This Switch’s ON/OFF colors are also se-

lected)
j%oi\% The Part must be large enough to display the entire Label.

GP-PRO/PB Il for Windows Ver. 5.0 Operation Manual 2-11



2.1 Parts Chapter 2 - Base Screens

Click on the [Label] tab in the Setting dialog box.

Bit Switch Settings [BS_001] =]

[General Setlings || Shape/Colar]| Label |
OFF Tewt Tracking

Enter the charac-
ters here

Appears only when
the Part has two — ||
states

|| — Copies the charac-

ters to the label for
the Off state.

OFF Test Color b

Syles \ .
| ®kema | [ EEEOEEOONEEE Copies the charac-
Selects the o
2 Raized

Selectthe — ||
character’s size

it —— ters in the Descrip-
character’s type
yp tion field to the label
for the selected state.

Select the label’s
[ Pace || Cancel || Heb color here

& Label

Here, you can type in the text displayed on a button. When typing in text,
press the . key to move to a new line. When the [Tracking] check box is
checked [+ (enabled), after the Part has been placed on the screen, if the
Label’s size or position is changed, for either state, the alternate state’s Label
size and position will be also automatically changed. If, however, the
Label’s size and position need to be specified independently for each state,
DO NOT check [ this box.

2.4.3 Scaling Up/Down
@ Copy from Description

The characters entered in the Description filed are copied to the label in the
selected state.

@ Copy to Off (On) state

When the state is On, the characters entered in the label are copied to the
label in the Off state. When Off, the characters are copied to the label in the
On state.

& State

States are displayed only for Lamps, and for those switches with two states
(ON and OFF). The text displayed for each state can be specified indepen-
dently. Simply click on either state button to specify its text and colors.

@ Character Size
Specifies the size of character.
2.2.9 Text
@ Style (Font)
Specifies the type of character (Normal, Bold, Raised) used in each Label.
2.2.9 Text
@ Text Color (ON/OFF)

Specities Label colors.
The default settings are Fg: White, and Bg: Transparent mode (Black + Blk).
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@ Alignment (Justification)
When the text input for a Label exceeds one line, the Alignment icons will

appear. Select Left, or Right justification, or Centering.

State OFF Text Tracking

[an] o

Character Size Spacing Alignment
Left-justified Centered Right-justified

@ Tracking

This feature allows you to link the OFF and ON states of a Bit switch. This
will always keep the 2 states together when one is moved.

M ID Numbers

When creating a Part, an ID number is automatically assigned to the Part
before it is placed on the screen. This number shows how many of that kind
of Part were previously placed on the current screen. When a Part is deleted
from a screen, all following Part numbers will be adjusted downwards.

Example of an ID number

BS-010
Indicates that this Part is a Bit |— Indicates the placement/
Switch creation order of the Part; in
(Varies according to the Part) this case, it is the 10th.

The ID number is displayed in the title bar at the top of the Setting dialog
box.

Bit Switch Settings [BS_001]

General Settings | Shape/Color || Label |
Description Operation Bit Address
—
state [On [ o] Biamian
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ﬁé\te: The ID number can be entered so that it is displayed during Base screen
drawing.

2.9.2 Screen Property Settings

Even if the ID number is entered to be displayed during Base screen draw-
ing, it will not be displayed on the GP panel after screen data transfer.

<ID Number List>
Part Name ID Number
Bit Switch BS-**
Word Switch WS-***
Function Switch FS-***
Toggle Switch L
Lamp LA-***
4-state lamp LF-***
Bar Graph BA-***
Pie Graph Pl-***
Half-Pie Graph HP-***
Tank Graph SG-***
Meter MT-***
Trend Graph TR-***
Keypad KE-***
Keypad Input Display KD-***
Alarm Display AL-***
File Name Display FD-***
Data Logging Display LG-**
Numeric Display ND-***
Message Display (Operation Mode: Bit) MB-***
Message Display (Operation Mode: Word) | MW-***
Date Display DD-***
Time Display TD-***
Picture Display (Motion mode: Bit) LB-***
Picture Display (Motion mode: Word) LW-***
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B Maximum Number of Automatically Created Part Libraries

When a Part is used in a project, a Part Library will be automatically created
in preparation for data transfer. The number of Part Library items are

limited to 6000 per project. If this number exceeds 6000, all Parts in excess
of 6000 cannot be transferred to the GP. To avoid this, please remember the

following:

1. Automatic Library creation will be performed follows: (per screen)
Switches: 2 (only switches with the Monitor function selected)
Lamps: 2
Messages: 2 to 16 (depending on the number of states used)
Picture Displays : 2 to 16 (depending on the number of states used)
Trends: 1 to 20 (depending on the number of channels)

However, Part Libraries using the same Parts (i.e. Part’s that are the
same size, same attributes, and without labels or other items) will be used
commonly.

For example:
When 30 Switches (Monitor function is selected) and 20 Lamps are
placed on a single Base screen, (30 x 2) + (20 x 2) = 100 Part Library
items will be automatically created. Therefore, 60 of these size
screens can be used in one project('s data).

2. When using the same Parts for multiple Base screens, register the Part on
one Base screen and then place it other Base screens using the Load
Screen function. Thus, when multiple Base screens use those Parts, only
one Part Library will be used, thereby reducing the Project File’s size.
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B Placing a Part in Position

Chapter 2 - Base Screens

After all of a Part’s attributes have been entered or selected, click on the
desired position on the screen to place the Part.

PROCEDURE

REMARKS

(1)After all of a Part’s attributes have been entered or
selected, click on the button.
The Part’s outline will appear on the Base screen, next
to your cursor.

.‘l N[ s ][ | |

(2)Click on the point where the Part’s top left corner is
to be placed.
The selected Part will then appear on the screen.

(3)Adjust the Part’s size, if desired.
Click on the Part to select it, and drag any one of the
handles to change the size of the Part.
To change the size of a Part, move the cursor to a Part
“handle” and click, then drag the “handle” to re-size the
Part, and click again.

2.4.3 Scaling Up/
Down

After placing the Part, double-
clicking on it automatically brings
up its Attribute Setting dialog box.

2.4.14 Changing
Attributes

ﬁ(k)\te: Depending on the Part, when scaling up or down, a one dot error may occur

in the frame width.

E.g.)
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m Bit Switches

Here, the creation of a touch panel switch, used for turning a specified Bit
ON or OFF, is explained.

2.1 Parts

If the GP unit has not been connected to the host PLC, Bit
Switches with the Monitor function selected will not be dis-

Important  played on the GP unit after the Project File transferred.

B Bit Switch [General Settings| Attributes

Enter comment
data here

Image of the

currently se- T

lected Part Shape

Bit Switch Settings [B5_001]

" General Settings | Shape/Colar Label |

Drescription

Operation Bit Address
)

Erowser...

Calls up the Part
Shape Browser,
where different
Part Shapes can
be selected

T Moritar

Whonifan Bif Sddress:

il
Functior e CIptiar
¥ Bit Set ) Buzzer
2 Bit Resst ) Oneshes
29 Momertan

Bit Irwert

7] Interlock
Interlock &ddres:
(%] o000 =

Touch available condition

BEDy LD ENDY

Sets the switch’s

" Place ” Carcel ||

Help |

function

@ Operation Bit Address
Here, the Bit Address data controlled by the Switch is input.
€ Monitor Bit Address

Only after the Monitor check box is checked can the Monitor Bit Address
used to change the Switch’s display setting be entered. The Switch’s state
(ON/OFF) display can be specified so that it will change according to
changes in this Bit Address. Addresses input in the Bit Address area can

also be done here

Appears only
when creating a
Bit Switch with
two states.
Toggles the
switch’s state
either ON or OFF,
allowing you to
set the attributes
of each state

Selects the

Interlock

Enter the Bit
Switch Address

|_— When creating
a Bit Switch
with two states,
check this box
and enter the
alternate Bit
Switch Address
below

Sets the buzzer
to ON/OFF

function state

Bit Switch Settings [B5_001]

" Gieneral Settings | Shape/Color | Label |

Descriptioh

Browser...

State

Operation Bit Address

(%] e ~ |
]:] tamitor
Wmitan Bl dddinsy
<0000 =~
Function
%9 Bit Set
2 Bit Reset
2 Momertary
2 Bit Inwert

) Interlock
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After entering the Bit Address, if you attempt to perform another area’s
operation before entering the Monitor Bit’s address data, the dialog box
shown below will appear. Clicking on the button automatically
inputs the Bit Address’s data into the Monitor Bit Address. To enter a

different address, click on the button and input the desired ad-
dress.

Do you want to use the zame Bit Address
far the Monitor Bit Address?

& Function

The Bit Switch functions are as follows.

Bit Set: When the Bit Switch is pressed, the PLC’s designated Bit
Address is turned ON. This state continues (i.e. remains
ON) even after the switch is released.

When the Bit Switch is pressed, the PLC’s designated Bit
Address is turned OFF. This state continues (i.e. remains
OFF) even after the switch is released.

Only while the Bit Switch is pressed and held is the
specified PLC Bit Address turned ON. Thus, when the
switch is released, the specified Bit Address is turned OFF.
Every time the Bit Switch is pressed, the PLC’s designated
Bit Address state is changed (from ON to OFF, or from
OFF to ON).

Bit Reset:
Momentary:

Bit Invert:

@ Interlock

Only when a bit designated via Interlock Address is in a state that has been
selected via [Touch available condition] radio buttons, the switch becomes
effective. Whether the switch is effective in ON state or in OFF sate is
selectable here.

Gt

ote: This feature is only available on GP377, GP77R and GP2000 series units.
X2)
Touch Available Interlock Address |Touch Available/
Condition Status Not Available
Bit ON ON Touch Available
: OFF Touch Not Available
. ON Touch Available
Bit OFF OFF Touch Not Available

Bl Bit Switch [Shape/Color]| Attributes

Here, the Switch’s border color (Frame), ON/OFF state colors (On Color,

Off Color), and pattern can be selected.
2.1 Parts M Selecting Colors

The color and pattern settings available will differ depending on the switch’s

settings.

B Bit Switch [Label] Attributes

Here, the text of the Label to be displayed on the Switch button is entered.

2.1 Parts M Creating Labels

2-18
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B Placing a Bit Switch
An example of how to place a Reverse Switch is shown below.
First press of the Switch The next press resets M0016
sets M0016
PROCEDURE REMARKS

(1)Select the [Parts] menu - [Bit Switch] command, or

click on the || icon.

(2)In the [General Settings] screen, input the Bit Ad-
dress and select the Bit’s Function.

Bit Switch Settings [BS_001]

General Settings | Shape/Color | Labsl |

] Maniter

Operation Bit Address
- g

- Enter M0016

it Biddtiss

[aaan =
Funci Dptio

] interlock

Interlock Address

[E] feonoa

Touch available condition
ol L = i)

Face | Cacd |[ Heb |

When the switch’s
state can change,
click here

Selectable only in
momentary mode

Select the Bit

Invert function

(3)Select a Part Shape from the Browser.
If desired, Select the desired color(s) and input a Label
from the Shape/Color and Text areas.

Shape Browser

,,,,,

SwW_3D002Z |

SW_3D004 |

SW_3D005 |

SW_3D006 " FDE Fle...

Current PDE File : Jc:\propb3wm\pdb\ap4—3d01.pdb |

Title jsw_3Dnn1

a

|

(4)After all of a Part’s attributes have been entered or

selected, click on the button.

The Switch’s outline will appear on the Base screen, next

to your cursor.

When the Change State function se-
lected, after entering the Bit Ad-
dress, if you attempt to perform
another area’s operation before en-
tering the Monitor Bit Address, the
dialog box shown below will ap-

pear. Click on the button

to input the same address as used
for the Bit Address. To enter a dif-
ferent address, click on the

button and input the de-

sired address.

Bit Switch

Do pou want to uze the same Bit Address
fior the Monitor Bit Address?

2.1 Parts B Select-
ing a Part Shape
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Chapter 2 - Base Screens

PROCEDURE

REMARKS

(5)Click on the point where the Switch’s top left corner | To cancel the placement, click on

is to be placed.

the icon.

If desired, use the Switch’s handles to alter its size. To change the Part’s size, refer to

2.4.3 Scaling Up/
Down.

Double-clicking on any Part placed
on the screen automatically calls up
that Part’s Attribute Setting dialog
box.

2.4.14 Changing

Attributes

2-20
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2.1 Parts

@ Word Switches

Here, a touch panel switch for setting data to a specified Word Address can

be created.

B Word Switch

Enter Comment

data here \

The Word
Switch’s image
appears here

Calls up the Part —|

Shape Browser
Parts can be
selected directly
from the Browser

Selects the —

Interlock func-
tion

@ Word Address

[General Settings] Attributes

Bit Switch Settings [BS_001]

General Settings | Shape/Color | Label |

Operation Bit Address

(%] o000

|_— Enter the Word
Address you
wish to use

Deescription

[y S—

=

7] Moniter

m— Enter the data

Optior .
& i Sel ) Buzeer for the Switch
2 Bit Resst ) O Shat
£ Momen R to send to the
jomentary
£ Bit vt Word Address

Sets the buzzer
to ON/OFF

T Interlnck
Interlock. Address
20000 ~||EE

Touch available condition
Senln L ERDK

Select the
Switch’s func-
tion

| Place ] ‘ Cancel 1 ‘ Help 1

Here, the desired Word Address is entered.

& Constant

Here, number registered to the Word Address is input. The data format is
Decimal (Base 10), and the input range is from -32768 to 32767.

& Function

The Word Switch’s functions are as follows:

Word Set:

Add/Sub:

Digit (ADD):

Digit (SUB):

When the Word Switch is pressed, constant data is written
to the PLC’s designated Word Address. Fixed or default
values will be written to the timer, counter, etc.

Every time the Word Switch is pressed, the Data value is
added to the data currently in the PLC’s designated Word
Address, and the result is then written to the PLC’s address.
If a Data value is positive, the function will increment, and
if it is negative, it will decrement.

Every time the Word Switch is pressed, the designated
decimal place’s data will be added by the Constant’s value.
The result will not be carried up to the next digit, so “9”
simply rolls around to “0”. Select the data format from Bin
and BCD.

Every time the Word Switch is pressed, the designated
decimal place’s data will be subtracted by the Constant’s
value. The result will not be carried down to the lower
digit, so “9” simply rolls around “0”. Select the data
format from Bin and BCD.
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@ Interlock

Only when a bit designated via Interlock Address is in a state that has been
selected via [Touch available condition] radio buttons, the switch becomes
effective. Whether the switch is effective in ON state or in OFF sate is

%I}V\ote:

X2

selectable here.

This feature is only available on GP377, GP77R and GP2000 series units.

Touch Available Interlock Address |Touch Available/
Condition Status Not Available
Bit ON ON Touch Available

OFF Touch Not Available
. ON Touch Available

Bit OFF OFF Touch Not Available

B Word Switch [Shape/Color] Attributes

Here, a Word Switch’s color, and pattern can be selected.

2.1 Parts B Selecting Colors

The color and pattern settings available will differ depending on the
Switch’s settings, such as its shape and Change State condition.

B Word Switch [Label] Attributes

Here, the text characters shown (engraved) on the Switch button face are
input.
2.1 Parts B Creating Labels

B Placing a Word Switch

An example of how to place a Word Set Switch is shown below.

[ e e

When the button is pressed, 34 is sent to D00001

PROCEDURE REMARKS
(1)Select the [Parts] menu - [Word Switch] command,
or click on the icon.
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2.1 Parts

PROCEDURE

REMARKS

(2)In the [General Settings] area, input the Word Ad-
dress and Constant data, and select a function.

Bit Switch Settings [BS_001]

| General Settings | Shape/Color | Label |

Description Operstian Bit Address — Enter D0001
] s e

7] Moritor

iomivon Bit Addigss

E

y Opt T Enter 34
[¥] Buzzer

) Qe St

T nteriock. \‘

Intelock Address I Select Word Set

Touch avalable condition

BBy LB

[ Place H Cancel H Help |

(3)Select a Part Shape from the Browser.
If desired, select Colors and input a Label from the Shape/
Color and Label areas.

Shape Browser

SW_3D002 |

SW_3D004 ||| SW_3D005 | - | POB File..

Cunent PDE File : Jc:\proprwin\pdb\ap4-3dU1.pdb

|
Title: j Sw/_3po0t Er Help

(4)After all of the Part’s attributes have been entered

or selected, click on the button.

The Switch’s outline will appear on the Base screen, next
to your cursor.

(5)Click on the point where the Switch’s top left corner
is to be placed.

If desired, use the Switch’s handles to alter its size.

2.1 Parts B Select-
ing a Part Shape

To cancel the placement, click on

the [<2] icon.

To change the
Part’s size, refer to 2.4.3 Scaling

Up/Down

Double-clicking on any Part placed
on the screen automatically calls up
that Part’s attribute settings.
2.4.14 Changing
Attributes
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@ Function Switches ]

Here, a touch panel with special functions can be created.

B Function Switch [General Settings] Attributes

Enter Comment Function Switch Settings [F5_001]

data here " Gieneral Seliings | Shape/Color | Label | SeIeCt the
Deserpiion ~Functo Switch’s opera-
The Function %) Previous Scieen tion
Switch’s image T E’
appears here £ File Mame Key oY
PP D Na. ™ When “Go To
Calls up the Part —| [ &= | gg;tﬁ:m‘”gw Screen” is
Shape Browser. selected, the
Parts can be (Go To)
selected directly ﬁ;l“;;ﬂfjm screen’s num-
from the Browser /| mrw i g““ ber and data
Buzzer
Selects the fsthiamt oy formatdmust be
Interlock function Crme ][ cwen [ o0 ] entere
state
@ Function (Switch Operation)
The Function Switch’s attributes are as follows:
Previous Screen: When the Switch is pressed, the currently

displayed screen on the GP will change to
the previously displayed one.

Go To Screen: When the Switch is pressed, the currently
displayed screen on the GP will change to
the specified screen. Input the screen
number to be changed (jumped) to. The
Data Format can be either Bin or BCD.

ﬁé\te: If a screen number is specified in the BCD data format to place the corre-
sponding screen, it is still displayed in the BIN data format when the screen is
closed and then opened.

Reset GP: When the Switch is pressed, the GP will be
reset to the save status as when the GP’s
power was turned ON.

File Name Key: This is a function switch corresponding to
the File Name Display and is the same as
the one that is automatically placed together
with the File Name Display.

Designate the same ID number as the one of
the File Name Display and select a opera-
tion mode.

2.1.16 File Name Display

224 GP-PRO/PB III for Windows Ver. 5.0 Operation Manual



Chapter 2 - Base Screens 2.1 Parts

Data Logging Key: This is a function switch corresponding to
the Data Logging Display and is the same
as the one that is automatically placed
together with the Data Logging Display.
Designate the scroll direction and the
number of lines being rolled up or down.

2.1.17 Data Logging
Display
OFFLINE: When this switch is pressed, the GP enters
the OFFLINE mode.

@ Interlock

Only when a bit designated via Interlock Address is in a state that has been
selected via [Touch available condition] radio buttons, the switch becomes
effective. Whether the switch is effective in ON state or in OFF sate is

@\ selectable here.
‘Note: This feature is only available on GP377, GP77R and GP2000 series units.

X2
Touch Available Interlock Address |Touch Available/
Condition Status Not Available
ON Touch Available
Bit ON OFF Touch Not Available
ON Touch Available
Bit OFF OFF Touch Not Available

B Function Switch [Shape/Color]| Attributes
The Switch’s color, and pattern are selected here.

2.1 Parts W Selecting Colors
The color and pattern settings available will differ depending on the switch
shape.

B Function Switch [Label] Attributes
Here, the characters shown (drawn) on the Switch button face are entered.
2.1 Parts B Creating Labels
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B Placing a Function Switch

The Screen Switching (Function) Switch’s placement procedure is shown

below.
4 N\

E1 E10

N o
ol =
Pressing this button, shifts to screen B10.
- /
PROCEDURE REMARKS

(1)Select the [Parts] menu - [Function Switch] command,
or click on the |%i|icon.

(2)Designate the [Function] on the [General Settings]
tab.

Function Switch Settings [FS_001] / Se'eCt GO TO
Gererd Stinge [Sraperle [ Lo | Screen

5 Previous Sereen
£ Gio To Scresn B
£ Rleset GP
£ Fls Name Key
D Na.
£ Dats Logging Key

£ Oif ine
Enter 10
7] Interlock
Interlock Address
Touch available condition E fue
P Select Bin
[ Pace |[ tence ][ Hee |
(3)Select a Part Shape from the Browser. 2.1 Part W Select-

If desired, select Colors and input a Label from the Shape/ | ing a Part Shape
Color and Label areas.

Shape Browser

sw_3D002 | |sw_NO_BOR

sw_30004 ||| sw_30005 ||| sw_3D006 |/~ FoeFie..

Current PDB File J.:\pmph3wm\pdh\up4-3dﬂ1 pdb \

Tile : [5w_30001 i
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2.1 Parts

PROCEDURE

REMARKS

(4)After all of Part’s attributes have been entered or

selected, click on the button.

The Switch’s outline will appear in the Base screen, next
to the cursor.

(5)Click on the point where the Switch’s top left corner
is to be placed.

If necessary, use the Switch’s handles to alter its size.

To cancel the placement, click on
the [«] icon.

To change the Part’s size, refer to:

2.4.3 Scaling Up/
Down

Double-clicking on any Part placed
on the screen calls up that Part’s At-
tribute Setting dialog box.

2.4.14 Changing
Attributes
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@ Toggle Switches

Here a toggle type touch panel switch, used to turn a specified Bit ON or

ﬁé\te:
A\

)

OFF is created.

A Toggle Switch will not be displayed on the GP when transferred, if the GP
has not yet been connected to the PLC.

B Toggle Switch [General Settings] Attributes

Enter comment
data here

Changes the
state of the
dialog box’s
switch display to
either ON or OFF

Displays the /

currently se-
lected Part

Calls up the Part
Shape Browser.
Part Shapes can
be selected di-
rectly from here

Toggle Switch Settings [TS_001]

 General Settings | Shape/Color | Label |

[rescription

<0000
State Monitor Bit Address

) Interlock

Browszer...

1 BiyOn

Operation Bit Address

]
[
) Buzzer

Interlock Address\
<0000 ~EE

Touch available condition

2 Biy i

|

|

Flace ” Cancel H

Help

l

Enter the Bit
Address to be
operated via
the Switch

— Enter the
desired Monitor
Bit Address
here

— Selects the
Interlock
function state

@ Operation Bit Address

The number of the Bit Address to be operated via the Switch is entered here.
€ Monitor Bit Address

Here, the Monitor Bit Address used to change the Switch’s display is en-
tered. The Switch’s ON/OFF state can made to change according to changes
in the Monitor Bit Address data. The same address as the Bit Address’s can

be used here.

After entering the Bit Address, if you attempt to perform another area’s
operation before entering the Monitor Bit Address’s data, the dialog box

shown below will appear. Clicking on the button automatically
enters the Bit Address data. To input an address different from the Bit
Address, click on the button and input the desired Monitor Bit

Address.

Toggle Switch

Do you want bo uze the zame Bit Address
for the Monitor Bit Address?

2-28
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@ Interlock Address

Only when a bit designated via Interlock Address is in a state that has been
selected via [Touch available condition] radio buttons, the switch becomes
effective. Whether the switch is effective in ON state or in OFF sate is
selectable here.

Z

ote! This feature is only available on GP377, GP77R and GP2000 series units.
2]
Touch Available Interlock Address |[Touch Available/
Condition Status Not Available
ON Touch Available
Bit ON -
OFF Touch Not Available
ON Touch Available
Bit OFF -
OFF Touch Not Available

B Toggle Switch [Shape/Color] Attributes

The Switch’s frame colors (Frame) for the ON and OFF states can be selected.

2.1 Parts W Setting Colors
The color and pattern settings available will differ depending on each
switch’s settings, such as its shape and state change conditions.

W Toggle Switch [Label] Attributes

Here, the text characters shown (Raised) on the Switch button face are
entered.

2.1 Parts B Setting Labels

B Placing a Toggle Switch

The Toggle Switch placement procedure is shown below.

Pressing ON sets M0016, and pressing OFF resets it.

PROCEDURE REMARKS

(1)Select the [Parts] menu - [Toggle Switch] command,
or click on the icon.
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PROCEDURE

REMARKS

(2)In the [General Settings] area, input the Operation
Bit Address.

Toggle Switch Settings [TS_001]

General Settings | Shape/Calor | Label |

Operation Bit Address

Blpon  _FlEE—
oritor Bit Address
i Er—)

Option 1
] Buzzer
) Interlock.

Interock Address

o Er—)

Touch available condition

ey 1B

[rescription
1 |
siae

Enter M0016 here

Birawser

‘ Place ” Cancel H Help ]

(3)Select a Part Shape from the Browser.
If desired, select Colors and input a Label from the Shape/
Color and Label areas.

Shape Browser [%]

Sw_3D304 ||| Sw_3D305 ||| sw 30306

FDE File...
|
T tee

Current PDE File Jc \propb3winipdbiopd-3d02. pdb
Title - sz_303m

(4)After all of a Part’s attributes have been entered or
selected, click on the button.

The Switch’s outline will appear in the Base screen, next
to your cursor.

(5)Click on the point where the Switch’s top left corner
is to be placed.

If desired, use the Switch’s handles to alter its size.

After entering the Operation Bit
Address, if you attempt to perform
another area’s operation before en-
tering the Monitor Bit Address
data, the dialog box shown below
will appear.

Toggle Switch

Do vou want to use the zame Bit Address
for the Monitor Bit Address?

Clicking on the button

automatically inputs the Operation
Bit Address into the Monitor Bit
Address area. To input an address
different from the Bit Address,

click on the button.

2.1 Parts M Select-
ing a Part Shape

To cancel the placement, click on
the [=] icon.

To change a Part’s size, refer to

2.4.3 Scaling Up/
Down

Double-clicking on any Part placed
on the screen automatically calls up
that Part’s attribute settings.

2.4.14 Changing
Attributes
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@ Lamps ]

Here a lamp is created, which turns ON or OFF according to the PLC’s
Monitor Bit Address state.

Lamps will not display on the GP unless the GP has been

1 connected to the PLC.

Important When placing a Lamp, DO NOT overlap it with other objects. If

you do so, it may not be displayed correctly.

B Lamp [General Setting] Attributes

Enter comment Lamp Settings [LA_DO1]
data here  General Settings | Shape/Color | Label | . Enter the

Description Bit Addriess desired Bit

) B FE Address here

Displays the cur-
rently selected Part

|~ Changes the
Calls up the Part —] state of the
Shape Browser. dialog box’s
Part Shapes can switch display
be selected to either ON or
directly from here OFF

" Place ” Cancel H Help

@ Bit Address

The Bit Address to be monitored is entered here.

B Lamp [Shape/Color] Attributes

Here, border colors for both ON and OFF states, and Lamp’s colors and
tiling pattern in each state can be selected.

2.1 Parts W Selecting Colors
The color and pattern settings available will differ depending on each lamp
shape.

B Lamp [Label] Attributes
Here, the text characters shown on a Lamp button’s face are entered.

2.1 Parts B Creating Labels
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B Placing a Lamp

The procedures for creating and placing a Lamp are shown below.

When X0017  the Lamp When X0017 the Lamp

is ON... lights up. is OFF... turns off.
PROCEDURE REMARKS
(1)Select the [Parts] menu - [Lamp] command, or click
on the [ icon.
(2)In the [General Settings] area, enter a Bit Address.
Lamp Settings [LA_001] [x]
General Settings | Shape/Color [ Label |
Crescription Bit Address -
: ” | Enter X0017 here
State ,W

” Place ”l Cancel |” Help I
(3)Select a Part Shape from the Browser. 2.1 Parts M Select-
Select Colors and input a Label, if desired. ing a Part Shape

Shape Browser

Cancel

LM_3poo1 || IXECTIEE With the Blink check box checked
[}, and if the Bit is turned ON, the

Lamp will blink. Lamp blinking
can also be seen via the pull down
menu [View]’s [Preview] com-

——————

LAMP_NO_Bd

LM_3D005 ||| LM_3D006 FDE: File...

Current FDE File : Jc::\propb3wwn\pdh\op4-3d01.pdb

|
Title: [LM_30001 L Hep mand.
NEEOENER 2.9.3 Preview
Screen
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PROCEDURE REMARKS

(4)After all of a Part’s attributes have been entered or

selected, click on the button.

The Lamp’s outline will appear in the Base screen, next
to your cursor.

(5)Click on the point where the Lamp’s top left corner | To cancel the placement, click on
is to be placed. the [« icon.

If necessary, use the Lamp’s handles to alter its size. To change the Part’s size, refer to

2.4.3 Scaling Up/
Down

Double-clicking on any Part placed
on the screen automatically calls up
that Part’s attribute settings.

2.4.14 Changing
Attributes
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@ 4-State Lamp

Here, a 4-State Lamp, which changes its state according to whether the

/A

)
Important

)

PLC’s two Monitor Bits are ON or OFF, are created.

Even when a 4-State Lamp data is transferred to the GP, if the

GP and PLC have not communicated, the 4-State Lamp will
not be displayed on the GP.

When placing a 4-State Lamp, DO NOT overlap it with other
objects. If you do so, it may not be displayed correctly.

B Features of 4-State Lamp

Enter comment

4 State Lamp Settings [LF_001]

x|

data here’ if General Settings | Shape/Colar [ Label |
necessary. Description Lamp Address1
] (] foono H“

Changes the Lamp Address] Lamp Address? H- Enter a

9 T .E_n] [ [ronaa e desired Bit
state of the Lamp [p—— = B
currently dis- [on J or] Address to
played on the be moni-

tored.

dialog box to
either ON or OFF.

Browser...
Displays the '
currently selected
Part’s image.

|| Flace I ” Cancel | " Help

Calls up the Part
Shape Browser. A
Part Shape can be
selected directly
from here.

€ Lamp Address
Enter the two Bit Addresses (Lamp Addresses 1 and 2) to be monitored.

€ Lamp Address m

Changes the Lamp state by changing the combination of the two Bit’s ON/
OFF state.

When the two Bits that have been assigned to the Lamp Addresses are
changed simultaneously, the Lamp state change is recognized as follows
according to the Bit read timing, which makes the Lamp display flicker.

foe:
2]

e.g.) When Lamp Addresses 1 and 2 are changed from OFF to ON
simultaneously:
Lamp Address1 |0 >0 — 1
Lamp Address2 [0 >1—1
Or
Lamp Address1 [0 > 1 —1
Lamp Address2 |0 >0 — 1
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B Features of 4-State Lamp (Shape/Color)

Here, a 4-State Lamp’s border colors for both ON and OFF states and
Lamp’s colors and tiling pattern in each state can be selected.

2.1 Parts B Selecting Colors

The color and pattern settings available (effective) will differ depending on
each Lamp shape.

B Features of 4-State Lamp (Label)

Here, the text characters shown on a Lamp button’s face are entered.

2.1 Parts B Creating Labels

Bl Positioning a Lamp

The procedure for creating and placing a 4-State Lamp are shown below.

[ The Lamp state will be switched according to the Lamp Addresses X0017’s )
and X0018’s ON/OFF states.

When X0017 is When X0017 is When X0017 is When X0017 is

OFF and ON and X0018 ON and X0018 OFF and
L X0018 is OFF is OFF is ON X0018 is ON
PROCEDURE REMARKS
(1)Select the [Parts] menu - [4-State Lamp] command,
or click on the | icon.
(2)Enter Lamp Addresses 1 and 2 in the [General Set-
tings] tab.
(e i =T Enter “X0017".
IDescriptiﬂn " Ié]nlllxumlsss .ﬁ
Lamp Address1 Lamp &ddiess2
[on Jon ] =

Lamp Addiess?

Y

T

~ Enter “X0018”.

Browser... |

[ Place || rancsl || e
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PROCEDURE

REMARKS

(3) Select a Part Shape from the Browser.
Select Colors and set up a Label, if desired.

Shape Browser

LM_3D001

LM_3D005 ||| LM_3D006 ||| LM_3D007 |

FDB Fil...
Curtent FDE File : [c\propbwin'pdbpdb pdb
Title:[LM_z000 El ke |

(4) User either or button to change the Lamp

Address states and select Colors and Pattern for each
state.

Set up a Label for each state, if desired.

4 State Lamp Settings [LF_001] _

[General Setings || Shape/Color [ Label |

Buorder Color
LT TIST 1Tl a 15 e

-, B
5 W

Patten

[ Piece || cance | Hep |

(5) After all of a Part’s attributes have been entered or

selected, click on the button.

The 4-State Lamp’s outline will appear on the Base
screen, next to your cursor.

(6) Click on the point where the 4-State Lamp’s top cor-
ner is to be placed.

Use the 4-State Lamp’s handles to alter its size, if nec-
essary.

2.1 Parts W Select-
ing a Part Shape

To cancel the placement, click on

the icon.

To change the
Part’s size, refer to 2.4.3 Scaling

Up/Down.

Double-clicking on any Part placed
on the screen automatically calls up
that Part’s attribute settings.

2.4.14 Changing
Attributes
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E Bar Graphs ]

Here the setup (creation and placement) of a bar graph is explained. Bar
Graphs are used to display PLC Word Address numeric data in absolute or
relative values. This graph’s display will change according to Word Address
data changes.

B Bar Graph [General Settings]| Attributes
<When displaying Word Address numeric data in absolute values>

Select absolute or relative
value display
Enter comment

data here Bar Graph Settings [BA_001]

General Settings ‘Graph Gettings [‘Shane/éolarTA\arm Settings | L Enter the
Description (% Absoue £3 Relative ) desired Word

Displays the Word Address Address to

currently se- (i3] [oooon rlE 7] Display Made +/- store graph

lected Part b Foms— data here

B0

Calls up the Part —| L\;

Shape Browser. S.elect the ’

Part Shapes can be : display data’s

selected directly [ e [ oo ] ] data format

from here

@ Absolute

Data stored in the Word Address is displayed in absolute values from 0 to
100 (with Display Mode +/- selected, -100 to 100).

€ Word Address
Here, enter the Word Address used for storing the Bar Graph’s data.
@ Data Format

The display data’s format can be either Bin or BCD.
When Bin is selected, negative numeric data can also be displayed. In that

case, check [[w]| the Display Mode +/- check box.
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<When displaying PLC Word Address numeric data in relative values>

Select the Relative value display

Enter comment Used to store the
data here B‘ e [ . 1 L — graph’s data.
General Settings | Graph Settings | Shape/Color |/ &larm Settings H
. Description £ Bbsolte é Fie/aiive: Enter the desired
Displays the ) Word Address
currently se- ord e _
Epoow & I Display Made +
lected Part -
Bilengh [ |= ~—_ Select the
put Range Input Cod display data’s
. E]I % No Cade
Calls up the —| Movae |15 25 4125 Conplener format

Part Shape [t ]

Browser. Part ‘

Max Value  |B5535 %] L +/- M3SB T

] ™ Select the data’s

Place ” Cancel H Help

Shapes can be Input Code
selected di-
rectly from here Specifies data’s Bit Specifies data
Length Input Range
@ Relative

According to the Input Range designated for the Word Address’ data, the
data is converted and displayed as relative values.

€ Word Address
Here, enter the Word Address used for storing the Bar Graph’s data.
@ Display Mode+/-

When this check box [Jw| is checked, negative numeric data can also be
displayed.

@ Bit Length

Specifies the Bit Length of data stored in the Word Address.
@ Input Range

Specifies the data’s Input Range.
@ Input Code

When No Code is selected, only positive data can be entered. To enter
negative number data, select +/-2°s Complement or +/-MSB.
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ﬁé\te:
A\

Rote;
2

B Bar Graph [Graph Settings| Attributes
Bar Graph Settings [BA_001]
Gereral Settings || Granh Setting | Shape/Color || Alam Setting | 1 Only when a
Digplay Direction Axiz Divizions /// graph ‘N_ith
Selectthe || S graduations
e di £ Let has been
g!'aph_s display oo octed will
direction 9 it selected wi
¢ this box
appear.
Enter the
number of
” Place | ” Cancel | || Help dIVISionS

desired here
@ Direction
The graph’s display direction can be specified as either Up, Left, Down, or
Right.

If [Display Direction] is changed for a 3D part, its shade is rotated along with

that part. To let the shade displayed properly, click on the button,
and select the part again from [Shape Browser].

@ Axis Divisions

For a graph which has graduations, the number of divisions are entered here.
If the number of the divisions is specified to 10, then 11 division lines are
used. When graduations are not necessary, specify the number of the divi-
sions as 0.

Whether the graduations are necessary or not will differ depending on the
Part’s shape.

B Bar Graph [Shape/Color]| Attributes

The graph’s border color, division color (Axis Color), display data color
(Graph Color), and display data patterns are selected here.

2.1 Parts W Selecting Colors

B Bar Graph [Alarm Settings] Attribute
If desired, an Alarm can be setup here by toggling the Alarm check box.
2.1 Parts B Setting Alarms
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B Placing a Bar Graph

An example of the Bar Graph’s creation and placement procedures are
shown below.

~,
Data stored in D0102 displays on the Bar
Graph | l
When the value 34 is stored in D0102,[
the graph will look like this:
N grap J
PROCEDURE REMARKS
(1)Select the [Parts] menu - [Bar Graph] command, or
click on the [iiy] icon.
(2)In the [General Settings] tab, input a Word Address
and select a Data Format.
Bar Graph Settings [BA_001]
| — Enter D00102
here
— Select BCD
[ Pace || Cancel H Help 1
(3)Select a Part Shape that has graduations from the
Browser. . , 2.1 Parts M Se-
Her‘e, you can enter Alarm settings and select Colors, if lecting a Part Shape
desired.
o — If the Bar Graph’s Alarm value is
- specified as Variable, a pointer
showing levels will be displayed.
This pointer’s position will move
according to the specified Alarm
BG_3Do01U Value
Level pointer
BG_30003U | B li5 /W]
Curtent PDB File - J:-\prnpn3mn\pdh\np4-3dn1 poh \
Title - [BG_30002U F] | teb
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PROCEDURE

REMARKS

(4)In the [Graph Settings] tab, select the graph’s dis-
play direction and input the number of Axis Divi-
sions.

Bar Graph Settings [BA_D01]

Bllg
2Lt -+~ Enter 10 here

12 Down
£ Right

\

~ Select Up

Place ” Cancel H Help

(S)After all of the graph’s attributes have been entered
or selected, click on the button.

The Bar Graph’s outline will appear on the Base screen,
next to your cursor.

(6)Click on the point where the Bar Graph’s top left
corner is to be placed.

If necessary, use the Bar Graph’s handles to adjust its
size.

The area to enter the number of the
divisions will appear only for a graph
type which has axis divisions.

To cancel the placement, click on

the icon.

To change the Part’s size, refer to

2.4.3 Scaling Up/
Down

Double-clicking on any Part placed
on the screen automatically calls up
that Part’s attribute settings.

2.4.14 Changing
Attributes

The Bar Graph’s sizing handles are
located inside the graph.
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@ Pie Graphs ]

Pie Graphs create an area where a PLC’s Word Address data is displayed as
absolute values. The graph’s display will change to reflect changes in the
designated Word Address data.

B Pie Graph [General Settings] Attributes

<When displaying the data using absolute values>

Select Absolute or Relative

display
Enter comment _ _ Enter the
data here Pie Graph Settings [P1_001] W d
| General Settings | firaph Settifhs | Shape/Color | Alam Gettings or
Descipion ssds 5 Pelaive Address
The currently word Adiess used to

selected Pie
Graph’s image
appears here

Calls up the Part —7|

Shape Browser.

[ @M‘ I7) Display Mods +/-

Diata Format=—
# Bin
£ BCD \

‘ Place || Cancel ||

Help

Parts can be
selected directly
from the Browser

@ Absolute

store graph
data

Select the
desired
Data Format

Data stored in the designated Word Address is displayed in absolute values,

from 0 to 100 (with Display Mode +/- selected, -100 to 100).

€ Word Address

Here, the Word Address’ location data is entered to show where the desired

data is stored.

& Data Format

Select either the Bin and BCD display formats.
@ Display Mode +/-

With this check box |I¥] checked and the Bin data format is selected, a
negative numeric data can also be displayed.
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<When displaying the data using relative values>

Enter comment
data here

The currently
selected Pie
Graph’s image
appears here

Calls up the Part —

Shape Browser.
Parts can be
selected directly
from the
Browser

@ Relative

Select Absolute or Relative

display

Pie Graph Settings [PI_DD1]

General Settings J Graph Settings | Shape.r‘Co%] Alam Seftings |

Description

£ Absohite = Helatve

‘whord Address

=l ) (DGO | =
Bit Length "::
=Input Fiange Input Cod:
=] £33+ 2's Camplement
Max Value  |B5535 El
\

D Display Mode +/-

£ +/- MSB
[ Pl || Cancel H ‘\ﬂalp }
{

2.1 Parts

Enter the
Word Ad-
dress to
store graph
data

[T—— Select the

desired Data
Format

Specifies the

\

Specifies the data’s

effective Bit Length Input Range

data Input
Code

Specifies the data

According to the Input Range designated for the Word Address Data, the
data is converted and displayed as relative values.

€ Word Address
Here, enter the Word Address used to store Pie Graph data.
@ Display Mode +/-
When this check box [[+]| checked, negative numeric data can also be dis-

played.
@ Bit Length

Specifies the Bit Length of all data stored in the Word Address.

@ Input Range

Specifies the data’s Input Range.

@ Input Code

With No Code selected, only positive numeric data can be entered. To enter
negative numeric data, select either +/-2’s Complement or +/-MSB.
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B Pie Graph [Graph Settings| Attributes

Pie Graph Settings [P1_D01]

General Settings | Graph Settings | Shape/Color [| Alam Settings | | Enter the

Select the Pie — o graph’s
b
Graph,s (data |s.p::|y irectian s MSI number of
display) divisions
Direction
“ Place I “ Cancel | || Help
@ Display

Here, the graph’s data display start point, either Clkws. From Top or Clkws.
From Bottom, can be selected.

ﬁé\twel If [Display Direction] is changed for a 3D part, its shade is rotated along with

that part. To let the shade displayed properly, click on the button,
and select the part again from [Shape Browser].

@ Axis Divisions

The number of segments the Pie Graph will be divided into is entered here.
If the number of Axis Divisions is specified as 10, 10 division lines will be
displayed. When no divisions are necessary, simply enter 0.

B Pie Graph [Shape/Color] Attributes

A Pie Graph’s border color, division line color (Axis Color), data display
color (Graph Color - Fg and Bg), and data display pattern can all be selected
here.

2.1 Parts M Selecting Colors

B Pie Graph [Alarm Settings]| Attributes

Clicking on the Alarm Display check box will call up the Alarm Settings.
2.1Parts B Setting Alarms
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B Placing a Pie Graph

The procedure for placing a Pie Graph is shown below.

Data stored in D0102 displays on the

Pie Graph

When the value 34 is stored in
D0102, the graph appears like this:

PROCEDURE REMARKS

(1)Select the [Parts] menu - [Pie Graph] command, or

click on the ¥ icon.

(2)In the [General Settings] area, input a Word Address
and select a Data Format.

| Graph Settings | Shape/Color | Alam Settngs | | — Enter D00102
5 Absclute £ Relative h ere

Word Address

D002 sl ] Display Made +-

Data Format—
3 Bin | il
fg-loo]

[ Place ]| Cancel H Help

Select BCD

(3)Select a Part Shape from the Browser. 2.1 W Selecting a
You can also use the Alarm Settings area to choose an | Part Shape
Alarm and select Colors, if desired.

Shape Browser _

CG_3Doo2u

Tite : [C6_30001L] F e |

Currert PDE File: [cprogbwirtpdbtpdb. pdb |
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PROCEDURE REMARKS

(4)In the [Graph Settings] tab, select the display direc- | The area to enter the number of the

tion and input the number of Axis Divisions. divisions will appear only for a graph
type which has axis divisions.

Pie Graph Settings [P1_001]

— Enter 10

Display Direction

2 T, Fram Top
20 Clkans. From Bottom

" Select Clkws.
From Top

[ Ftace H| Cancel H| Help

(5)After all of the Graph’s attributes have been entered

or selected, click on the button.

A Pie Graph’s outline will appear on the Base screen,
next to the cursor.

(6)Click on the point where the Pie Graph’s top left cor- | To cancel the placement, click on

ner is to be placed. the icon.

If desired, use the Pie Graph’s handles to alter its size. To change the Part’s size, refer to
2.4.3 Scaling Up/
Down

Double-clicking on any Part placed
on the screen automatically calls up
that Part’s attribute settings.
2.4.14 Changing
Attributes
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2.1 Parts

@ Half Pie Graphs

)

This graph displays a Word Address’ numeric data (received from a PLC) as
absolute or relative values in a Half-Pie graph. The graph’s display will also
change to reflect Word Address data changes.

B Half Pie Graph [General Settings] Attributes

<When displaying the data in absolute values>

Enter comment
data here

The currently
selected Half Pie
Graph’s image
appears here

Calls up the Part —|

Shape Browser.
Parts can be

Select Absolute or
Relative display

T - Enter e
Description 18 thsolute £33 Riclative Word Ad-
[p E— Word Address dress to
&%) [ooooo = ) Display Made +/- store gra ph

>?3;t; rnrmat: \ data

T Select the
desired Data

Format
[Face [ el ][ Hew

selected directly
from the Browser

@ Absolute

Data stored in the designated Word Address is displayed as absolute values,
from 0 to 100 (with Display Mode +/- selected, -100 to 100).

@ Word Address

Enter the Word Address where the data will be stored.

@ Data Format

Select the display data format from Bin and BCD.

@ Display Mode +/-

When this check box [l#]| is checked and Bin data format is selected, nega-
tive numeric data can be displayed.
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<When displaying the data in relative values>

Select Absolute or
Relative display

Enter comment Enter the
data here Half Pie Graph Settings [HP_001] Word Ad-
Gierersl Settings | Graph Settings | Shape/Color | Alsifh 5 ettings | dress used to
Description solute latrvel
The currently N f’::dd“ store graph
selected Half Pie [Eafis FlliE data
Graph’s image BiLengh [i5 1 e
appears here - _—— Selects the
ae | gN;?d; - desired Data
+/- 2¢ Lomplement
Calls up the Part —{| O = S L Format
Shape Browser. -
Parts can be J e dle= U Specifies the
selected directly 7 data’s Input
from the Browser . . Code
Specifies the data’s Specifies the data’s

effective Bit Length Input Range

@ Relative

According to the Input Range designated for the Word Address Data the data
is converted and displayed as relative values.

€ Word Address
Here, enter the Word Address used to store Half Pie Graph data.
@ Display Mode +/-

When this check box |I#If checked, negative number data can be displayed.
@ Bit Length

Specifies the Bit Length of all data stored in the Word Address.
@ Input Range

Specifies the data’s Input Range.
@ Input Code

With No Code selected, only positive numeric data can be entered. To enter
negative numeric data, select either +/-2°s Complement or +/-MSB.
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B Half Pie Graph [Graph Settings] Attributes

Half Pie Graph Settings [HP_D01]

General Settings|| Graph Settings | Shape/Color || Alarm Settings | | Enter the
Select the Half — ]| ... 010 graph’s
Pie Graph’s (data || © g number of
display) Direc- divisions
tion
|| Place | ” Cancel | ” Help
@ Display Direction

Here, the Half Pie graph’s display direction is fixed to clockwise.
@ Axis Divisions

The data entered here determines how many pieces a Half Pie Graph is
divided into. If the number of Axis Divisions is specified as 10, 10 division
lines are displayed. When no divisions are necessary, specify the number of
divisions as 0.

B Half Pie Graph [Shape/Color]| Attributes

Here, a Half Pie graph’s border color, division color (Axis Color), display
data color (Graph Color - Fg & Bg), and display data pattern are all selected.

2.1 Parts W Selecting Colors

B Half Pie Graph [Alarm Settings] Attributes
If desired, Alarm settings can be set here.
2.1 Parts W Setting Alarms

GP-PRO/PB Il for Windows Ver. 5.0 Operation Manual 2-49



2.1 Parts Chapter 2 - Base Screens

B Placing a Half Pie Graph

The procedure for placing a Half Pie Graph is as shown below.

Data stored in D0102 displays on the Semicircle Graph

When data 34 is stored in D0102, the
Half Pie graph will appear as follows:

PROCEDURE REMARKS

(1)Select the [Parts] menu - [Half Pie Graph| command,
or click on the @ icon.

(2)In the [General Settings] area, input the Word Ad-
dress and Data Format.

Half Pie Graph Settings [HP_001]

General Setlings [ Graph Setlings | Shape/Color | Alarm Settings | | Enter Doo 1 02

Desoription %5 Abschute £ Relative

| I B
[ Joonioe FlE

Data Famat
3 Bin
@D

7] Display Mode +/-

— Select BCD

|

nnnnnn

(3)Select a Part Shape from the Browser.
You can also use the Alarm Settings area to enter Alarm
settings and select Colors, if desired.

2.1 Parts B Se-
lecting a Part Shape

Shape Browser

Caneel

(I HG 3pooz

HG_3Do03

|||__HG_ 30004 [[I-]|l [ Po5 Fik

Curret PDE File ; [c:\propb3wintpdblopd-3d0T.pds |

Title - |HEG_3D001 [ Help
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2.1 Parts

PROCEDURE

REMARKS

(4)In the [Graph Settings] tab, input the number of axis
divisions.

[ General Settings || Graph Settings | Shape/Color || Alaim Setlings |

Display Diection Avis Divisians

@ Chshnin 0 Enter 10

[ Face H| Cancel H| Help

(5)After all of a Part’s attributes have been entered or
selected, click on the button.

The Half Pie graph’s outline will appear on the Base
screen, next to your cursor.

(6)Click on the point where the Half Pie Graph’s top
left corner is to be placed.

If desired, use the Half Pie graph’s handles to alter its
size.

The area to enter the number of the
divisions will appear only for a
graph type which has axis divi-
sions.

To cancel the placement, click on
the [=| icon.

To change the Part’s size, refer to

2.4.3 Scaling Up/
Down

Double-clicking on any Part placed
on the screen automatically calls up
that Part’s attribute settings.

2.4.14 Changing
Attributes
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m Tank Graphs ]

This Part creates an area where a Word Address’ numeric data received from
the Host (PLC) is displayed as absolute or relative values in a special “Tank”
shaped graph. The graph’s display will change to reflect changes in Word
Address data.

Regarding the following parts, if the value of 100 on the scale is displayed, the

ﬁ?te: graph area may not be filled completely depending on display magnification.
In this case, the graph can be displayed properly by enlarging or reducing the
part by one dot.

- Part file name: op4-3d01.pdb
GR_3D007, GR_3D008, GR_3D010, GR_3D015, GR_3D017

- Part file name: op4-p101.pdb
GR_PL007, GR_PL008, GR_PL010, GR_PL015, GR _PL017

B Tank Graph [General Settings] Attributes

<When displaying data in absolute values>

Select Absolute or
Relative display

Enter comment

data here Tank Graph Settings [5G_001] | — Enter the Word

General Settings | Graph Setting€| Shape/Calor | Alam Settings | Address to
Description 5

The currently o gg::dd“ L) Zta‘:;e graph

selected Tank 5% [osan FlE oo o

Graph’s image Dstems—

appears here &\:k Select the

Bromser.. desired Data

Calls up the Part ] Format

Shape Browser. [ Place ][ cacel ][ He

Parts Shapes can

be selected

directly from the

Browser

@ Absolute

Data stored in the designated Word Address is displayed as absolute values,
from 0 to 100 (with Display Mode +/- selected, -100 to 100).

@ Word Address

Enter the Word Address where the data will be stored.
@ Display Mode

Select the display data format from Bin and BCD.
@ Display Mode +/-

When this check box [[#]| is checked and Bin data format is selected, nega-
tive numeric data can be displayed.
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<When displaying data in relative values>

Enter comment
data here

The currently
selected Tank
Graph’s image
appears here

Calls up the Part

Select Absolute or
Relative display

Enter the Word

Shape Browser;

Part Shapes can

be selected di-
rectly from here.

@ Relative

Tank Graph Sellings [SG_001] Address used
Gieneral Settings | Graph Settings | Shape/Zhlor | Alam Settings | to store graph
Descriplon (o aboonte @iz ) data
‘Ward Address
[EITT F ﬁ 7] Display Mode +/- Select the
|nE‘ttL|::ier Imput Cod geSire(tj Data
. =] ([ % Mo Code orma
Specifies the
[ Pace ][ coel [\ Hee | data’s Input
Code
Specifies the data’s Specifies the data’s

effective Bit Length

Input Range

According to the Input Range designated for the Word Address Data the data
is converted and displayed as relative values.

@ Word Address

Here, enter the Word Address used to store Tank Graph data.
@ Display Mode +/-

When this check box [I#]| checked, negative number data can be displayed.

@ Bit Length

Specifies the Bit Length of all data stored in the Word Address.
@ Input Data Length

Specifies the data’s Input Range.

@ Input Code

With No Code selected, only positive numeric data can be entered. To enter
negative numeric data, select either +/-2°s Complement or +/-MSB.
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ﬁéte:
X2
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B Tank Graph [Graph Settings] Attributes

Tank Graph Settings [SG_001]
General Settings|| Graph Settings | Shape/Calor || Alam Settings | | — Only when a

graph type

Select the v ol It which has axis

Tank Graph’s 5 et divisions is

display 9 Donn selected, will

Direction 2 fen this appear.
Enter the
graph’s num-
ber of divi-

[ Flace || cemcel || Her sions
@ Display Direction

Here, Up, Left, Down, or Right can be selected for the Tank graph’s display
direction.
The display direction varies depending on the part types.

If [Display Direction] is changed for a 3D part, its shade is rotated along with

that part. To let the shade displayed properly, click on the button,
and select the part again from [Shape Browser].

@ Axis Divisions

Here, the Tank Graph’s divisions are entered if the graph is a division type.
When no divisions are necessary, specify the number of divisions as 0.
Whether a Tank graph has divisions or not will vary depending on the Part
Shape selected.

B Tank Graph [Shape/Color] Attributes

Here, a Tank graph’s border color, division color (Axis Color), data display
color (Graph Color - Fg & Bg), as well as the data display pattern can all be
selected.

2.1 Parts W Selecting Colors

B Tank Graph [Alarm Settings| Attribute
If desired, Alarm Settings can be set here.
2.1 Parts W Setting Alarms

2-54

GP-PRO/PB III for Windows Ver. 5.0 Operation Manual



Chapter 2 - Base Screens 2.1 Parts

B Placing a Tank Graph

The procedure for placing a Tank Graph is as shown below.

/Data stored in D0102 displays on the Tank Graph )
RRLNIL HIE ERN
When data 34 is stored in D0102, the

Tank Graph will appear as follows:

- /

PROCEDURE REMARKS

(1)Select the [Parts] menu - [Tank Graph] command,
or click on the icon.

(2)In the [General Settings] area, input the Word Ad-
dress and Data Format.

Tank Graph Settings [S6_001]

— Enter D00102

— Select BCD

[P ][ cancel |[ Hen |

(3)Select a Part Shape from the Browser. 2.1 Parts B Se-
You can also use the Alarm Settings area to enter Alarm | lecting a Part Shape
settings and select Colors, if desired.
Shape Browser

ok

GRA_3D002MU

GR_3D003MU ||| GR_3D004MU i FDE File
Current PDE File : |c:\propbwin'pdbopd-3d01 pdb
Tile  [GR_a000TMU L b |
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PROCEDURE

REMARKS

(4)In the [Graph Settings| tab, input the number of axis
divisions and graph data display derection.

Tank Graph Settings [SG_001]

General Settings|| Graph Settings | Shaps/Color | &lam Settings |

Enter 10

'™ Select Up

|| Place ||| Cancel |H Help

(5)After all of a Part’s attributes have been entered or

selected, click on the button.

The Tank graph’s outline will appear on the Base screen,

next to your cursor.

(6)Click on the point where the Tank Graph’s top left

corner is to be placed.

If desired, use the handles to alter its size.

The Axis Divisions area will appear
only for a graph type which has axis
divisions.

To cancel the placement, click on
the [«| icon.

To change the Part’s size, refer to

2.4.3 Scaling Up/
Down

Double-clicking on any Part placed
on the screen automatically calls up
that Part’s Attribute Settings dialog
box.

2.4.14 Changing
Attributes
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2.1 Parts

m Meters

This Part creates an area where a PLC’s Word Address’ numeric data is
displayed as absolute or relative values in a Meter (i.e. a needle moves to
show the value). The graph’s display will change to reflect PLC Word
Address data changes.

B Meter [General Settings] Attributes

<When displaying data in absolute values>

Enter comment
data here

The currently
selected Meter
Graph’s image
appears here

Calls up the Part —||

Shape Browser;
Parts Shapes can
be selected

Select Absolute or
Relative display

Meter Graph Settings [MT_001]

| General Settings | Graph Settings | Shape/Color | &fam Settings |

Description (B3 pbsohits £ Relative )

I | e

7] Display Mode +/-

\\

—

lllllll

directly from the
Browser.

@ Absolute

Enter the
desired Word
Address data

Select the
desired Data
Format

Data stored in the designated Word Address is displayed as absolute values,

from 0 to 100 (with Display Mode +/- selected, -100 to 100).

€ Word Address

Enter the Word Address where the data will be stored.

@ Data Format
Select the display

data format from Bin and BCD.

@ Display Mode +/-

When this check box [+ is checked and Bin data format is selected, nega-

tive numeric data

can be displayed.
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<When displaying data in relative values>

Enter comment
data here

The currently
selected Meter’s
image appears
here

Calls up the Part
Shape Browser.
Parts Shapes
can be selected
directly from the
Browser

& Relative

Select Absolute or
Relative display

Enter the
Meter Graph Settings [MT_001] Word Address
" General Setings | Graph Sefings | Shape/Color | pfom Settings | used to store
Description ({;; Absolute @HE\ENV&‘) display data
| Word Adress

Bit Length [1g t:]lﬁ

Input B

D000 & ) Display Mode +/-
=

T— Select the

desired Data

Input Cod

_ 7t [ || Fommat

Specifies the

[Pz [ cancel |[ Eek ] data’s Input

Code
Specifies the data’s Specifies the
effective Bit Length data’s Input

Range

According to the Input Range designated for the Word Address Data, the
data is converted and displayed as relative values.

&€ Word Address

Here, enter the Word Address used to store Meter data.
@ Display Mode +/-

When this check box [[+]| checked, negative numeric data can also be dis-

played.
@ Bit Length

Specities the Bit Length of all data stored in the Word Address.

@ Input Range

Specifies the data’s Input Range.

@ Input Code

With No Code selected, only positive numeric data can be entered. To enter
negative numeric data, select either +/-2’s Complement or +/-MSB.
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B Meter [Graph Settings] Attributes

Meter Graph Settings [MT_001]

General Seftings | Graph Settings | Color/Shape || Alaim Setting | L Only when a
graph type
Select the which has
Meter’s (data e divisions is
displa_y) selected, will
Direction this selection
appear

|| Place ||| Cancel |H Help

@ Display Direction

Here, the Meter’s display direction, either Clockwise or Counterclockwise
can be selected.

@ Axis Divisions

Here, the Meter increments are entered. If the number of Divisions is
specified as 10, 10 or 11 division lines are displayed. When no divisions are
necessary, simply enter “0”.

B Meter [Shape/Color]| Attributes

Here, a Meter’s border color, division color (Axis Color), and needle color
(Meter Color) can be selected.

2.1 Parts W Selecting Colors

B Meter [Alarm Settings] Attributes
If desired, an Alarm’s settings can be set here.
2.1 Parts B Setting Alarms
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B Placing a Meter

The procedure for placing a Meter is as shown below.

fData stored in D0102 displays on the Tank Graph \

When data 34 is stored in D0102,
\ the Meter will appear as follows: J

PROCEDURE REMARKS

(1)Select the [Parts] menu - [Meter] command, or click

on the |EZ| icon.

(2)In the [General Settings] area, input the Word Ad-
dress and Data Format.

Meter Graph Settings [MT_001]

General Settings | Graph Setlings | Shape/Color | Alam Settings | _— E nte r

Description 159 Absolute 121 Relative DOO1 02
I reyerren

DomIoZ F] ) Display Mode +-

@3%’ Select BCD

rrrrrr

[ Pree ][ Coreel |[ Heb |

(3)Select a Part Shape from the Browser. 2.1 Parts W Select-
You can also use the Alarm Settings area to enter Alarm | ing a Part Shape
settings and select Colors, if desired.

Shape Browser
- [

R

| _ || [TPoe Fie
Current PDE File : |c:\propbwin'pdbopd-3d01 pdb
Tile :[MT_a0001 L b |

MT_3D003
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2.1 Parts

PROCEDURE

REMARKS

(4)In the [Graph Settings| area, input the number of
divisions and data display direction.

Meter Graph Settings [MT_001]

General Settings]| Graph Setings | Colar/Shape |[ Alam Setting |

Disolaw Direction A Divisiores
180 Clackwise E ntel' 1 0

9 Courterclackwise

™ Select Clockwise

Ploce Hep

(5)After all of a Part’s attributes have been entered or
selected, click on the button.

The Meter’s outline will appear on the Base screen, next
to your cursor.

(6)Click on the point where the Meter’s top left corner
is to be placed.

If desired, use the Meter’s handle to alter its size.

The Axis Divisions will appear
only when Absolute display is se-
lected.

To cancel the placement, click on
the [«] icon.

To change the Part’s size, refer to

2.4.3 Scaling Up/
Down

Double-clicking on any Part placed
on the screen automatically calls up
that Part’s attribute settings.
2.4.14 Changing
Attributes
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m Trend Graphs ]

This Part displays Word Address numeric data as absolute values on a Trend
(line) graph. The graph’s display will then change to reflect Word Address
data changes.

B Trend Graph [General Settings] Attributes

Trend Graph Settings [TR_001]
Enter comment

data here

[- Channel S ettitgs r Shape/Calar r Alarm Settings ]
General Settings | Giraph 5 ettings

Description

The currently selected
Trend Graph Shape
appears here

| Select the
desired Data
Format

7] Display Mods +/- ]

Calls up the Part
Shape Browser, S
displaying a list of
pre-made Trend
Graph Shapes. Part
Shapes can be | Place ” Cancel || Help
selected directly from
the Browser.

¢ Data Format

Here, the display data format is specified as either Bin or BCD. With the

Display Mode +/- check box || checked, and Bin data format selected,
negative numeric data can also be displayed.
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B Trend Graph [Graph Settings]| Attributes

Trend Graph Settings [TR_001]
Select a graph type | : ,
[ Channel Settings r Shape/Color I Alarm Settings |
[ General Settings | Graph Settings
) NormaE 2 Pen Recorder )
— P — Enter the No. of
isplay Direction =Data Samples ————
24 Up DataSampIes samples, Scro"
Select the data 9 Let sl 5] value, and Sam-

display direction £3 Down SampinaTine || pling Time

18 Right

=iz Soale

ofuiz Divisions '?
x-AxisDivismsE] |___—++— Enter the number
= .
I of X and Y divi-

" Place I | Cancel ] | Help ] SiOI’lS

@ Graph Settings

Using “Normal”: The specified Word Address’s data changes are dis-
played over time in a Trend Graph. Display data
always starts at the “0” point. As each (time) sampling
period elapses, the latest data is added in the specified
display Direction. When the graph’s poly(gonal) line
reaches the limit of the Trend Graph, the graph is
shifted in the display Direction for the number units
specified in “Scroll”.

E.g.) Display Direction: Right Enter screen scrolls
at this point
= ] > = > ] = \
BeginDisplay [ z0] [ 25] [ so] [ 4] [ 0]

Using “Pen-Recorder”:
A specified Word Address’s data changes are displayed
over time in a Trend Graph. The data’s display always
begins with “0”. As each sampling period elapses, the
graph’s poly(gonal) line is shifted one division opposite
the specified display Direction. The latest data is
always displayed at the very limit (in this example, the
right side) of the Trend Graph’s display area.

E.g.) Display direction: Right

BeginDisplay | zo| [ =] [ s [ 40| | 20
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@ Data Samples

Data Samples: The number of data “units” to be displayed in a single
Trend Graph. Up to 638 can be used.

Scroll: The number of data units to be scrolled when the
polygonal line reaches the limit of the Trend Graph’s
display area.

Sampling Time: The data read interval (from the host PLC) is input in
seconds.

@ Display Direction
Select the Trend Graph'’s display direction, either Up, Left, Down, or Right.

ﬁé\\f\\% If [Display Direction] is changed for a 3D part, its shade is rotated along with

that part. To let the shade displayed properly, click on the button,
and select the part again from [Shape Browser].

@ Axis Scale

Enter the number of units that the X and Y axes are to be divided into.
When no divisions are necessary, input “0”.

B Trend Graph [Channel Settings| Attributes

Trend Graph Settings [TR_001]
Designates or [ Giereral Seftings. I Graph Seltings 11— Enters the
enters the num- - ChamelSetings | ShapesCor [ abmsatee | | Word Address
ber Of data Iines Mo. of Channels ‘wiord Address used tO store
(channels) to be = Elpmn — FlE the current
displayed on the Current Channel channel’s
Trend Graph Tharrel1 7] %%‘%‘%‘% display data
Fo NN I I 1] e
Designates.the © MR o T~ Selects the
channel being color and type
currently se- . . . of line used
lected P [ Coed J[ b | for the current
channel

& Number of Channels

Enter the number of channels used in the Trend Graph. Use the “Current
Channel” area to select which channel is being specified. Up to 8 channels
can be designated for a single screen, and up to 20 channels can be entered
in a Project file (PRW file).

&€ Word Address

Enter the Word Address used to indicate where the Trend graph’s data is
stored.
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B Trend Graph [Shape/Color]| Attributes

The Trend Graph’s border color, division color (Axis Color), and Trend

Graph’s display area color (Graph Area Color) can be selected.
2.1 Part B Selecting Colors

B Trend Graph [Alarm Settings] Attributes
If desired, an alarm’s settings can be set here.
2.1 Part M Setting Alarms

2.1 Parts

B Placing a Trend Graph

An example of a Trend Graph (scrolling left to right) is shown below.

%ata stored in D0102 is displayed on the Trend Graph

-,

When 34 is stored in D0102
k\thhe graph will look like this: -

Auis Sefings
* Sarmple 20
* Gerol 19
* Sampling Time 10 sec
* Axis Div. (Wer) 10
" (Hor) 1o Y,

PROCEDURE

REMARKS

(1)Select the [Parts] menu - [Trend Graph] command,
or click on the icon.

(2)After clicking on the [General Settings| tab, select
the data format.

Trend Graph Settings [TR_DO1]

Shape/Color | Alsm Settings |

| Graph Settings

D Display Mode +/-
—Dvata Fo /
#Bin  — |

i3 BCD

|l — Select Bin

Place ” Cancel H Help

Data in the range of 0 to 100 can
be displayed on the Trend Graph.
When the data range is from -100
to 100, check the Display Mode
+/- check box.
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PROCEDURE REMARKS

(3)Select a Part Shape from the Browser.

You can also use the Alarm Settings area to enter Alarm 2.1 Parts B Se-

settings and select Colors, if desired. lecting a Part Shape

TR_3D00ZR

Current FOEB File : [c:\propb3wintpdbhopd-2di. pdtf

(4)In the [Graph Settings| area, select the Graph Type
and Direction, and enter the number of Data Samples

and Axis Divisions.
Select Normal

Trend Graph Settings [TR_DG1]
[‘ Channel Settings I Shape/Color T Alarm Settings I Enter 20
[‘ Geneldé/ettmgs | Graph Setings
2 Nomal i Pen Recarder Enter 1 9
Display Direction =D ata 5amples
£ Up Data Samples [20 =
{2 Left Scrall iu || En r 1
£ Dawn Sampling Time m — | / te 0
%) Right ia
=iis Seales Enter 10
. =y .
o Dviens [T If the more than one channel is
i Divigions II;‘ =4 ||
Enter 10 used, be sure to enter the Word
| el T ] Address and select the Color for
/
Select Right each channel before placement.

(5)In the Channel Setting area, enter the Number of
Channels, then enter each channel’s Word Address

and select the desired colors. !

In this example, since the Number of the Channels is | important

“1”, you only need to enter one Word Address. A Trend Graph’s channel
Trend Gragh Setlings [1R_001] Word Addresses should not
[ Dhanngesn:t[i;:umusl ShaDLED‘m TGral:lhf:;;t[w:;gssE"WS /L/ Enter D00102 be the same as Othel' Paf't ad'

dresses, otherwise, it will

No. of Channels word Address

= Epwe  FE cause a GP error.
Current Charinel
lannel hd E .
N ——————— Up to 20 channels can be desig-
Fo MmO ok . . :
b EEEOEEC o0 nated for a Project file (including
the Data Sampling frequency num-
ber).

" Place ” Cancel || Help |

Up to 8 Trend Graph display areas
can be placed on a single screen.
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PROCEDURE REMARKS

(6)After all of Part’s attributes have been entered or

selected, click on the button.

The Trend Graph'’s outline will appear in the Base screen,
next to your cursor.

(7)Click on the point where the Trend Graph’s top left | To cancel the placement, click on

corner is to be placed. the [&] icon.
If desired, use the Trend Graph’s handles to alter its size, | Tq change a Part’s size, refer to
after placement. 2.4.3 Scaling Up/

Down

Double-clicking on any Part placed
on the screen automatically calls up
that Part’s attribute settings.

2.4.14 Changing
Attributes
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m Keypads ]

Here, pre-made keypads are used to enter data to a designated Word Ad-
dress. In order to input data via the keypad, it is necessary to first create a
Keypad Input display.

2.1.13 Keypad Display

B Keypad [Description] Attributes

Keypad Settings

General Settings ] e Select the
Kevpad Type—s / Keypad’s data
3 Decimal | format
£ Hex
i Text

Displays the — |
currently selected
Keypad’s image

Pad Colar L Select the
) ) O o ) ek Keypad’s
border color

Calls up the Part
Shape Browser. —_{]
Parts can be
selected directly
from the Browser

|

Flace || Cancel || Help |

€ Keypad Type

First, a Keypad type needs to selected that will be suitable for the data
format specified. To select a Keypad type, simply click on the Browser and
the selection of available Keypads will be displayed.

@ Pad Color
The Keypad’s border color (Pad Color) can be selected here.
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2.1 Parts

B Keypad Key Functions

The various Keypad Key functions are shown in the table below.

Decimal Hexadecimal

Keypad Specs

Common Keys

Numeric value keys (for Hex, the keys are 0 to F).
Inputs the corresponding value in the display.

Delete key
Deletes the character above the cursor.

Clear key

Clears the entire display. If the s pressed after clearing,
0 is stored in the PLC Word Address.

Enter key
Registers the set value and writes it to the PLC Storage

Address. Then, the cursor moves to the next display and
awaits next input.

Cursor keys
Moves the cursor right and left within the display.

Jump keys
Moves to the next Key Display without entering the set value.

You can use these keys to jump to the area where you wish to
enter data.

Negative key
Only available for

Dec(imal) and +/-
format.

Dec. Only keys

Decimal Point key
Valid when Decimal
Places have been
entered for Decimal
and BCD numbers.
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B Placing a Keypad

The procedure for creating and placing a keypad is shown below.

KD_1 7 2 5[4] =
R0

o2 ]

KD_%
When the Trigger KD_1to 3 IE I:I T
Bit M0080 turns (Word Address D0050 Input data
ON, ... to D0052) can receive... from the

Keypad

h A

For how to create the display area for the keypad shown here,
refer to 2.1.14 Keypad Display.

PROCEDURE REMARKS

(1)Select the [Parts] menu - [Keypad] command, or click
on the |E icon.

(2)Select a Keypad Data Format Type.

Keypad Settings

Feypad Type=——

£ Decimal Select Decimal
3 Hew

9 Test

Pad Calor

) ) o i ) e I

General Settings ]

|. Flace ] | Cancel } | Help |

(3)Select a Keypad Shape from the Browser. 2.1 Parts M Select-
If desired, select a color from the Shape/Color area. ing a Part Shape

Shape Browser

I KP_3D002D ||| POBFie..

Curtent PDE File: [o\prapbuin'pbipdb.pch |

Tile: [kP_a0amD d|
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2.1 Parts

PROCEDURE

REMARKS

(4)After all of the Keypad’s attributes have been en-

tered or selected, click on the button.

The Keypad’s outline will then appear in the Base screen,
next to your cursor.

(5)Click on the point where the Keypad’s top left cor-
ner is to be placed.

To cancel the placement, click on
the [a]icon.

Double-clicking on any Part placed
on the screen automatically calls up
that Part’s attribute settings.

2.4.14 Changing
Attributes

%e: Regular Keypad parts have all been previously grouped. Therefore, to create
a new keypad, simply un-group the Keypad and arrange the pieces as you

like.

2.4.12 Group/Ungroup
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m Keypad Display ]

Here, the area used to display keypad data is created.

B Keypad Display [General Settings] Attributes

Enter comment

Keypad Input Display Settings [KD_001] | — Enter the
data here " General Settings [ Display Format | Shape/Color | Word Address
The currently J[;\mp“m | Jd;\udndn[;ss TEz u_sed to store
selected Part’s [ : display data
image will appear Trigger Bit Address | Enter the
here Trigger Bit
Calls up the Part || Address to
Shape Browser. allow you to
Parts can be perf.orm d.ata
selected directly [ Pee |[ cwed |[ Bee settings via
from the Browser the Keypad

€ Word Address
The Word Address is used to store the keypad display’s data.
@ Trigger Bit Address
When this bit is turned ON, the Keypad’s data entry area becomes active.

B Keypad Display [Display Format] Attributes

Select either The decimal
Numeric or Text Keypad Input Dizplay Settings [KD_001] point is not
for the data’s |General88ttings" Display Format ‘Shape.-"[lolor| included in the
display format Koo Dislay Format S display digits.
| p y = Mo, of Dizplay Digitz Enter the NO.
) Code +t- Decimal Flaces _] of Display
When Numeric is 6B 328k Character Size Digits
Selected, these 18 Decimal {2 Decimal
selections appear. g:z; e Enter the No.
Select the Data oo :: Déglt_s af:er
Length and Data e teclma
poin
Format || Flace | || Cancel | || Help \\L
Character size can be
selected here
@ Data Display Format

Here, the data’s Format, Code and Bit Length are selected. When selecting
decimal, negative numeric data can also be displayed by clicking on [[w| the
“Code +/-” check box.

@ No. of Display Digits

Here, the number of digits displayed, to the right of the decimal point, is
input.
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@ Decimal Places
Here, the number of digits to the right of the decimal point is input.
Each data format available is listed in the table below.
Data Format Code | Data Length D|§p.lay Decimal
Digits Places
Data Dec +- 1-5 0-4
Values [ Hex + 14
16 bit
BCD 1-4 0-3
Oct + 1-6
Dec +- 110 0-9
Hex + 32 bit 1-8
BCD + 1-8 0-7
Char. Col. No. of Char. 1-80

When using 32 bit data, the relationship between the top and bottom of the
Word Address will differ depending on the PLC used.

PLC Connection Manual

ﬁé\te: When the No. of Display Digits is set to 5 and the Decimal Places is set to 2, a
value appears on the Keypad Input Display as shown below.

€ Character Size

The label’s character size is selected here.

2.2.9 Text

B Keypad Display [Color/Shape] Attributes

The Keypad Display’s border color, data display color (Text), and interior
color (Plate) are selected here.

2.1 Parts B Selecting Colors
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B Placing a Keypad Display

The Keypad Display’s placement procedures are shown below.

s ™y
KD_1 7 2 5[4]
[ [NTHEN]
o2 ]
When the Trigger KD_1to 3
Bit M0080 turns (Word Addresses Input data
can receive...
" Keypad. .
SAEEAEEK For how to create a Keypad like the above, refer to 2.1.13
Keypad
PROCEDURE REMARKS
(1)Select the [Parts] menu - [Keypad Input Display]
command, or click on the @ icon.
(2)In the [General Settings] area, input the Word and
Bit Addresses.
Keypad Input Display Settings [KD_001]
" Gereral Settings ‘ Display Format T Shape/Color |
Description ‘Word Address
| |  [¥][oomoso FlEE
Trigger Bit Address
™ Enter D00050
Browser. ™
e ] " Enter M0080
|' Place ” Cancel || Help 1
(3)Select a Part Shape from the Browser. 2.1 Parts B Select-

If desired, select colors from the [Shape/Color] area. ing a Part Shape

Shape Browser

m 77777

KD_3D001 || IECEERITH KD_3D003

KD_3D004 ||| KD_3D005 ||| KD_3D00i FDE File...

Curtert PDB Fie  [c\prapbwintpdbipdb pdb

|
Tite: [KD_zD001 =
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2.1 Parts

PROCEDURE

REMARKS

(4)In the [Display Format] area, specify the Data Dis-
play Format, No. of Display Digits, and Decimal
Places (i.e. number of the digits after the decimal
point) to be used. If desired, select the Character Size.

Keypad Input Display Settings [KD_001]

General Settings | Display Format | Shape/Color |

Diats Display Format

Biiineid 0 Ten Ne. of Disolay Digit

Enter 4

eeeeeeeee
e pemapiee £ Do not enter
16 Bi 3281 Chaacter Size .
5 Decimal {7 Decimal | 12X8 anythlng here
L Hex £ Hex H 117, 24
CHBCD £ BCD (I'e' 0 )

L Dctal

[ Face ||| Cancel H| Help

(5)After all of the Keypad Display’s attributes have been
entered and selected, click on the button.

The Keypad Display’s outline will appear on the Base
screen, next to your cursor.

(6)Click on the point where the Keypad Display’s top
left corner is to be placed.
If desired, use the Keypad Display’s handles to alter its
size.
Even though the set value display area is scaled up or
down, the character size will not change. To change
the character size or position, directly select the charac-
ters inside the border.

(7)Repeat from step (1) to create Keypad Displays with
Word Addresses “D0051” and “D0052”.
Except for the addresses, all settings should be the same.

To cancel the placement, click on

the [ ] icon.

To change the Part’s size, refer to
2.4.3 Scaling Up/
Down

Double-clicking on any Part placed
on the screen automatically calls up
that Part’s attribute settings.

2.4.14 Changing
Attributes

If the key is pressed when the
display area’s border is scaled up
or down, its interior characters are
also scaled.
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B Using a Keypad to Input Values

Chapter 2 - Base Screens

The procedures for entering setting values via a Keypad on the GP screen

are shown below.

. ™y
KD_1 7 2 5[4]
MOOED
o2 ] :
os[___ ]
When the Trigger KD_1to 3 i
Bit M0080 turns (Word Address Input data
ON... D0050 to D0052) from the
can receive...
\ Keypad .

PROCEDURE

REMARKS

(1)Here, three Direct Call-Ups have been set to share a
common start bit.

ID No.

(2)Then, when the PLC’s internal Trigger Bit M0080
turns ON,

PLC
N

1.

(3)First, the Keypad Display KD _1’s display reverses
(highlights) and waits for input.
The square box shown below represents the cursor’s po-
sition.

[T
[ 1
[ 1

For how to create
a Keypad, refer to 2.1.13 Keypads

For how to create
a Keypad Display, refer to 2.1.14
Keypad Display B Placing a Key-
pad Display
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2.1 Parts

PROCEDURE

REMARKS

(4)Press the Keypad’s keys to input the desired value.

5|2

(4]

7 <] ]

(9]

6]

5]14] [-]

0]

—A=m

(5)Press the [ENT] key to register the value.

E

(6)The registered value will then be stored in Word Ad-
dress D0050, which was designated in KD 1. Next,
KD 2 will be highlighted and be ready to receive in-

put.

£ 52

FLC

., I #
S

Set value display areas having a
common Trigger Bit will enter a
wait state in order, from the lowest
ID number upwards. After the first
value has been registered, the next
value’s display area will automati-
cally be ready to receive input.
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m Alarm Display ]

When the PLC Monitor Bit has been turned ON, messages registered in the
Alarm Summary by the Alarm Editor, can be displayed in a list.

Chapter 5 CREATING AND EDITING ALARMS

Message display order is decided according to which Monitor Bit is in the
lowest position in the Alarm Summary display area. It is recommended that
Monitor Bit assignment begins from the message with the highest priority.
Be sure to input only one message per line. The characters of a message
that exceed one line will be truncated.

The number of the characters that can be displayed in one line will vary
depending on the character size and GP type. When the size is 1 x 1, the
maximum number of characters that can be displayed per line for each GP

model is:
GP-470, GP-570, GP-571, GP-870, GP-477R, GP-577R,
GP-2400, GP-2500: ...oooiiiiiiiiiiieiiiieeee e 80
GP-H70, GP-270, GP-370, GP-377, GP-377R: ....coovvevivvenen. 40
GP-675, GP-2600: ....ooeeiieiiiiiieeiiieeeee et 100

B Alarm Summary [Description] Attributes
Enter the start

Aeuings [AL_DD1] address for
Enter Comment * Gieneral Settings | Display Fomat | Style/Color | each
data here \ Diescription ‘wiord Address message’s
| i S | e a7 Monitor Bit
Select the display g[?ﬁ gj';lr:;er Mo, of Manitor Wards 1 \‘EJ\ Enter the
area border % [ | pnterthe
(frame) = Words allo-
- cated for a
Monitor Bit
|' Flace ] | Cancel | | Help ]

@ Border Type
The display area frame types are No Border, Outside, and Outside + Inside.
€ Word Address

The Monitor Bit’s first address for the messages specified by the Alarm
Editor is input. Input this address in word units.

E.g.) How to designate a Word Address (MELSEC-A Series - Mitsubishi):
When designating the Word Address for the input/output or internal
relay, the Word Address is designated from the Least Significant Bit.

MOTES MOTEE MOT4E MOT44 YOUF YO1E Y011 00
< High Low— LSB < High Low— LSB
In this case, M0144 is In this case, Y010 is
designated designated
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€ No. of Monitor Words

Here, the number of words a Monitor Bit is assigned and entered. Up to 100
words can be monitored.

B Alarm Summary [Display Format] Attributes

Alarm Summary Settings [AL_001] Designates the No.
De?'Qnat_es_from General Settings _. Dizplay Format Stylex’l:olor] — of Lines of a
which existing —f - message that can
error message Display Start Line = be displayed on
will the display M. of Display Lines [12 ~ = one screen

begin

M. of Display Char, |40 \%\

. Designates the
maximum No. of
Characters per line

I

Flace I| Cancel || Help

€ Display Start Line

Among the messages whose Monitor Bit is turned ON, the Start Line desig-
nates from which message the display starts.

%{e: When the Alarm Summary display cannot fit in a single screen, only one
1 Alarm Summary display can be placed on a screen. When the number of
messages to be displayed does not fit on one screen, create Alarm Summary
displays on multiple screens, so that the screens will switch to display all the
messages. To display all error messages continuously, specify each screen’s
Start Line as follows:

The first screen: ......... The starting line
The second screen: .... The number of display lines on the first screen + 1
The nth screen: .......... The number of display lines on any screen x (n-1) + 1

€ No. of Display Lines

Designates the maximum number of alarm message lines that can be dis-
played on one screen. Up to 50 lines can be displayed.

@ No. of Display Char.

Designates the maximum number of characters that can be displayed on a
line. The screen’s limit is 100 characters per line. However, the maximum
number of characters for each GP unit will vary depending the model.

B Alarm [Style/Color| Attributes
The display area color when a message is cleared (Clear Color) is selected.
2.1 Parts B Selecting Colors
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B Placing an Alarm Summary Display Area

The Alarm Summary Display Area’s setting procedure is shown below.

Ve

N
[Bitdodess e [Wesae | ErrorCode030 Unit 0D5
12 iﬁﬂﬂéﬂ Ejﬂﬂjﬁj ErrorCode040 Unit 0D5
3 w005t Summay ErrorCode041 Unit 0D6
100 Alarm Messages, have Appear on t_he screen in _a
. . Summary Display, at 10 lines
been assigned to bits M0800 ~ by 30 characters per displa
MO0899 in the Alarm Editor y per dispiay.
\\ J

PROCEDURE

REMARKS

(1)Select the [Parts] menu - [Alarm Display| command,

(2)In the [General Settings] tab, input the Word Address,
No. of Monitor Words, and select one of the Show

(3)In the [Display Format] tab, input the Display Start
Line, No. of Display Lines, and No. of Characters.

or click on the || icon.

Border options.

Here, since the Word Address range is from M0800 to
MO0899, enter “7” for the number of Monitor Words.

Alarm Summary Settings [AL_001]
 Gieneral Settings | Display Format | Style/Colar | | Enter M0800
Deszcription whord Address
I N =
Border Type=—— -
13 No Barder Mo, of Moritor words |7 =
o ==
0 - ™ Enter7
1= \
[T Select Border type

|. Place ” Cancel H Help ]

In the [Style/Color] tab, select the
Color, if desired.

Alarm Summary Settings [AL_D01]

“General Settings . Drizplay Format Stylea’CoIor]

Clear(ing of Data)

— Enter 1

Digplay Start Line |1 =1

Mo, of Display Lines [10 =1

Mo. of Display Char. |30 \._5-]\

L Enter 10

[

T Enter 30

Flace ” Cancel || Help

SOOI 2.1.15 Alarm
Summary Display B Alarm Sum-
mary [Description] Attribute ¥
Word Address
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PROCEDURE

REMARKS

(4)After all of the Part’s attributes have been entered

and selected, click on the button.

The Alarm Summary display area’s border will appear
in the Base screen, next to your cursor.

(5)Click on the point where the Alarm Summary dis-
play area’s top left corner is to be placed.
If desired, use the Alarm Summary display handles to
alter its size. When the Alarm Summary display is scaled
up or down, the displayed character size will also change,
according to the border’s size.

To cancel placement, click on the
icon.

To change the Part size, refer to

SEOETTIK 2.4.3 Scaling Up/
Down

Double-clicking on any Part placed
on the screen automatically calls up
that Part’s Attribute Settings dialog
box.

SAOTTNEIK 2.4.14 Changing
Attributes

|
Imp;rtant
Be sure to use the Alarm
Summary’s display area only
for displaying Alarm Mes-
sages, i.e. never place, over-
lap, or overlay another Part or
object in this area.
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m File Name Display ]
Data registered in the Filing Data settings is displayed.
Tag Reference Manual; 4.2 Filing Data (Recipe) Function
B File Name Display [General Settings] Attributes
Enter a descrip- [0 ] Specif
tion if desired Gereral Settings | Display [ Style/Color || Switch Settings || SwitchT ypeColor | pecily
izplay yle/Color || Switch Settings | SwitchT ype/Calar whether or nOt
Enter the ID Diescription =lze LS to use the LS
number for the Duse 15 aea area
File Name TopWwiite Word Address
Display and its = —1— Enter the start
function switch FPLE Teansfer word address
Usze Transfer Completed Bit Address of the LS area
Enter the File No. 1D Mo. PLC Transfer Completed Bit Address
- H—Set up the
of filing data to rene [T | EOE__LIE PLC 1E:'ansfer
be displayed. Completed Bit
H Place I" Cancel ||| Help | Address.
@ Description
Enter a description using a maximum of 20 single-byte characters.
€ IDNo.
The File Name Display is linked to its function switch (File Name Key).
Specify the number to identify this link is here. This number is available up
to 255.
@ FileNo.
Enter the file number registered in the Filing Data list (1 to 2047). The
names under this number are displayed when the file is opened.
Tag Reference Manual; 4.2 Filing Data (Recipe) Function
€ ByWayofLS
When Filing Data is transferred between backup SRAM and the PLC, it can
be modified on the GP screen by routing it via the LS area (the data is stored
temporarily in the LS area). If data transfer via the LS area is used, specify
the LS area’s start-word address where Filing Data will be stored from. The
address where the data can be stored is from LS0020 to LS2031, and
LS2096 to LS4095.
€ PLC Transfer
This Bit is turned ON when filing data transfer to the PLC is completed.
Since this Bit does not turned OFF automatically, to use the PLC Transfer
Completed Bit again, turn it OFF beforehand.
%f €. When the PLC Transfer Completed Bit Address has been entered, in the case
el where filing data cannot be transferred to the PLC, the GP’s special relay
LS2032 Bit 10 will be turned ON.
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B File Name Display [Display] Attributes

File Display [FD_001] x|
| General Settings || Display I Style/Color || Switch Settings || SwilchType.fCUIDrl
H— Enter the
Mo, of Display Lines = number of
Mo. of Display Characters mgl names being
Specify the name —|| _ displayed
. ™) Direct Selection
selection method /D] Curgor Position Control N— Enter the
number of
Specify the characters
cursor position used for the
retention names being
[_Face [ Concel |[ Hep displayed

€ No. of Display

Specity the number of Filing Data rows displayed on the GP. A maximum of
50 rows may be specified.

€ No. of Display Characters

Specity the number of Filing Data characters used on each row. A maximum
of 100 characters may be specified.

@ Direct Selection

Select a File Name Display being placed on the GP by directly touching its
border. If [Direct Selection] is not used, select the file name using the data
scroll switches [Roll Up/Roll Down].

B File Name Display [Switch Settings] Attributes

€@ Cursor Position Control

Even when the screens are changed on the GP , the current screen’s cursor
position can be retained. When turning the GP’s main power switch ON or
resetting the GP, however, the cursor will appear in the first line.

%{e; The cursor position will be stored for each ID No. To retain the cursor posi-
tion, be sure that the File Name Display ID Nos. will not be overlapped
through all the screens.

B File Name Display [Style/Color] Attributes

Specity a color [display color (Fg)] for characters in the Filing Data display
area, and a color [display color (Bg)] of the Filing Data display area.

2.1 W Selecting Colors
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B File Name Display [Switch Settings| Attributes
Set the function switches that are placed automatically.
SO 2.1.3 Function Switches

File Display [FD_001] <]
Switches to General Settings || Display || Style/Calor | Switch Settings | SwitchType/Colar | Switches to
tranSfer Flllng Automatic Switch Placement Method transfer data
Data between the . iathe LS
backup SRAM F) (00 Send To L5 Framy SRt via the
and the PLC 1) e T SREM FromlLs are.a. These
switches are
O Send T LS Fram RLE: .
valid when By
O 3end T LT Rrami LS Way Of LS is
Switches to scroll .
selected in
names and select [General
n .
one Settings]
|| Flace I " Cancel | " Help

€ Automatic Switch Placement Method
Automatically places the function switches for the selected names.
€ Send To PLC From SRAM

Places the switch used to transfer Filing Data from the backup SRAM to the
PLC.

@ Send To SRAM From PLC

Places the switch used to transfer Filing Data from the PLC to the backup
SRAM.

€ RollUp

Places the Roll Up key used to scroll names and select one. Touching the
Roll Up key once will roll up names by the number specified here.

€ RollDown

Places the Roll Down key used to scroll names and select one. Touching the
Roll Down key once will roll down names by the number specified here.

€ Send To LS From SRAM

Places the switch used to transfer Filing Data from the backup SRAM to the
LS area.

€ Send To SRAM From LS

Places the switch used to transfer Filing Data from the LS area to the backup
SRAM.

€ Send To LS From PLC

Places the switch used to transfer Filing Data from the PLC to the LS area.
€ Send To PLC From LS

Places the switch used to transfer Filing Data from the LS area to the PLC.
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B File Name Display [Switch Type/Color] Attributes

Specity colors (border colors) for the function switches which are placed

automatically.

BTN 2.1.3 Function Switches

Bl Place File Name Display

Shows how to call up the File Name Display.

e N
) Registered File No. 1’s filing data is dis-
79 ~—35 0, played on the File Name Display with 3
- display lines and 10 display characters.
3 By pressing a function key (File Name Key),
filing data can be transferred from the
_:..
S_Hﬁlrj‘ﬂ EEEM SRAM to the PLC, or from the PLC to the
SRAM.
For filing data list and reg-
istering filing data, refer to Tag Reference
Manual; 4.2 Filing Data (Recipe) Function.
\ J
PROCEDURE REMARKS

(1)Select the [Parts] menu - [File Name Display] com-

mand, or click on the [§| icon.

(2)In the [General Settings] tab, enter the File No. of | dMiIRINTIR B File Name Dis-
filing data to be transferred and the File Name | play [General Settings] Attributes
Display’s ID No.

Here, since File No. 1’s data is transferred, enter “1” for

the file number. The File Name Display’s ID No. is “0”. | To transfer Filing Data via the LS

File Display [FD_001]

[x]

General Settings I Digplay || Style/Color || Swatch Settings ” SW|lcthDEfEuIUr|

[rescription

=lse LS

Use LS Area
Top Wiite Word Address

1D Ho. |0

=PLC Tear

Q] Use Transfer Completed Bit Address
PLC Transfer Completed Bit ddress

i

File Mo. |1 =

B =

" Flace

I” Cancel I” Help |

Enter 1

area, mark the check box for [Use
LS Area] in the [Use LS Area].
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PROCEDURE REMARKS

(3)In the [Display] tab, specify the No. of Display Lines,
Display Characters, Direct Selection, and Cursor
Position Control.

If necessary, specify the display color in the [ Style/Color]
tab.

File Display [FD_001] [x]

| General Settings|| Display | Style/Colar [| Switch Settings || SwitchType/Calor |

Mo of Display Lines E I Enter 3
MNo. of Display Characters l
Db T— Enter 10

Cursor Position Control

|| Place I” Cancel |” Help |

(4)In the [Switch Settings] tab, select the function
switches which are being placed automatically, and
specify the number of lines being rolled up or down.

File Display [FD_001] |
| General Settings || Display || Style/Color]| Switch Settings [ SwitchType/Color |

Automatic Switch Placement Method

| - Select
Send To PLC From SRaM ) [ $end Tols Ramfu these two
Send To SFAM From PLC Senl Ty SRkl Fiam L3 switches
Oraus [T B O semlotsfenpls
Fdbon [ & Sand ToPLE FamlLs

|| Place I” Cancel |” Help |

(5)Specify the border colors for the function switches in
the [Switch Type/Color] tab.

(6)After setting all the attributes, click on [ pace |

The frame of the File Name Display size will be dis-
played in the drawing area.
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PROCEDURE

REMARKS

(7)Click the mouse button where you want to place each

attribute.

1234567300 lspa

o —pPLG

3 |PLO—>
5

RAM

(8) Select the placed File Name Display. Then, select the
[Edit] menu - [Ungroup] command, or click on the

icon to ungroup the File Name Display and alter

each item’s position and size.

1234567800
2
3

To cancel the placement, click on

the |=»|icon.

The File Name Displays are
grouped. To change any attribute,
first ungroup the File Name Dis-
plays, and then change the attribute.
SOOI 2.4.12 Group/
Ungroup

SABTTITIK 2.4.14 Changing
Attributes

If the By Way Of LS area is se-
lected, the address for the LS area
can be changed after ungrouping
the File Name Displays.
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m Data Logging Display ]

Data created in the data logging settings can be displayed and edited on the
GP unit.

After the data logging settings, place the Data Logging Dis-

| play.
Important .
mportan For registering logged data, refer to Tag Reference Manual;

4.3 Logging Function
The Data Logging Display does not operate in a window.

%\t\% - Only one Data Logging Display can be placed on each screen.

- The Data Logging Display cannot be set simultaneously with any K-tag or
Keypad Input Display.

- Data that could not be logged due to a read error is identified with “***” jn
a cell.

- Data that is not logged is not displayed.

B Data Logging Display [General Settings| Attributes

Enter a comment, [T Using a word
if necessary  General Settings |Data type T Colar ]"Switch setting ]"Switch Shape.-"[lglm‘]/ address’
Drescription Block Number Add specify the
Specify whether —_|| DO00G FlEz block number
. of data being
the data edit displaved
function is I7) Data Edit play
enabled or
disabled H— Using a bit
address,
. specify the
SpeCIfy Whether " Place ” Cancel H Help ] H p W
\ interlock
the interlock
.. address
function is
enabled or
disabled

€ Block Number Address

On a block basis, specify the data being displayed. The logged data for the
block number stored at the word address specified here will be displayed.

The block numbers that can be entered are between 0 and 2047, but the
maximum of the effective range is [Number of Blocks] specified in [Trigger
Settings] in the data logging settings. If [Number of Blocks] specified in
[Trigger Settings] is 4, the block numbers are 0 to 3 (BIN values only).

%l‘ €, - If any block number that does not exist is specified, no data will be dis-
e played.

- When the loop function has been designated via [Trigger Settings] of the
data logging settings, the Block Number Address will become ineffective.
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€ Data Edit

The logged data can be modified by directly touching the frame of each item
in the Data Logging Display placed on the GP. If Data Edit is enabled,
touching the cell of data that can be modified in the table will cause the
buzzer to sound and allow you to enter data. If Data Edit is disabled, this
touching will be invalid and the buzzer will not sound.

- The data that can be modified is only [Date] and [Value]| that have been
logged.

- If a block or logged data is selected by changing the block number during
on-screen modification of data, the data edit mode is canceled.

- If the cell is moved beyond the display area, using the scroll keys during the
data edit mode, the data edit mode is canceled.

€ Interlock

The interlock can only be activated when the data edit capability is enabled.
If the interlock is enabled, data can be modified only when the bit address
for the interlock is ON. If the interlock is disabled, data can always be
modified by touching it.

%f €. 1If the bit address for the interlock is turned OFF during on-screen modifica-

Specify whether —

tion of data, the data edit mode is canceled.

W Data Logging Display [Data Type] Attributes

Logging display[LG_001]
Select a Border [ General Settings| Data tupe | Caolar T Switch setting T Switch Shape.-"[lolor] E t th
| | H— Enter the
T-ype of the Border Type—= number of
Mo Bord
display area g@% order rows for the
o items dis-

played (0 to 40)

the scrolling of Enter the
the totaling number of
section is en- : _ . colu_mns for
abled or disabled [place [ concel ]| teb | the items

1 displayed (0 to
Enter a display interval 25)
(the number of dots) (0 to 10)

€ Border Type

Select a border type of the display area from among three types, No Border,
outer border ff (1-dot lines), and outer border plus inner border [ (the
outer border and item use 2-dot lines, while the inner border uses 1-dot
lines).

€ Row

Specify the number of rows used to display logged data on the GP. A maxi-
mum of 40 rows may be specified.
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€ Column

Specify the number of columns used to display logged data on the GP. A
maximum of 25 columns may be specified.

€ Spacing

Specify spacing at which to display logged data on the GP. A maximum of
10 dots may be specified. This entry is only valid when the display area
border type is specified as No. Border. Draw the border line using the
drawing tool.

%f €. The gap equivalent to the specified display spacing is provided between the
el cell and the border line. The entire cell is filled with the clear color specified
in the Data Logging Display [Color] Attributes. However, the gap is not
displayed in the clear color, but its background is displayed. If No Border is
selected to draw an arbitrary border, ensure that the border is drawn using
the same width as the specified display interval without overlapping the cell.

<Display Spacing>

®  Scroll data area Border (the gap between the Draw the border so
border and the cell is not filled that it does not
with the clear color) overlap any cell.

Cell [>

If the scroll data area is enabled, the totaling section is scrolled together with
the data section. If the totaling section scroll is disabled, the totaling section
always appears on the screen.

B Data Logging Display [Color]| Attributes

Select a color (clear color) displayed when the border of each item is
cleared.

2.1 M Selecting Colors
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B Data Logging Display [Switch Settings] Attributes

The number of rows and that of columns specified in [Data type] are dis-
played on the Data Logging Display. If any data exceeding these numbers
exists in the GP, use the function switches to scroll the data.

2.1.3 Function Switches

Logging display[LG_001]
Select the func- [ General Settings T Data type T Colar | Switch setting | Switch Shape/Color ]_
tion switch t e Select Place Switch T Enter the
to be bl dyp Fllue = number of
0 be place @loom rows/columns
g scrolled
e
|I Flace I | Cancel ] | Help ]

B Data Logging Display [Switch Shape/Color]| Attributes

Specify a color (border color) of each function switch.
2.1 M Selecting Colors
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B Placing the Data Logging Display

The procedure for setting the Data Logging Display is described below:

The logged data for the block number stored at the block number desig-
nated address is displayed.

\ihi/

D0100

15

If 3 is stored at D0100

=

The logged data in block No. 3
will be displayed.

Date Time | Datal e
1st | 98/10/16 | 09:14:00 144
2nd | 98/10/16 | 09:14:00 145
EM
3rd | 98/10/16 | 09:14:01 146 ||
4th | 98/10/16 | 09:14:01 147 R
5th | 98/10/16 | 09:14:01 148 |
TOTAL 730 L

PROCEDURE

REMARKS

(1)Select the [Parts] menu - [Data Logging Display]| com-

(2)In the [General Settings]| tab, specify the block num-
ber designated address, data edit, and whether the

(3)In the [Data Type] tab, specify the display settings.
If necessary, select a clear color in the [Color] tab.

mand, or click on the [gg] icon.

interlock is enabled or disabled.

Specify D0100 for the block number designated address.

Logging Display[LG_001] [%]

General Settings ‘ Data Type | Color l Switch Setting I Switch Shape/Calar |

Diezcription il

:l Elock Mumber Address

I Data Edit

Tl tsmnek
Interlock Address

|. Flace ” Cancel H Help ]

| Enter D0O100

Logging Display[LG_001] [<]
General Getlings | D'ata Type | Color | Switch Setting || Switch Shape/Calar |

Border Type=—— Row
20 Mo Border Column
ok

s E Spacing

Serol Total With D ata

|| Place I” Cancel I” Help

I H— Enter 7

T— Enter 4

2.1.17 M Data
Logging Display [General Set-
tings] Attributes ® Block Number
Address
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PROCEDURE

REMARKS

(4)In the [Switch Settings] tab, select the function switch
type that is to be placed automatically, and specify
the number of rows, columns scrolled.

If necessary, select a color for the special switch in the
[Switch Shape/Color] tab.

Logging display]LG_001]

[ General Settings | Data pe | Color \ Switch setting | §witch Shape/Color ]7

Select Place Switch

e =
i
] Right E]
¥ Left

|' Place ” Cancel H Help }

(S)After entering and selecting all the attributes, click

on the button.

The border of the Data Logging Display size will be dis-
played in the drawing area.

(6)Click on the point where the function switch is to be
placed.

To cancel the placement, click on

the || icon.

The Data Logging Displays are
grouped. To change any attribute,
ungroup the Data Logging Displays
by clicking on the [] icon before-
hand.

SAOTIIK 2.4.12 Group/
Ungroup

If you double-click on the function
switch placed on the screen, the
address confirmation screen for
parts will appear, enabling you to
change the address.

OO 2.4.14 Changing

Attributes
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m Numeric Displays

)

This Part displays host Word Address numeric data as an absolute value.

B Numeric Display [General Settings] Attributes

Enter Comment

data here \

Display’s the

currently se- \

lected Part’s
image

Calls up the Part —|
Shape Browser

Browser...

Humeric Display Settings [ND_001]

 Gieneral Settings | Display Fomnat | Shape/Color | Alam Settings |

Word Address

| [][ooom

Description

~F

=@

. — Enter the Word
Address where
the display
data is stored

|. Place I | Cancel ] | Help

€ Word Address

Here, input the Word Address where the display data is to be stored.

B Numeric Display [Display Format| Attributes

Humeric Display [ND_001]

Select the
Data Format
and Data
Length

180 Decimal 2 Decimal
47 Hex

£9ECD
2 Octal

General Settings || Display Format | Shape/Calar || Alarm Settings |

Mo, of Display Digits
Decimal Flaces

Character Size

32 Bit

120 Hex
£ BCD

Flace

I" Cancel ||| Help

Enter the total number
of digits used (not
including the decimal
point) in the display

.~ Enter the number of
digits to be displayed
after the decimal point

T~ Select the size used for

the label’s characters

@ Data Display Format

Here, the Data Display Format, Code, and data length are selected. Choose
a data format of either Decimal (base 10), BCD, Hexadecimal (base 16), or

Octal (base 8). With the Code +/- check box [+l checked, when you select
“Decimal”, negative numeric data can also be displayed.

@ No. of Display Digits

Here, enter the total number of digits used (not including the decimal point)

in the display.

%te: When the No. of Display Digits is set to 5 and the Decimal Places is set to 2, a
value appears on the Numeric Display as shown below.
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@ Decimal Places
Here, enter the number of digits to be displayed after the decimal point

The types of numeric data that can be used with each data format are listed

below.
No. of Decimal
Data Form Code [Datalength| Display Alarm Range
. Places
Digits
. + only 0-65535
16 bit 1-5 0-4 i 65535
Dec +- +onl 0-
32 bit 110 09 oMY | 4204967295
+/- -4294967295
BCD + 16 b!t 1-4 0-3 0-9999
32 bit 1-8 0-7 0-99999999
16 bit 1-4 0-FFFF
Hex + -
32 bit 1-8 0-FFFFFFFF
Oct + 16 bit only 1-6 0177777

The relationship between upper and lower position Word Addresses when
32 bit data is used will differ depending on each PLC type.

PLC Connection Manual
@ Character Size

The label’s Character Size is selected here.

2.2.9 Text

%{e; Only when the GP type is the GP-77R , GP-377R, or GP2000 series, is the 8 x
16 setting valid. For any GP other than the GP-77R , GP-377R or GP2000
series, selecting 8 x 16 in the editor will display 16 x 16 on the GP.

B Numeric Display [Shape/Color] Attributes

Here, the Numeric Display area’s border color, value display color (Number
color), and interior color (Plate color) are selected.

2.1 W Selecting Colors

B Numeric Display [Alarm Settings] Attributes

If desired, specify a variety of Alarm settings.
2.1 M Setting Alarms
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B Placing a Numeric Display

The procedure for placing a Numeric Display is shown below.

4 Data stored in the specified Word Address is displayed in the h
designated Numeric Display.
Doq00
00101 I:>
stored in addresses D0100 digits is 10, with 2 decimal
and D0101 yunn placeS.
\_ J
PROCEDURE REMARKS
(1)Select the [Parts] menu - [Numeric Display] com-
mand, or click on the icon.
(2)In the [General Settings] tab, input the Word Ad-
dress used to store the display data.
Numeric Display Settings [ND_D0D1]
General Settings | Display Format I Shape/Color [ Alam Settings |
Description ‘Word Sddress
| | [oomo FEz
™~ Enter D00100
|' Place ” Cancel H Help
(3)Select a Part Shape from the Browser. 2.1 Part M Select-

If desired, set an Alarm and Colors from the [Alarm Set- | ing a Part Shape
tings] and [Shape/Color] area.

Shape Browser

ND_3D002 |

ND_3D004 ||] ND_3D005 | I FDE File..

Curent FDE File Jc.\pluubwin\pdb\pdb pdb

|
Title: [MD_3D001 Tl ten
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PROCEDURE

REMARKS

(4)In the [Display Format] area, specify the Data Dis-
play Format, and input the No. of Display Digits and

the Decimal Places.

Specify the Character Size, if desired.

MNumeric Display [ND_001]
General Settings | Display Famat | Shape/Calor | Alam Settings | | Enter 1 0
[rata Display Format=—= X
g;Cade 7 Mo, of Display Digits
16 Bit 37 Bit Decimal Places |2 Enter 2
120 Decimal 489 Decimal | Character Size
120 Hex £ Hex '
ECD ECD Wi .
oo 2 I~ Select 32 bit
clal
Decimal
” Place | “ Cancel ‘ “ Help ‘

(5)After all of the Part’s attributes have been entered

and selected, click on the button.

The Numeric Display’s outline will appear on the Base

screen, next to your cursor.

(6)Click on the point where the Numeric Display’s top

left corner is to be placed.

If necessary, use the Numeric Display’s handles to alter

its size after placement.

Regardless of whether the numeric data display area is
scaled up or down, the character size will not change.
To change the character size and position, select the char-

acters inside the border directly.

To cancel the placement, click on

the [2] icon.

To change a Part’s
size, refer to 2.4.3 Scaling Up/
Down

Pressing the key while re-
sizing an area’s border will also re-
size that area’s characters.

Double-clicking on any Part placed
on the screen automatically calls up
that Part’s attribute settings.
2.4.14 Changing
Attributes
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m Message Display ]
This display is used to show single-line alarm messages in response to
changes in PLC Word Address data. A total of 16 messages can be dis-
played, in order of occurrence, in a message display area.
B Message Display [General Settings| Attributes
Select the
Enter Comment Meszage Display Settings [MWw_001] Word or Bit
data here * General Settings | Messages | Address to be
\ Drescription Address monitored
The currently r | oo FlE | |- Select a Border
selected Part [ Border Color color
Shape is dis- EEEOWECO oD
I d h Alignment —— Select the type
prayedhere ’F;;an of alignment
. 5 desired for the
Calls up the Part —{| [ orer. | %) word
Shape Browser; 88 4 text of the
Part Shapes can Display
be Selected | Place ” Cancel H Help ] Select the
directly from the Operation
Browser Select a Mode
Character Size
€ Address
Enter an Address to be monitored. Select either Bit Address or Word Ad-
dress according to (operation) Mode.
€ Border Color
The Message Display’s Border color can be selected.
2.1 Parts M Selecting Colors
€ Alignment
Here, the text’s alignment can be selected.
Right
Center
€ Mode
There are two methods to change messages displayed on the Message
Display, i.e. via Bit’s turning ON/OFF and Word state changes. Here, select
either mode.
Mode: When selecting Bit
Messages will change according to the specified Bit Address
changes.
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Mode: When selecting Word

2.1 Parts

Messages will change according to the state changes of the desig-
nated bits, consecutively from the specified Address’s 00 bit.
According to the number of the messages (either 2, 4, 8, or 16), a
bit is automatically assigned from the specified Address’s 00 bit.

Numbers of | Number of
Messages Bits Used
2 1
4 2
8 3
16 4

When the value set in
the No. of Messages is
16, bits 00 ~ 03 are

used.

N\~

03 02 01 00

N

The remaining bits can be

used for other purposes

When the value set in the
No. of Messages area is 4,
bits 00 and 01 are used

When the value set in the
No. of Messages area is 2,
only bit 00 is used

When the value set in the No. of
Messages is 8, bits 00 ~ 02 are

used
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B Message Display [Messages| Attributes
(Operation Mode example: When using Word Address)
Enter the message’s Deletes the
text here currently
selected
Message Display Settings [Mw_001] message, and
Enter the number | [Goasetings| Messages | specifies the
of messages T N Diccla . / message (and
(StateS) here I\:ess“%es E:g’,a%t:eas Selce\rssage Dele|te ItS color) as
Enter the maxi- = S: (oo o | G| undefined.
mum No- of \ Message byl =—= ] rom Uescnplion 0 0 .
M AT 2 Nomal
Characters 3 Bold Copies all t_he
o frsed characters in
The state indica- — Foler . the Selected
tion buttons [Te“w”'”’ ENEJEEO0) &N Message field
appear according e o MM B D) to all states.
to the No. of | _
Messages [ Pece ][ Concel [ beb | / Copies the
Select the Ch f characters in
ete:':T e Lhar- Select the message’s the Description
acter lype (display) Color field to the
Selected
Message field.
@ No. of Messages
The number of the messages (number of states) can be selected from 2, 4, 8, and
16.
@ Display Characters
Here, the maximum number of characters displayed in a message is selected.
Up to 40 characters can be input. If the number of a message characters
exceeds the specified value, characters that do not fit in the area will be
truncated.
@ Message
According to the No. of Messages, designate a message for each state.
Operation Mode: Bit
Designate a message for each state (ON and OFF).
Operation Mode: Word m
As many buttons as the number of the specified messages will be displayed.
Designate a message for each state.
@ Selected Message
Messages are entered here. After entering a message, the message will be
displayed in the selected color(s). The default value setting is “Undefined”.
@ Color
Here, each message’s display colors can be selected.
Default settings are = Char. color - White; Plate (background) color - Blue.
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Base Screens

B Placing a Message Display

2.1 Parts

The Message Display setting procedure is shown below. (When using a

Word Address)

4 Message No. 0:

Message No. 1:
Message No. 2:
Message No. 3:

None

Signal A Operation
Signal B Operation
Signal A & B Operation

Signal B Oper

-

A message from those listed

above, allocated to the specified

Word Address...

...displays in response
to changes in the Word
Address data.

v

PROCEDURE

REMARKS

(1)Select the [Parts] menu - [Message Display] com-

mand, or click on the [ icon.

(2)In the [General Settings] tab, input a Word Address.
Select the message’s Border Color, Text Alignment and
Character Size, if desired.

Message Display Settings [MwW_001]

" General Settings Messages ]

|__— Enter M0064

Description Address

| | [E¥]mouss

Border Color

Alignment

HEN_ EE 0 e
== Mode
’}3 Bit=“

15 whord

Character Size
8x8 [

|' Flace ” Caneel H

Help ]

(3)Select a Part Shape from the Browser.

Shape Browser

| mMD_3D001

_____

MD_3D002 |

MD_3D004 ||| MD_3D005 ||| M

D_3D006 |

FDE Fike...

Current PDE File : Jc:\pmpbwin\pdb\pdb.pdb

Title - [MD_300M1

|
E”" Help

2.1 Parts 1 Select-
ing a Part Shape
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PROCEDURE

REMARKS

(4)In the [Messages| area, input the number of the mes-

sages and characters used.

Message Display Settings [MW_001]

Ix]

General Setlings | Messages I

Mo of Display

Messages Characters Selecled Mewsage Delete I
=t f |

Ten o MWW WEOCINE
Plate Color [/ O ) I 0 [ W B[]

” Flace ||| Cancel I” Help I

(S)Enter your Alarm Messages.

| — Enter 16

Message Sly\e=‘H‘EOD¥MDescnpt\on ||| Copy ta &ll |

[T @ l
3 ot — Enter 4
i Raised Color

Select the message number to be registered and enter
the message. When displaying a border with no mes-
sage, be sure to delete the words “Undefined”. Select

Colors and Character Size, if neces
(Example) When registering the m
erating” as message Number 1:

Message Display Settings [MW_001] [x]

General Settings || Messages I

Mo, of Display

Messages  Characters Selected Message | Detéle

=l =)

i
Style——— || Copy from Desmipt\nnl Copy to &ll

&) Normal

Ten o WO NEOCNE
Plate Color IO 00 ) I 0 o B[]

Message

2 Raised

sary.
essage “A Unit Op-

Enter A Unit
Operating

I~ Select 1

” Flace ||| Cancel I” Help I

(6)After all of the Part’s attributes

have been entered

and selected, click on the button.

The Message Display’s outline will appear on the Base

screen, next to your cursor.

/\
/A\
N

!
Important
Any characters entered that
are over the limit specified in
step (4) will be cut from the
GP’s display.

If the text “Undefined” is not de-
leted, it will be registered and then
displayed as a message.
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2.1 Parts

PROCEDURE

REMARKS

(7)Click on the point where the Message Display’s top
left corner is to be placed on the Base Screen.
If necessary, use the Message Display’s handles to alter
its size after placement.
The message, corresponding to the message number des-
ignated in the Dialog box, is displayed on the Message
Display.
Regardless of whether the Message Display is scaled up
or down, the character size will not change. To change
the character size and position, directly select a charac-
ter inside the text box.

To cancel the placement, click on
the [=2] icon.

To change the Part’s size, refer to

2.4.3 Scaling Up/
Down

When the Message Display is
scaled up(larger), the message char-
acters may not be displayed in the
correct position. In that case, use
the pull down menu [Edit] menu’s
[Align...] command to adjust the
position.

2.4.9 Align

Double-clicking on any Part placed
on the screen automatically calls up
that Part’s Attribute Settings dialog
box. Also, clicking on the message
numbers allows you to view the
message’s display status.

2.4.14 Changing
Attributes

%f €@, - Changing the state via the Parts State Change Tool Bar after placing a Part
1 allows you to check each state’s Library display condition.

- Every time a part’s screen is opened, the Part’s state will be reset to 0.

- If a state which has not been defined is designated, the Message Display
may show nothing. For example, when the number of messages is 16 and
only states 0 to 3 actually have a message registered, designating states 4 to

15 displays only message frames.
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m Date Displays ]

Date display data is created using the GP’s internal calendar and formatted
as: February 11th, 2000, or 00/02/11; however, the date format can be
changed.

B Date Display [General Settings| Attributes

Enter Comment Date Dispaly Settings [DD_001]
—— |- Select the Data

data hel'e General Settings ]
- Format
||| Description Character Size

The currently se- T |Bx16 7] [wirmiad ]
lected Part’s image
is displayed here

Test Color NI M) Bk g

[Border Color E]DD Blk ]2]

Calls up the Part Pae Co MWW ok L | Select the
Shape Browser o (e
p - Text and Plate
Parts can be se- (background)
lected directly from [t JI oot TL e Y
colors

the Browser

€ Data Format
The following display formats are available:

yy/mm/dd"!
dd/mm/yy™!
mm/dd/yy™!
20yy/mm/dd™
dd/mm/20yy*
mm/dd/20yy™

(yy: year, mm: month, dd: day)

¢ Color

The Date Display’s border color, character display color (Text), and interior
color (Plate) can be selected here.
2.1 Parts W Selecting Colors

@ Character Size

The label’s Character Size is selected here.

2.2.9 Text

*] The characters used to display 2000 on the GP are “00".

*2 The characters used for the display of 20005 first two characters (“207) are single-byte
characters.
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B Placing a Date Display
The Date Display placement procedure is shown below.
Used to display the date. 00/02/3
PROCEDURE REMARKS

(1)Select the [Parts] menu - [Date Display] command,
or click on the [112] icon.

(2)In the [General Settings| area, select a display format.

General Seftings |

Deseiion R | — Select the yy/mm/
I— ) | P

Border Color |1 ) )0 e O
B Tew Cobr ) MY ) e O
Plate Color 1) ) ) I ) ) B D

[ Prace |H Cancel ||\ Help |

(3)Select a Part Shape from the Browser.
If desired, select Colors and Character Size.

Shape Browser

Cancel

iR
_3D001

DD_3D002 |

DD_3D004 ||| DD_3D005 | B PDE File...

Current PDB File : Jc:\prapbwim\pdb\pdb.pdb ‘
Tile : [DD_30001 EIH Hep |

(4)After all of the Part’s attributes have been entered
and selected, click on the [Place] button.
The Date Display’s outline will appear in the Base screen,
next to your cursor.

2.1 Parts A Select-
ing a Part Shape
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PROCEDURE REMARKS

(5)Click on the point where the Date Display’s top left | To cancel the placement, click on
corner is to be placed. the [« icon.
If desired, use the Date Display’s handles to alter its size.
Regardless of whether the Date Display is scaled up or
down, the character size will not change. To change the
character size and position, directly select the charac-
ters inside the border.

To change a Part’s size, refer to

2.4.3 Scaling Up/
Down

Double-clicking on any Part placed
on the screen automatically calls up
that Part’s attribute settings.

2.4.14 Changing
Attributes

vy s dd

When scaling up or down the dis-
play area, if the key is pressed
at the same time, the characters will
scale in unison with the border.
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2.1 Parts

m Time Displays

Time Display areas can be created, based on the GP’s internal calendar
function. Time will be expressed in 24 hour format.

(E.g)2

:25 pm > 14:25

Only one Time Display Part can be used per screen.

B Time Display [General Settings| Attributes

Enter Comment
data here

The currently

Time Settings [TD_001]

General Settings ]

Description Character Size

Bx16  |r

selected item’s
image appears
here

Calls up the Part — |

Shape Browser.

Part Shapes can be

Border Calar E]DD Blk g
Plate Color - J) [N 0 (1) O (O ) Bk d

|

/Select the
Character Size

)

Browveser

Text Color E]DD Bk O
” Flace

|” Cancel ||| Help

Select Border,
Character, and
Plate colors

selected directly
from the Browser

¢ Color

Here, the Time Display’s Border color, character display color (Text), and
background color (Plate) can each be selected.

2.1 Parts B Selecting Colors
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B Placing a Time Display
The Time Display is placed using the following procedure.

Display the time.

PROCEDURE REMARKS

(1)Select the [Parts] menu - [Time Display] command,
or click on the [[Z] icon.

(2)Select a Part Shape from the Browser. 2.1 Parts M Select-
If desired, select Colors and Character Size. ing a Part Shape

Shape Browser
:

TD_3D002 |

TD_30004 ||| TD_3D005 | il PDE Fie.

Current PDE File Jc:\plonbwin\pdb\pdb pdb

|
Title - JTD_ED om E” Help

(3)After all of the Part’s attributes have been entered | To cancel the placement, click on

and selected, click on the button. the [ icon.

The Time Display Part’s outline will appear on the Base

screen, next to your cursor. ATTIK. To change a Part’s

size, refer to 2.4.3 Scaling Up/

(4)Click on the point where the Time Display’s top left| ,

corner is to be placed.

Change the size if necessaty. ) ) When scaling up or down the dis-
Regardless of whethgr the 'Tlme Display is scaled up or play area, if the key is pressed
down, the character size will not change. To change the

. " ) simultaneously, the characters are
character size and position, select the characters directly.

also scaled up or down together
with the border.

Double-clicking on any Part placed
on the screen automatically calls up
that Part’s attribute settings.
2.4.14 Changing
Attributes
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@ Picture Displays ]

Registered Library items are displayed according to PLC Word Address
changes. Parts and Tags, however, cannot be displayed in these displays.
Up to 16 different kinds of Library items can be displayed on a single
Picture Display.

2.5 Libraries

\ /|\ The Picture Displays will not be displayed on the GP when
important transferred, if the GP has not been connected to the PLC yet.

B Picture Display [Description] Attributes.

Picture Display Settings [LB_001] ' Enter the
Enter Comment "Gieneral Settings | Library Image | Address to be
monitored
data here \\ Description Address here
\J | [E]unnun =

The currently ~_|

selected Part I Mode—
State’s image £ Bit Selects the
appears here £ Word Operation

Mode

|I Place I| Cancel H Help ]

@ Address

Here, either a Bit or Word Address is entered, after first selecting a Type
(either Bit or Word).

@ Mode

There are two methods used to switch the Library images displayed on the
Picture Display; one is Bit access and the other is Word access. Select either
of these.

Mode: When selecting Bit
Messages will change according to the specified Bit Address
changes.
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Mode: When selecting Word
Messages will change according to the state changes of the desig-
nated bits, consecutively from the specified Address’s 00 bit.
According to the number of the messages (either 2, 4, 8, or 16), a
bit is automatically assigned from the specified Address’s 00 bit.

Numbers of Number of
Messages Bits Used
2 1
4 2
8 3
16 4

When the value set in
the No. of Messages is
16, bits 00 ~ 03 are
used.

N\~

03 02 01 00

The remaining bits can be
used for other purposes

B Picture Display [Library Image] Attributes

Displays the —__
currently
selected
Library image

Reflects the
currently
selected item’s
designated
state

Picture Digplay Settings [LE_001]

| Settings  Library Image ]

N

Chapter 2 - Base Screens

When the value set in the
No. of Messages area is 4,
bits 00 and 01 are used

When the value set in the
No. of Messages area is 2,
only bit 00 is used

When the value set in the No. of
Messages is 8, bits 00 ~ 02 are
used

Library

Ergze Color

Delits:

Calls up the
Library Browser.
Library items can
be selected
directly from here

Pattern D

o IS W] o1
% HEELINELL)

|I Place || Cancel ||

Hep |

|

Deletes the
currently selected
Library item

— Selects the item’s
background and
foreground colors

& Browser

(used for clearing)

When clicking on the button, the Library Browser (Library list)
will appear. Select a desired Library from this list and drag it to the inside
of the Library image display border on the Dialog box.

2.5 Libraries
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@ Delete
The selected Library item is deleted and the display will disappear.
@ No. of Lib.

Displays only when Type’s Word is selected. The number of Library images
(number of states) to be displayed on the Picture Display can then be input.
Select any of 2, 4, §, or 16.

@ Library

Here, the Library item used for each state is specified. Settings will differ
depending on the Type selection.

Mode: When selecting Bit
Specify a Library item’s ON and OFF states, respectively.

Mode: When selecting Word
The n.umber of buttons will match the designated number of
Library items. Specify a Library item for each state.

%te:
N\

Changing the state via the Parts State Change Tool Bar after placing a Part
allows you to check each state’s Library display condition.

@ Color

The background square colors (Clear Fg, Clear Bg)) and pattern (Pattern)
are selected. The default settings are black. The square colors can be
selected so as to match the Picture Display placement area background’s
color.

<Back Ground Square>

The Library item to be displayed while the GP is running needs the filled
square for the background to be the rearmost, so that the items(images) do
not overlay each other when they are switched. When designating a Library
item, the GP-PRO/PBIII for Windows program will draw this colored square
automatically.

Right after the Library item(s) is/are placed, the background square will match
the size of the largest Library item designated. After the items are placed, it
can be scaled larger or smaller, independently from the Library items.

For a state with no designated Library item, only a background square will
be displayed and it will become the Library’s deletion screen, i.e. it will be
overlaid on top of an existing item to “delete” that item.
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B Placing a Picture Display

The Picture Display’s creation procedure is shown below.

State 0 State 1 State 2 State 3

The 3 pictures registered as libraries, as illustrated above, will
change in response to changes in the state of Word Address D00250.

N\ J

PROCEDURE REMARKS

(1)Select the [Parts] menu - [Picture Display] command,
or click on the icon.

(2)In the [General Settings] area, enter an Address and
select a Mode.

| General Settings | Library Image I
1| — Enter D00250
Description Address

| |  [¥]pons <

tode-
i3 Bit
& Wward

T Select Word

|. Flace I ‘ Cancel 1 | Help ]

(3)In the [Library Image] area, input the No. of library
items (No. of Lib.) used.

Picture Dizplay Settings [LW_002]

[ General Setings | Library Image ]

Now of Lit,
Erase Color:
Fo [ I ) ) 1) & [
e BN o« O
Pattern i:i:

" Place ” Cancel H Help ]
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2.1 Parts

PROCEDURE

REMARKS

(4)Select a state (to register an item as), and then click

on the button.

Here, perform settings for state 0.

Picture Display Settings [L'_002]
[[General Setings | Libray Image |
4 = :
Ly

Erase Color

Fo [ ) ) ) Bk T
eo [ )] Bk

Pattern I:l
\ | Flace I| Cancel H Help ]
\
Select 0

(5)Select a Library to be displayed for state 0 from the
Browser.

;a0 [Op4-objg.cpw : Unused Plain Keypad Parts]
Fil= Edit “iew window Help

[O=] [%[=[@

F

12: stop

(6)Drag the selected item to the Dialog box’s black item
display area.
Select foreground or background Colors, if desired.

Picture Display Settings [L'w_002]

Genersl Settings| Library Image |

No. of Lib. N

Library
Fs I M) & D)
EEE

2.5 Libraries

To select a Library from a file dif-
ferent from the currently displayed
one, click on the Library Browser’s

icon.

2.5 Libraries

GP-PRO/PB III for Windows Ver. 5.0 Operation Manual

2-113



2.1 Parts

Chapter 2 - Base Screens

PROCEDURE

REMARKS

Picture Display Settings [LW_002]

General Settings

Library Image I

Ly
Erase Color,
Fa [ I ) e

es I

(7)For States |[1] and [z], repeat steps (4) ~ (7). Since
State [z ]is used to delete Library item from the screen,
nothing is specified for it.

(8)After all of the item’s attributes have been entered

and selected, click on the button.

The Picture Display’s outline will appear on the Base
screen, next to your cursor.

(9)Click on the point where the Picture Display’s top
left corner is to be placed.
Here, the Picture Display’s border (dotted line or filled
square) and the Library item will appear. At this time,
the Library item corresponding to the state currently se-
lected in the Dialog box is displayed on the Picture Dis-
play.
Regardless of whether the Picture Display’s border is
scaled up or down, the Library item’s size will not
change. The border size is common through all the Li-
braries. The Library item’s size and position can be al-
tered by clicking directly on its inside border.

To delete a Library item, click on

the button.

To cancel the placement, click on

the [«] icon.

Double-clicking on any Part placed
on the screen automatically calls up
that Part’s attribute settings. Also,
switching the states allows you to
view the Library display status.

2.4.14 Changing
Attributes

Changing the state via the Parts
State Change Tool Bar after plac-
ing a Part allows you to check each
state’s Library display condition.

%je: - Every time the screen is opened, the state will be reset to 0.

- If a state with no Library registered is designated, nothing will be displayed
on the Picture Display. For example, when the number of messages is 16
and only states 0 to 3 actually have a message registered, designating states
4 to 15 displays only background square frames.
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m Drawing

Straight lines, rectangles, and oval objects can be drawn, using drawing
tools.

2.2 Drawing

An object’s attributes such as line types and colors are designated in its

dialog box. After designating the object’s attributes, move the cursor and
start to draw the object directly in the drawing area.

ﬁé\t\eﬂ These objects can also be drawn via the Keypad and Trend Graph screens.

Usage Pattern

[Draw] —  Selectadrawing

— Set any attributes
or command

— Draw the object

Select a desired drawing icon from the
Draw Tool Bar.

B Drawing Tools

Icons contained in the Draw Tool Bar and their corresponding drawing
objects are as follows:

Icon Object Types Icon Object Types
Dot Filled Polygon
HE Line/Poly-line Scale
_@ Square/Rectangle Text
Circle/Oval Load Screen
= ArciPie Load Mark
I@ Fill

B Selecting Line Types

10 selections are available for straight and poly-lines, and for graph divi-
sions. 6 selections are available for rectangles, circles, arcs and pie sections.

Polyline |
%

9 — ] Polyine

g +—

e

Fo I e
0 RO EECC] Bk

Select one of these
patterns
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B Selecting Colors

For color and blink attribute settings, use the procedure same as for Parts.

2.1 Parts B Part Attributes - Selecting Colors

B Tiling Patterns

Nine different tiling patterns are available. These patterns can be selected
for squares, circles, filled squares and polygonal objects. When combining
foreground (Fg) and background (Bg) colors, a variety of filled patterns can
be drawn.

Line/Polygon |

— Select a pattern

fo HEECE®OO &<
5o /) B

When a square or circle is drawn, only the line type will be displayed ini-
tially. To display the pattern selections, check the Fill check box. (check
mark will appear)

Circle/Oval [=] Circle/Oval [=]

Fi =] Fil c
== IZ>

Fo I ) ) )] B Fo I ) ) )] B
Bo [N/ 1) ex) Bo [N/ 1) ex)

D o |

Dots can be drawn in 1, 2, 3, and 5 dot units. To draw a dot, simply click on
the desired point.

B Dot Attributes

Dot |
. =D ot type=—x=

Select th_e dot unit used % 1Dat - +— Displays the currently
for drawing £ 2Dots selected dot’s image

2 3Dats

i 5Dats

Fo 0T exl| _Selef:t col_ors and blink-
ing, if desired
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B Creating a Dot

2.2 Drawing

PROCEDURE

REMARKS

(1)Select the [Draw] menu - [Dot] command, or click on

the icon.

(2)Set the attributes of a dot to be drawn.
Select a dot type and colors, if desired.

Dot |
=Dt type=—
T —
i 2Dots
i 3Dots
7 BDots

fo HEE_ BN &k

(3)Move the cursor to the drawing area. A dot will be
drawn at the point clicked on.

When using the keyboard to draw
a dot, move the cursor to the de-

sired point and press the [ ]| key.

To cancel/delete the dot, click on

the || n_ﬁ_u. icon.

Double-clicking on any object
drawn on the screen automatically
calls up that object’s Attribute Set-
tings dialog box.

2.4.14 Changing
Attributes

@ Line/Poly-line

In order to draw a line, simply click to designate the line’s start and end
points. A continuous straight line can also be drawn; holding down the
key allows you to draw lines at precisely 0°, 45°, or 90° angles.

H Line/Polyline Attributes

When drawing a polyline, check this box

Polyline

Selects a line type

[]
(with or without —__| g : ) Polyine | The currently selected
arrows) & o line’s image appears

here

Selects a line

=

type

ro AWM exC)|  Select a color, and
Ba I MmN 1] e]|| blinking, if desired
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B Drawing a (Straight) Line

PROCEDURE REMARKS

(1)Select the [Draw] menu - [Line/Poly-line] command,

or click on the icon.

(2)Set the attributes of a straight line to be drawn.
If necessary, select the color and line type.

Polyline [<] If an arrow (=) is selected, the
H— o line’s end point will become an ar-
g : E| olyline rOW.

=

fo HEECIE®EO &
B 1) Bk

(3)Move the cursor to the drawing area, click on the | In step (4), while holding the [Ctrl]
line’s starting point and drag the mouse to the end | key down, a straight line at an angle
point. of either 0, 45, or 90 degrees can

also be drawn.

When using the keyboard to draw
a straight line, use the arrow keys
to move the cursor to the start and

end points and press the | key, to
start and finish the line.

(4)Click again; a straight line is drawn (registered). To cancel the placement, click on
the [wa] icon.

drawn on the screen automatically
calls up that object’s attribute set-
tings.

2.4.14 Changing
Attributes

/‘ Double-clicking on any object

B Drawing Polylines
When the Polyline check box is checked, Polylines can be drawn. Click on the
starting point then drag the mouse, clicking the left mouse button at each point of
the desired directional change of the line; and, click on the right mouse button at
the end point of the line.

ﬁé\te: - When drawing, if the Keyboard’s key is pressed instead of clicking
A on the mouse right button, the start and end points of a polyline object will
be automatically connected.

* You can draw a line that looks hand-drawn by holding down the mouse’s
left button when drawing a polyline.

2-118 GP-PRO/PB III for Windows Ver. 5.0 Operation Manual



Chapter 2 - Base Screens 2.2 Drawing

@ Square/Rectangle ]

To draw a square, click on and designate the diagonal two points.

To draw a regular square, perform this operation while holding down the
key. By selecting a pattern before drawing, a filled square also can be
drawn. Both normal (non-filled) and filled squares can be beveled.

B Square Attributes

Check this check box when draw-
ing a filled Square/Rectangle

SquarefBectangle

Displays the

= Fil E | currently se-
lected Square/
o g
omer]—:” Rectangle type

Selects a line
(border) type — === = =z =--||[mmmm]| '~ When selecting
Corner, this

Select a Colorand _ ||Fa [ /[ [ )] v number desig-
blinking, if desired B W) e[ nates the num-

ber of dots used

Selects the type of |
Square/Rectangle

7

<Filled Square/Rectangle Setting Screen>

Q |:| ] Fil
QD Comer-
Select one of the

tiling patterns D

fo HEECIE®OO e
Bo )0 Bk

@ Square Shapes and Beveling types
Square shapes and beveling types are as shown below.
[ ] Notbeveled.
(D All corners are beveled with straight lines.
D All corners are beveled with arcs.

When selecting Beveling, input a bevel dot number.

Founded + Line
The dot value sets up

4
- f T this spacing
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B Drawing a Square/Rectangle

Chapter 2 - Base Screens

PROCEDURE

REMARKS

(1)Select the [Draw] menu - [Square/Rectangle] com-
mand, or click on the icon.

(2)Set the attributes of the square/rectangle to be drawn.
If desired, select the colors, line types, beveling type and
dot. When drawing a filled square, check the Fill check
box, instead of selecting line types.

QEI L Fil E
D Eorner-
==

Fo /)07 ek
il | ) m] | [

@ Select a pattern
SquarefHectangle
QEI ] Fil n
D Eorner-
]

Fo /)07 ek
il | ) m] | [

(3)Move the cursor to the drawing area and click on the
first of the diagonal’s points, “a”.

(4)Click on the diagonal’s other point “b”.
The rectangle is automatically drawn (registered).

2.2.3 B Square At-
tributes; ® Square Shapes and

Beveling types

In step (4), hold down the [Ctrl |key
to draw a square.

When using the keyboard to draw a
square, use the arrow keys to move
the cursor to the rectangle’s two di-
agonal points and press the | key
to start and finish the rectangle.

To cancel the placement, click on

the icon.

Double-clicking on any object
drawn on the screen automatically
calls up that object’s attribute set-
tings.

2.4.14 Changing
Attributes

2-120

GP-PRO/PB III for Windows Ver. 5.0 Operation Manual



Chapter 2 - Base Screens 2.2 Drawing

@ Circle/Oval ]

To draw a circle or an oval, click on its center point and drag the mouse to
the circumference point, and click again. Holding down the key draws
a perfect circle. To draw a filled circle or oval, select the desired pattern.

B Circle/Oval Attributes
Check this check box, if a filled Circle/

Oval is desired !
Circle/Oval | X]|
I Fill |

e —
Select a Fg and T | | O | e

Bg color, and

o e (| Fo I ) ) B
ls)il:::;lng, if de- T TR T e

— Displays the
currently selected
Circle/Oval image

Select a Line/
Border type

<Filled Circle/Oval Setting Screen>

Circle/0val ]

Fo HEECIEE O &<
B W)W 1] e

Select one of the
Tiling patterns

B Drawing a Circle/Oval

PROCEDURE REMARKS

(1)Select the [Draw] menu - [Circle/Oval] command, or

click on the [ 3| icon.

(2)Set attributes of an oval to be drawn.
Select colors and a line type, if desired. To draw a filled
oval, check the Fill check box and select a pattern, in-
stead of selecting a line type.

Circle/0val [x]

o MEE R o0
o N ] e

@ Select a Pattern
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PROCEDURE REMARKS

U

Circle/Oval [<]

O =

Fo I )] Bk
el | 0 (] | i

(3)Move the cursor over the drawing area, and click on | In step (3), if the key is held

the center point, shown here by “a”. down, you can draw an oval which
contacts a specified area (i.e. the
side(s) of a square). This function
is useful when drawing an inscribed
circle and can also be used in step

(4), together with the key.

(4)As the cursor is moved, the oval will expand or con- | To draw a regular circle, hold the

tract. key down in step (4).
Click on the point shown by b. The drawn oval will be
registered.

When using the keyboard to draw
an oval, use the arrow keys to move
the cursor to the center point and
then, to the point which defines its
circumference (radius point), press-

S ing the [ key each time.

To cancel a drawing action, click
on the [[wz] icon.

Double-clicking on any object
drawn on the screen automatically
calls up that object’s attribute set-
tings.

2.4.14 Changing
Attributes
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@ Arc/Pie ]

To draw an arc or pie, a portion of a circle must be selected. You will need
to first draw a circle, and then, click on the arc’s beginning and end points.

B Arc/Pie Attributes

Check this check box when
drawing a Pie

| Pie | Displays the
currently selected
Select one of

Arc/Pie image

the line/border = -
types E R A

fo HEROEN O &< Select the Color
RN | e and Blink set-

tings, if desired

B Drawing an Arc

PROCEDURE REMARKS

(1)Select the [Draw] menu - [Arc/Pie] command, or click

on the |+ icon.

(2)Set the Arc’s attributes.
Select Colors and line type, if desired.

Arc / Pie [x]
=
|| | | | B ]

fo HEECE®OO e
B I W) Bk

(3)Move the cursor to the drawing area and click on the | In step (3), if the key is held

oval’s center point “a”. down, you can draw an oval which
contacts a specified area (i.e. the
side(s) of a square). This function
is useful when drawing an inscribed
circle and can also be used in step

(4), together with the key.
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PROCEDURE REMARKS

(4)Click on the oval’s radius point “b”. In step (4), holding down the[Ctrl]
An oval will appear and the arc’s base line will be dis- [ key draws a circular arc.
played.

5)Click on the arc’s start point “c” or on its elongation. | When using the keyboard to draw
p g g y

an arc, use the arrow keys to move

the cursor first, to its center point,

then, to another point on its circum-
. ference (radius point), and then, to
its start and end points. Press the

b key after specifying each of
these points.

(6)Click on the arc’s end point “d”.
The arc will be drawn (registered). To cancel the drawing action, click

on the E icon.
¢ d Double-clicking on any object

drawn on the screen automatically
: calls up that object’s attribute set-

b tings.
2.4.14 Changing

@ Attributes

B Drawing a Pie (Sector)
Follow the same steps used for the drawing of Arcs.

When using the same procedure to draw an Arc:

c A

SIS

D
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@ Fill |

To use the Fill command, simply left-click your cursor on top of an object’s
enclosed area. The selected Fill pattern will then spread outward until it
reaches a boundary. A boundary can be any line or Fill that is the same
color as that chosen for the Fill’s foreground, background, or border.

<Cautions when Filling an Object>

= solid lines. Dotted lines can not be used as an enclosure.
Important

m Be sure that the area to be filled is completely enclosed with

A space of only one dot on the border of an enclosed area is
enough to allow Fill to leak into other areas of the screen. Be
especially careful when drawing polygon vertexes and filling an
object while the display is set to 50%.

DO NOT attempt to fill objects that have been designated as
blinking.

When filling an image that uses an arc, Fill may leak when that
image is actually displayed on the GP panel display. To prevent
this, use a line to connect any gaps in the image.

B Fill Attributes

Fill

[x]
Displays the
currently selected

Fill type

Select one of the
tiling patterns

Fo W] &)
0 IO EN]] ekl Select a Color
ed I MmO

ﬁé\te: + To select the background color for all the screens used, use the [Option]
menu’s [Screen Settings|] command.

2.9.2 B Settings Screen Property - [Color]

- To cancel the application of a Fill due to a mistake, such as having desig-
nated the wrong Fill point, press the key.
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B Filling an Object

PROCEDURE REMARKS
(1)Select the [Draw] menu - [Fill] command, or click on
the ‘% icon.
(2)Set the attributes. Fill spreads outward from the se-

lected point until it reaches a bor-

Select Colors and Tiling Patterns, if desired. der with one of the colors (Fg, Bg,

Fill [x] Bd) selected in step (2).
D Select the same color for the Bd
(border) Color and boundary Fg
(foreground) Color.
Eil /!

Line's Fq color, Blug

Fo NI [ )] &) Fill's B colar Blug
Bo I T O ) ek
ed I O o D

Left-clicking on a line will not

(3) Move the cursor to the drawing area and click on | cause it to be filled. Be sure to only
the area to be filled. click in an area enclosed by lines.

The designated area will be filled in.

When drawing via the PC’s key-
board, press the |« button to indi-
cate a fill point. Fills and fill points
1 can be specified to either display

or not display via the drawing
board.

@ AT 2.9.2 Screen Envi-

ronment Settings
To cancel Fill due to a mistake, such
as designating a wrong Fill point,
press the key.

To cancel the filling, click on the

icon.

Double-clicking on a filling point
of any filled object drawn on the
screen automatically calls up that
filled object’s attribute settings.

2.4.14 Changing
Attributes
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@ Line / Polygon ]

To draw a Polygon, either Left-click or press the | key to indicate the
Polygon’s vertices. To complete the Polygon, either right-click or press the
to automatically connect the beginning and end points.

Holding down the key while drawing a Polygon will snap the polygon’s
segments to 45 degree angles.

B Polygon Attributes

Line/Polygon

[x]
| Displays the
currently se-
Select one of lected Polygon
the tiling pat

terns

Fo N IM® ekC)|  sets the Color
Ba MW JM® 1] e«|| and blinking, if

desired

B Drawing a Polygon

PROCEDURE REMARKS

(1)Select the [Draw] menu - [Filled Polygon] command,

or click on the | %4 | icon.

(2)Set attributes of a polygon to be drawn.
Select Colors and Tiling Pattern, if desired.

Line/Polygon |

fo HEECE®OO e
B I W) Bk

(3)Move the cursor to the drawing area and click on the
start point “a”.
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PROCEDURE REMARKS

(4)Left-click to designate the positions of the Polygon’s [ Up to 100 corners (faces) can be
vertices. created.

Repeat this for as many vertices as needed. Here, points | 1, step (4), holding the key

band c are also shown. causes lines to be drawn at exactly

0, 45, or 90 degree angles.

(S)After defining the final vertex, c, right-click or press | To cancel the drawing, click on the

to complete and fill the Polygon. icon.

Points a and ¢ are joined and the object is filled.

Double-clicking on any object
drawn on the screen automatically
calls up that object’s attribute set-
tings.

2.4.14 Changing
Attributes

ﬁ?te: + About Filling a Polygon
X2

When a polygon’s segments overlap, the filling alternates, so that areas next
to each other do not display the same pattern. As a result, areas without
any fill (white) may develop inside the polygon. If fill is desired in these

areas as well, click on the icon.
Eg
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2.2 Drawing

ED o

To draw or create a Scale, input the number of divisions desired and then
left-click the mouse’s cursor to designate the scale’s beginning and end
points. Scales can be either horizontal or vertical, linear (straight line) or

curved (semi-circle).

B Scale Attributes

Enter the number of divisions desired

Scale

] Displays the cur-

=Type=—=) Divisions
Selec} the £ Curved rebr!tlyt’se_lected
Scale’s type 5 Linear object’s image

W] Vetical "
— (Only with straight

— line Scales) Changes

Select the line E- i

— the scale’s orienta-

type ———

tion to vertical

- EEEOEE 0 o0 ertical
Bo BT EN] )] B0 (default is horizontal)

Select the Color and

B Drawing a Scale

blinking, if desired

PROCEDURE

REMARKS

(1)Select the [Draw] menu - [Scale] command, or click

wls

on the |;5l icon.

(2) Set the attributes of the divisions to be marked.
Select the Scale’s colors, line type, and Scale type, and in-
put the number of scale divisions. If “Linear” is selected as
the type, select the orientation direction by clicking on the
Vertical check box. (Unchecked means Horizontal)

Scale |
=Tupe=——= Divisions

1 Curved

) Linear E Vertical

||_ — o

fo HEECN®EOO &
Bo I I ) ) B

<Number of Divisions>

When the number of the divisions
is specified as 8§, a total of 9 divi-
sion lives will be displayed.

(i.e. the number entered +1)
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PROCEDURE REMARKS

The following explanation is divided into two parts; first,
when creating a linear type scale, and second, when
creating a curved type scale.

[Creating a Linear type scale- (Vertical, with 8 divi-
sions)]
Specify the area of division lines by a rectangle.

(3)Use the mouse’s cursor to create a rectangle in the
drawing area, i.e. left-click to indicate the linear scale’s
start point, a.

N4

‘ A

(4)Complete the rectangle by left-clicking on the Scale’s | Holding down the key while
end point, b. performing step (4) will draw a per-
The rectangle shape will disappear, and be replaced by | fect square.

division lines. When using the keyboard to per-

a form drawing, press the | key to
designate the start and finish points.

To cancel the drawing, click on the

g [ icon.

[Creating a Curved type scale- (8 divisions)]
Specity the area of division lines, using double circles.

(3)Use the mouse’s cursor to create a circle on the draw-
ing area, i.e. left-click to indicate the curved scale’s
start point, a.

/

‘ a
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2.2 Drawing

PROCEDURE

REMARKS

(4)Click on the radius point “b”, which is of a scale’s
outer circle.

a°/
—

(S)Draw another circle inside the circle drawn in step
(4) to decide the width of the scale. Click on this in-
ner circle’s radius point “c”.

(6)Rotate the displayed segment and click on the scale
start point “d” or on its elongation.

(7)Then, rotate the segment again until you reach the
desired end point e, and click to designate the end of
the scale’s divisions.

Division lines appear inside the area surrounded with
the double circles and the two segments. They will be
drawn clockwise from the start point to the end point.

When using the keyboard to draw

divisions, press the [(]| key after
moving the cursor to the division
circle’s center point, to the other
point on its circumference (radius
point), and then to the divisions’
start and end points.

To cancel the drawing, click on the

icon.

Double-clicking on any object
drawn on the screen automatically
calls up that object’s attribute set-
tings.

2.4.14 Changing
Attributes
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@ Text

Chapter 2 - Base Screens

)

Use your PC’s keyboard to enter text, and then place in on the screen with
your mouse’s cursor. This software has two methods of placing text on the
screen. The first method defines the placement point, and the second de-
fines the area where the text will be centered.

B Text Attributes

Enter text here. A
maximum of 100
characters can be

entered per line,
and 100 lines per
screen

Selects the text’s

display direction

Specifies the
character width
and height

Text

text

=Drirection =Syl
Harizonta l;_h 1% Mormal

[
@ -\ 5 8ol
\%sed
Farit Size

Fo NN N T 1) IV ] &
B [N I o[ ) kL

& Character Size

Display a sample
of the current
text’s attributes

Selects the
Character Type

Rotates the text
in 90 degree
increments

Selects the Fg
and Bg colors,
and blinking

Clicking on the font size display area, displays the current character size
(used after text is placed on the drawing area). Move the cursor to where the
X and Y axis lines cross, and drag the cursor. As the axis lines move, the

character size will change. Click on the text block again, or press the

key to register (enter) the change.

Fort Size

16x32 |-

: I

0 17 A0 e

oMM [ WO0 e
1632

E.g.) Available Height x Width Chart

Single Byte Font Double Byte Font

Character | 1 x1 8x8 16x16 | 16x8 | 16x 16
Size 2x2 16x16 | 32x32 | 32x16 | 32x32
4x2 32x32 | 64x64 | 64x32 | 64x64
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ﬁé\te:
X2l

@ Style

Characters can be either Normal, Bold, or Raised.
Style
29 Nomal
i) Bold

i7) Raized

When text character backgrounds (Bg) is specified to Black + Blk (Blink),
transparent mode is used, thereby displaying that area as transparent. For
256-color mode, select the last (255th) color, which is “Transparent.” How-
ever, for the GP unit with three blink speeds, this mode can be specified only
when the “Mid” speed is selected. If an object has been drawn underneath
these characters, they (the characters) will appear transparent, showing the
object behind. This function is useful when overlaying text on objects, i.e.,
over the face of Switches and Lamps.

2.2 W Selecting Colors

B Changing to a New Text Line and Line Settings

When entering characters, simply press the |J key to move to a new line.

When there are 2 or more lines of text, icons will appear to allow adjust-
ments in line spacing, and justification.

Controls the

;ine _Spa,::ing. T iz Spacing Juztification Controls the
pepflerng;: in |BX1E El |':' —— selected

text’s

dot Incre-  EEEDEECO O justification
s I E D EE] 5«0

@ Justification

Horizontal text’s alignment can be changed to either Left, Center, or Right
justified.

Left justified — = ={— Right justified

Centered
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B Entering Text

PROCEDURE REMARKS

(1)Select the [Draw] menu - [Text] command, or click

on the (| icon.

(2)Set the attributes of the characters to be input. The attributes can also be entered
Select Colors and Character Size, if desired. and selected after entering text.
Text

bet

When “Raised” is selected for
Character Type, the border color
(Bd) will become shadowed (i.e.

=Directior Syl 3 'D) .
i Horizontal e %) Normal
................... o
19 Variical 0 Bold
) Raized
Font Size

Fo I/ )] k1
Bo [N/ T ) BT

(3)Click on the text field to input characters, via your
PC’s keyboard.

Simply clicking on the text field allows you to input char-
acters there.

Text

bt

Mertioat £ Bold
£ Raized

= Directior Syl
O s [' & oma
:

Font Size

fo B )EEO 5«0
Bo [N I/ I Bk

Hereafter, two text alignment cases will be explained, one
not using and one using the Centering function:

<When Centering function is NOT used>

(4)Move the cursor to the drawing area and click on any
desired point.
After clicking on a point in the drawing area, a text box

the size of the selected character will appear on the screen. | {5 enter text press the [(J| key to
The top left corner of the text box is the base point used

. designate a position.
for positioning.

When using your PC’s keyboard
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2.2 Drawing

PROCEDURE

REMARKS

(5)Move the cursor to the desired position and left-click
the mouse to place it on the screen.

N

Operation 3creen

<When the Centering function IS used>

(4)Move the cursor over the desired placement area and,
while holding down the key, click on any
desired point.

After clicking on a point in the drawing area, the text
box will appear on the screen in dotted line.

(5)Select a centering area that is the same size or larger
than the previously selected text area.
The designated size’s text box will appear in the center
of the selected area.

Operation Screen

To cancel the placement, click on

the

k_ﬂj| icon.

Double-clicking on any object
drawn on the screen automatically
calls up that object’s attribute set-
tings.

2.4.14 Changing
Attributes

To cancel the designated area, click
the right mouse button.

ﬁé\te: + Here, GP-PRO/PBIII for Windows uses the PC’s system font. As a result,
=l the text that you see on the GP display and that shown on the PC may

differ.

+ In both GP-PROIII and GP-PRO/PBIII (DOS Ver.), when an object is
overlaid on a text block, the text block will be displayed in the foreground.
With GP-PRO/PBIII for Windows, however, the text block will be placed
behind the object. When the GP-PROIII and GP-PRO/PBIII (DOS Ver.)’s
data is used in the GP-PRO/PBIII for Windows, the text block will be

displayed in the foreground.
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m Load Screens ]

Graphics created on screens in a project can be loaded and used repeatedly
on others with GP-PRO/PB III for Windows. Thus, a single screen’s con-
tents can be used repeatedly elsewhere. The Load Screen function is also a
good way to cut down on your screen’s actual size, since you only need to
call up items to your screen, not save them on it.

B Screens that can be loaded to other screens

Current Screen Loadable Screens

B (Base) screen

T (Trend graph) screen

B (Base) screen K (Keypad) screen
| (Image) screen

| (Image) screen-CF card
B (Base) screen

T (Trend graph) screen | (Image) screen

| (Image) screen-CF card
B (Base) screen

K (Keypad) screen | (Image) screen

| (Image) screen-CF card

Only one (1) Keypad can be loaded onto a Base screen. The screen cur-
rently being edited cannot be loaded on to itself.

/| / If any portion of a Trend Graph screen extends over a Base

important Sc€reen’s border, the Trend Graph screen will not display cor-
rectly on the GP screen.

%te,' If a portion of an Image screen extends over a Base screen’s Y axis border,
that portion will not be displayed on the GP screen. When the Image screen
is placed over the Base screen laterally, however, any part that extends over
the Base screen X axis border will be squeezed onto the GP screen.(i.e. not
cut)

When using GP-PRO/ When using the GP

Example) PB Il for Windows panel display

Drawing
Areas
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B Nesting

Screens can be nested up to 10 times (11 layers). However, if your PC’s
system memory is low, a loaded screen/object may not be displayed. Later,
however, when the data is transferred to the GP, the display will appear

normally.
E.g.) Nesting Objects Twice (3 layers)
Bi00 B10 Bi

[

@ﬁ% L

Load Screen B100 Load Sareen B10

iy
OoO

%f €. The load screen nesting condition can be viewed via the load screen nesting
display function.

SEOTTIEIK 2.9.9 Display at Screen Level Change Structure

B Loading a Screen

PROCEDURE REMARKS

(1)Select the [Draw] menu - [Load Screen] command,

or click on the ||[&]| icon.

(2)Select a desired screen from the list or enter that | Only screens in the currently used
screen’s number directly on the [Screen No.] field via | Project file can be loaded. Screens

the keyboard, and then click on the button. | 1n other project files can not be
Then, the screen’s outline and center point will appear in | l0aded.

the drawing area, next to your cursor.

Load Scroon The current (selected) Screen can-
Screen Type |Base llz” 0K not be 10aded on to ltself
Sereen Ma. [11: Operation Manitar | @I

| 13:Trouble |[[14: Keyboard Infi~ Help

GP-PRO/PB 11l for Windows Ver. 5.0 Operation Manual 2-137



2.2 Drawing Chapter 2 - Base Screens

PROCEDURE REMARKS

(3)Click on the point where the Screen’s top left corner | A loaded screen cannot be edited
is to be placed. while it is being used on a different
The image’s center point is left top corner of its border, | (i.e. loaded) screen. You will need
and for other objects, the screen center mark will be the | to open the original screen to per-
placement point. form any editing.

I OPERATICN MONITOR \‘

To cancel the loading, click on the

A

E =HTOF WARM— TP RIITT iCOn.
o .

D

= TOP WARM—ITE EUTT

STOP WARII— TP RIITT

TEMPEE.
CONTROL

RUN

TROUBLE MONITOR

%ég When calling up a filled object:

When the current screen’s graphics overlap loaded filled (painted) graph-
ics, depending on the color used, unfilled areas may be created. To correct
this, add a fill to the current screen’s unfilled area.

ATEIIK 2.2.6 Fill
E100 E10
Load B100
B0 onto B10
Add a fill in the
unfilled area
AY{ - Ifabackground color is selected for the screen used for

Important screen call-up, the object placed on the screen will not be
displayed on the GP.

To call up the screen for which a background color has been
selected, specify the center of the screen as the call-up posi-
tion and then place the screen.
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m Load Mark ]

Marks (dot images) created in a Mark screen can be loaded and used repeat-
edly on Base/Trend Graph/Keypad screens.

B Loading a Mark Screen

PROCEDURE REMARKS

(1)Select the [Draw] menu - [Load Mark] command, or

click on the | & | icon.

(2)Select a desired Mark screen from the list or enter
that screen’s number directly on the [Screen No.| field

via the keyboard, and then click on the but-
ton.

The Mark’s outline will appear in the drawing area, next
to your cursor.

Designate its color and size before clicking on the [OK]
button, if desired.

Load Mark B Only Mark screens in the current
e [1 2y T project can be loaded. Mark
screens in other projects are not

available.

When the screen display size is
50%, the loaded Mark may not be
displayed correctly on the GP-PRO/

» EEEOEEO0 0 PB III for Windows software.
o EEEJEE) o0 e

To cancel the loading, click on the
(3)Click on the point where the Mark’s top left corner is icon.
to be placed.

If desired, use the Mark’s handles to alter its size. To change the Mark’s size, refer to

BT 2.4.3 Scaling Up/

Down
% - Double-clicking on any Mark
S loaded on the screen automatically
calls up that Mark’s attribute set-
tings.
AN 2.4.14 Changing
Attributes
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Tags are one of the GP-PRO/PBIII for Windows program’s many powerful
features. When you create a Tag, you can transform a square on the screen
into a switch, or create an animated display that changes according to data
from the Host PLC. Tags are created and placed on the screen where you
want a function to be; and, while most of the applications for Tags are on a
Base screen, they can be used with Keypad screens, as well as a variety of
other screens.

Here, topics such as Previously Created Tags, Changing of Tags, and Delet-
ing Tags, are discussed.

For further details of tags, refer to the Tag Reference Manual.

B Points to Consider when Creating Tags
When creating a Tag, please be aware of the following points:

€ When creating a number of tags on identical screens, if one Tag’s posi-
tion overlaps that of another Tag, the Tags will overlap when they are
called up and may not be displayed correctly. Please be aware of this
when loading (calling up) multiple Tags.

@ Using the Copy or Paste functions to place Tags with the same name on
similar screens can make identifying Tags difficult. It is suggested that
you either change the Tag’s attributes (i.e. name) directly, or use the Tag
Summary to change the name. It is especially important when 2 or more
K Tags have been used to enter a common Trigger Bit that the Tag names
used are different.

Tag Reference Manual 2.12 K-tag (Keypad Input)

@ Normally, up to 256 tags can be used on one screen (Digital’s GP-H70,
GP-270 and GP-370 can use up to 128 tags. GP-377, GP-37W2, GP-
377R and GP77R can use up to 384 tags.); however. more are possible, as
long as memory is sufficient. This total includes tags on any screens that
have been called up, or are included in a window that is used. This
figure, however, does not include any K tags or R tags.

Eg 1)
Screen B2 Screen B1 Screen B3

10 tags :> 10 tags||25 tags <:| 25 tags

Load Load
Screen Screen

Combined number of Tags = 35(B1) + 10(B2) + 25 (B3) = 70 < 256
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@ Though all of a Tag’s identifying marks, lines, etc. can be seen on the
screen that it was created on, after that Tag’s screen is called up to a Base
screen, those Marks can no longer be seen and it can not be edited. In
example 1 above, even though screen tags B2 and B3 are added to B1’s
total tag count, their identification data is not displayed on B1 (Drawing
area, Tag List, etc.) and can not be edited from that screen. To edit these
Marks, call up the Base screen on which each Tag was specified.

@ The order in which each Tag is created is recorded, and when the total tag
count for that screen exceeds 256 (Digital’s GP-H70, GP-270 and GP-
370 count up to 128 tags. GP-377, GP37W2, GP-377R and GP77R can
use up to 384 tags.), those excess tags are ineffective. When the tags
used on a screen have been called up from a window, those tags are
added to the total, in the order that the window was called up. Thus,
when calling up multiple windows for use on a screen, be sure that the
total number of tags used in all the windows does not exceed the above
limit, or certain tags will become invalid.

@ Approximately 90 reserved tags are used for the Device Monitor func-
tion. When using Device Monitor together with regular screen tags, they
must be added to the screen’s total tag count. Thus, be sure that the tags
used for the Device Monitor are included in your tag count calculation. If
the total becomes greater than that screen’s limit, the message “Total No.
of Tags is over limit.” will appear. Until the number of tags is reduced,
there is a possibility that the Device Monitor function will not work
correctly. If using the Device Monitor function will cause a screen’s total
tag count to exceed its limit, you should not use Device Monitor function
on that screen.

SEBGETIETIK 4.2.6 Device Monitor

@ The actual amount of space required (in bytes) for each tag will vary.
When placing tags on a screen, please consider the number of tags that
have already been created, the size of each tag, and the panel’s tag limit.

Information such as the current screen capacity and number of tags used
can be viewed in the [Screen Information] dialog box.

SEBOTNTIK 4.5.2 Screen Information

For each tag size, refer to the following table.
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<Tag Size List>

Tag Name Function T?gyfge
A Alarm Summary Text Display 56
a Alarm Summary Display 34
c Clock Display 28
D Statistic Graph Display 48
d Statistic Data Display 74

E Numeric Data Display extended function 3210122
F Free Library Display 42
G Graph Display 40

g Graph Display extended function 3810158
H Drawing Object Display 42
J Moving Mark Display 38

K Key Input 46,58

k Keypad Setup 28
L Library Display 34

| Library State Display 4010 102
M Mark Display 34
N Numeric Data Display 36
n Alarm Boundary Display 30
P Numeric Displayin Predefined Format 118

Q Alarm Summary Display extended function 46, 66,98
R Rail Settings 20
S String Display 32
T(Tih, Tiw included) Touch Panel Input 36
t Selector Switch Input 56
U Window Display 34
\' Video Window Display 30
w Write to a Device 32
X Display Text Data 40

Be aware of the following points:

* The total number of t-tags that can be used on the GP-470, 570, 571, 675
and 870 1s 128; with the GP-270, 370, and H70, it is 64; with the GP-377,
GP-37W2, GP77R and GP2000 series, it is 192.

* Only one (1) A, a, and C- tag can be used per screen.

» A total of 30 R tags are possible on one screen. The total number of
points used for R-tag data can be up to 406 per screen. However, when
calling up multiple screens, the total points allowable is 512.

* The number of windows that can be displayed on one screen at one time
is up to 3, i.e. one global window and two local windows via the U-tag.

 Tih, and Tiw tags cannot be used on the GP-H70, GP-270, GP-370, GP-
57J, GP-377, GP-37W2, GP-377R and GP2000 series units.
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2.3 Tags

@ Designating Tags

)

The tag setting items will differ depending on each tag type. Here, the basic
setting procedures are described.

After a Tag is selected, that tag’s dialog box will appear. Here all the tag’s
attribute data, such as the setting address, are entered. After all of the Tag’s

attributes have been entered, click on the button and designate the
point or area on the screen where the Tag will function.

Usage Pattern

-
or

[Tag]

Select a Tag
from the list

- se

Select a desired command icon

from the Tag Tool Bar.

Enter the Tag’s

tting data -

Designate the
functioning area

B Tag Settings

An example of a Tag’s dialog box is shown below.
In the [General Info] area, the Tag’s name and description data are entered.
Also, the Tag’s general settings are displayed.

E.g.) L Tag

Clicking here will
bring up the
Screen Access
settings (Items
will vary depend-
ing on the tag

type

L Tag Setting =
 General Info, m]
TagNome: ]
wiord Address: B \
Bit Address: 00oaoo
Trigger Type: 0-»1
Designated Screern; Direct
Sereen Mo Baze: 1
Erase Mode; Mo /

[ ok

=]

Help |

. Enter the Tag’s
name (number)
within 5
characters
here

— Enter Com-

ment data
within 20
characters here

Shows the
currently
selected Tag’s

settings

The actual setting items displayed will differ, depending on the tag.
Tag Reference Manual
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B Setting up Tags

An example of an L tag’s setting procedure is shown below.

I/—GP-PRO/PBIII Tag Settings PLC GP Display
[
Tag Name Lamp L1 o : - . /,
Display Mode i - -
Bit Address MO0016 I
Designated Screen Direct: 300 'When MOO16G is on. . the Lamp is on.
Erase Mode Yes WWhen MOOE is

off, the Lamp is off)
k. vy

In order to show a Lamp’s ON and OFF states on the screen, the above
mentioned settings will be used to create a lamp and its ON image.

(1) In preparation, draw a lamp on the screen where the Tag will be posi-
tioned.

(2) Draw an image of the lamp’s lighting area on screen B300 (This image
will be loaded onto the screen’s center point. Create the image based on
this center mark)

PROCEDURE REMARKS

(1)Select the [Tag] menu - [L-tag] command, or click on
the |[ L |icon.

—

(2)Enter the tag’s name. A Tag name should be 5 charac-
If desired, enter a description. ters or less.
" Tag Setting = SUGEENIN Tag Reference
R Enter lamp 1 ]lfanual, 2.14 L-tag (Library Dis-
T a
Tag Mame: L ] p y)
[ ezcription: ] —— Enter set up
now lamp
Word Address: -
Bit ddress: =00o00o
Trigger Mode: -1
Screen Access: Direct
Sireen Mo Baze: 1
Erase Mode: Mo
|| QK. | || Cancel | || Help
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2.3 Tags

PROCEDURE

REMARKS

(3)Enter the required data in the [Designated Screen]
area and click on the button to register it.

L Tag Setting

General Info. || Designated Screen |
) Direct 2 Indirect £ State

=Trigaer Type= Trigger Bit Address Erase Mode .
o-1 | e~ £t — Click on Yes
10 18 Yes

=5cieen Type: S M
{5 Base Screen oreen — -
2 Image Screen %IE
{2 Image Screen - CF Card

Enter M0016
T ok ¥ [ | ™~ Enter 300

n

Select Screen
Type

(4)Click on the point where the tag is to be used.
How this point is designated will differ depending on

each Tag type.

U

b

" Llamp

If your GP type is the GP77R se-
ries, [Image Screen - CF Card] can
be selected in the [Screen Type]
section.

Use the pull down menu [Option]’s
[Screen Property] command to
change the Tag name, setting ad-
dress, and Tag mark display state
(i.e. displayed or not displayed).
(However, these settings will not be
displayed on the GP screen.)

SABTENTIK 2.9.2 Screen Prop-
erty Settings

To cancel the placement, click on

the @ icon.

Double-clicking on any Tab regis-
tered on the screen automatically
calls up that Tag’s attribute settings.

SAOETNTIK 2.4.14 Changing
Attributes
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EZ» obiect Editing

Parts, objects, text, and Tags previously placed or drawn (hereafter called
“Objects”), can be edited using various functions, such as Copy and Delete.
To edit an object, first, use the cursor to select the object, and then select the
type of edit operation.

Usage Pattern

Select an [Edit] Select the type of Perform the
Object - or —>  editing to perform  —>  editing
Tool Bar

B Types of Editing Functions

Icons contained in the Edit Tool Bar and their corresponding edit operation
are as follows:

Icon Edit Type Icon Edit Type
= Undo % Mirror X-axis
C Redo ][ 2 Mirror Y-axis
.}E Cut =E Group
Copy IE Ungroup
R Paste E Bring to Front
Command Data Paste " E Send to Back
Duplicate a” Change Attribute
A Delete Change Coordinates
? Align Convert Bitmap
™ Rotate Left Transfgrlli'l::o:::(;een to
73 Rotate Right Converting S:ill'zen to Bitmap
F Redraw Screen

*] This function is enabled only when GP Type selection is a GLC series unit.
Pro-Control Editor Operation Manual

%te . The tools shown above can also be used from a menu by right-clicking the
X1 mouse.
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@ Selecting Objects ]

Two methods are available for selecting objects: 1) clicking on an object
directly, or 2) dragging the mouse to enclose and select single or multiple
objects.

Also, you can select individual objects that have other objects either on top
of, or overlapping them.

When the tool bar’s icon is clicked on (active), an object can be se-
lected. To activate this icon, click on it directly, or select the pull down
[Edit] menu’s [Select] command. Also, while drawing objects, right-
clicking anywhere on a desired object allows you to select it.

Either a Il or a [l mark will be displayed on the sides of the selected object.
These square marks are called “handles”.

Handle Types

There are two types of handles, those that can be used to scale the object and
those that can not. Refer to 2.4.3 Scaling Up/Down

M : Can be used to scale the object
[] : Cannot be used to scale

When an object has been be selected, the Selection Tool box will automati-
cally appear. When multiple objects are selected, all the selection Tool
box’s functions are available.

Selects all of the After selecting a group
objects in a group of objects, selects one
of that group

After selecting a group of
objects, selects one type
of object (i.e. squares,
circles, etc.)

After selecting either
or , clicking on either
or selects the next

object or type

— These keys are used to
select Tags when the Tag
box is checked

%@ Objects may be selected using the Screen Data List, instead of selecting them
on the screen.

2.9.4 Screen Data List

- When the tag check box for the selection tool box is marked with a check,
tags can be selected even if the tag names and marks are hidden.
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B How to Select a Single Object

Chapter 2 - Base Screens

Here, the procedure for selecting an object is explained.

PROCEDURE

REMARKS

[Selecting an Object Directly]

(1)Move the cursor over the object, and left-click.
Handles display on the object to show that it is selected.

k

O

P

[Selecting an Object by Dragging]

(1) Position the cursor near the object and hold the but-
ton down, then drag( this is called “Left-dragging”)
the mouse over the object. As you do so, a “box”
formed by a dotted line will expand to enclose the
object. When the entire object is enclosed within the
“box”, release the mouse button; handles display on
the object to show that it has been selected. You must
position the cursor relative to the object so that when
you Left-drag over it, the entire object will be en-
closed within the “box”; if it is not, then the object
will not be selected. This method is most useful when
selecting multiple objects, described below.

[Selecting an Object from Overlapped Objects]

(1)While holding down the key, click on an Object
to be selected.
That Object’s handles will appear to reveal it has been
selected.

To select a Tag, check the [Option]
menu’s [Screen Property]

command’s Tag Mark check box
beforehand.

When selecting grouped objects,
click on any one of the objects in a
group to select the group.

A Part’s Label can be selected in-
dependently from the Part.

Click on a Part to display its handles
and then on its Label to display the
Label’s handles. After selecting the
Label, it can be moved or scaled in-
dependently from the Part.

Numeric Display and text can also
be selected using the above-men-
tioned steps.

Left-dragging over only a part of the
object will not select it. The entire
object must be enclosed to select it.

When you wish to select another ob-
ject without de-selecting the previ-
ous one, hold down the key
while making the next selection.
This can also be done continually
to select multiple objects.
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B How to Select Multiple Objects

2.4 Object Editing

Use this operation to select multiple objects. All the objects in a designated area or
on the entire screen can be selected. Also, if necessary, some of these objects can be

de-selected.

PROCEDURE

REMARKS

[Selecting Multiple Objects by Dragging]

(1)Left-drag over objects as described in Selecting an
Object by Dragging (see above). Be sure to enclose
all of the objects to be selected completely; if part of
an object is not enclosed within the “box”, it will not
be included in the multiple selection. Handles will
display on the objects that have been selected.

[Selecting All the Objects on a Screen]

(1)Select the pull down [Edit] menu’s [Select All Ob-
jects] command. All object handles will appear, to
show that they have been selected.

-

To select a Tag, check the [Option]
menu’s [Screen Property]
command’s Tag Mark check box
beforehand.

Left-dragging over only a part of an
object will not select it. The entire
object must be specified to make
selection possible.

When two or more objects are se-
lected, the [Change Attributes]
command cannot be used.

The editing commands available
depend on what objects have been
selected.
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PROCEDURE REMARKS

[Excluding Objects From A Multiple Selection]

(2)When multiple objects are selected, to de-select an
object while preserving the selection of the other ob-
jects, first move the cursor over the object; then, while
holding down the key, left-click on the object.
When the object’s handles disappear, that object is
no longer selected. Repeat this process as many times
as desired.

[Adding Objects To A Multiple Selection]

(2)When multiple objects are selected, to add an object,

either left-click on the object or Left-drag over it,
while holding down the key.
The imaginary “box” that encloses the multiple selec-
tion (represented by its’ own handles) will expand to in-
clude the added object , which now has handles Using
this process, you can add as many objects to the multiple
selection as you want.
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2.4 Object Editing

PROCEDURE

REMARKS

[Selecting One Object in a Multiple Selection]

(2)First, make a multiple selection; then, click on the

Selection Tool box’s icon. All the objects in the

multiple selection will become de-selected, except for
one.

(3) Use the ||« |and ||+ | icons to “scroll” through all the
objects originally in the multiple selection; clicking on
these arrow keys will change the selected item, one at

a time. Clicking on the |+ |icon will select the next

object, and clicking on the |+ | icon will select the
previons object , inthe order that they were drawn.

If you wish to re-select all the
objects originally in the multiple
selection, click on the Selection

Tool box’s button.

To select an Object from over-
lapped Objects.

How to Select a
Single Object
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PROCEDURE REMARKS

[Selecting Objects by Type from a Multiple
Selection] Objects are classified as follows:
Parts: by each type,

Objects: by each type,

Selection Tool box’s W icon. Tags: All as one type,

Selection handles will appear for only one type of object | Loaded Screens and Marks: All as
(here, only square objects are selected), while an outline | one type, respectively.

remains around them all. This will effectively de-select
any objects that are not the currently selected type.

(2)First, make a multiple selection; then, click on the

- ®ER-E-§

To re-select all the objects originally
in the multiple selection, click on

the Selection Tool box’s
& — mm— button.

(3) Use the ||« | and ||+ | icons to select a different object type.

As you press either arrow key, the selected object type
will change.
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2.4 Object Editing

@ Moving Objects

)

In this section, the procedures for moving objects are described.

B How to Move an Object

PROCEDURE

REMARKS

(1)Click on the desired object. The object’s handles will
appear, showing that it has been selected.

(2)Place the cursor over the object, away from the
handles, and after the cursor changes to >, drag it
to the desired location.

&

ST 2.4.1 Selecting
Objects

The keyboard’s , , , and
keys can also be used when the
object’s handles are displayed.

If an object is too small to select
and move (i.e. it is only scaled up
or down), click on and drag the ob-

ject while holding down the[ Alt ]
key.

Also, you can move the object by
zooming out the screen or using the
keyboard.

1.3.2 Display Area
(50%, 100%, 200%)

To cancel the movement, click on

the @ icon.

%l‘ €. - To move an object horizontally or vertically, do so while holding the [Shift]
= key down. In this case, the object will be moved in either the horizontal or
vertical direction where the moving distance is greater.

- To move and scale up/down an object, designating its coordinates can be

used.

SOOI 2.4.15 Changing Coordinates
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@ Scaling Up/Down ]

Scaling means changing the size and proportion of an object. This function
allows you to easily scale an object up (larger) or down (smaller). Be sure
the object’s handles are displayed as ().

B Scaling An Object

PROCEDURE REMARKS

(1)Click on the object to select it. The object’s handles | SETIFTTNITIR 2.4.1 Selecting
will appear to show that it is selected. Objects

Re-sizing will depend on which

handle is dragged:
(2)Place the cursor on an object’s handle, and after the 88

double arrow cursor appears, drag the handle to re- Ex. To scale a square up or down:
size the object. Corner Handles = proportionally

Top/Bottom handles = vertically
s Right/Left handles = horizontally
Place the cursor on one of the
handles of the object. When the
| cursor becomes <>, use the

T keyboard’s either , 122, 1€], or
Q [{] key to scale the object up or

down in the unit of dot.

]
= E To cancel the re-sizing, click on the

71| icon.

ﬁé\te: * When re-sizing an object while holding down the key, lines will snap to
=l 45 degree intervals, Rectangular and Scale (Linear) objects will become
square-shaped objects, and ovals will become circles. Also, if the key
is held down, all selected Lines, Rectangles, Ovals, Scales, Text and loaded
Marks will scale up or down proportionately.

* When scaling a Part with a Label, holding down the key causes the
Label to scale up or down together with the Part.

* When selecting an oblique line, 8 handles will be displayed. Click on the
line again and 8 handles will change to 2 handles, one at either end. Click-
ing and then dragging on one end’s handle “fixes” the opposite end in place,
and “releases” the dragged end, and allowing the line to pivot freely.

+ Multiple parts may be selected and then scaled up/down. However, the
following parts are not scaled up/down, but their positions are moved:

- Half-pie Graphs, Pie Graphs, Meters, Trend Graphs, Alarms, Keypads, and
Picture Displays.

- To move and scale up/down an object, designating its coordinates can be
used.

SEOOTIEAIK 2.4.15 Changing Coordinates
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2.4 Object Editing

D <

)

Here, the procedure for “cutting” an object (deleting it) and placing it on
another screen, is explained. The object can also be placed elsewhere on the
same screen, instead of using the Move procedure described in section 2.4.2.
In addition, an object can simply be “cut” (deleted), and not placed any-
where. (When an object is “cut”, it is stored in the Clipboard™'.)

B Cutting (Moving) an Object

PROCEDURE

REMARKS

(1)Select an object.

(2)Select the [Edit] menu - [Cut] command, or click on

the icon.

Then, the selected object will be cut.

(3)Open the object’s destination screen, and select the
[Edit] menu - [Paste] command, or click on the

icon.
Then, the outline of the object cut from the previous
screen will appear.

(4)Position the cursor and click on the point where the
object is to be placed.
The object that had been Cut from the previous screen
will be “pasted” at the new location.

ST 2.4.1 Selecting
Objects

To cancel the Cutting, click on the

71| icon.

To cancel the pasting, click on the

E icon.

*] An area where text, graphics, or both, that have been Cut or Copied, are temporarily
stored. The contents of the Clipboard can be “pasted” (copied from the Clipboard)
using the Paste function. However, once the Copy/Cut command is executed, the data
stored in the Clipboard is replaced; therefore, only the data from the most recent Copy/

Cut command can be Pasted.
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BD oo |

Here, the procedure for “copying” an object (without deleting it) and placing
it elsewhere, is explained. (When an object is “copied”, it is stored in the
Clipboard™.)

B Copying an Object

PROCEDURE REMARKS

(1)Select the desired object(s).

SOOI 2.4.1 Selecting
Objects

(2)Select the [Edit] menu - [Copy] command, or click | To cancel the Copying, click on the
on the icon. E icon.

The selected object(s) will be Copied to the Clipboard.

(3)Select the [Edit] menu - [Paste] command, or click | When “pasting” the Copied object

on the icon. on another screen, be sure to open

. . . . that screen first.
Then, the outline of the object copied from the previous

screen to the Clipboard will appear. Selecting and dragging an object to
anther screen while holding down

(4)Position the cursor and click on the point where the the key can also be used to

object is to be placed. copy the object.
The object stored in the Clipboard will be Copied to the | T4 cancel the pasting, click on the
specified location.
icon.
- — -.Q

.

—3
i
u

*] An area where text, graphics, or both, that have been Cut or Copied, are temporarily
stored. The contents of the Clipboard can be “pasted” (copied from the Clipboard)
using the Paste function. However, once the Copy/Cut command is executed, the data
stored in the Clipboard is replaced; therefore, only the data from the most recent Copy/
Cut command can be Pasted.
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@ Paste ]

Here, the procedure for “pasting” an object, that has been Copied (or Cut) to
the Clipboard™, is explained.

B Pasting an Object

PROCEDURE REMARKS
(DFirst, Copy (or Cut) an object. AT 2.4.5 Copy

(2)Select the [Edit] menu - [Paste] command, or click

on the icon.

Then, the outline of the object copied from the previous | To cancel the paste, click on the |
screen to the Clipboard will appear.

icon.

(3)Position the cursor and click on the point where the
object is to be Pasted.
The object stored in the Clipboard will be Pasted to the

new location.
When an object is copied from an-

other screen, it will be automati-
cally placed at the same coordinates
as its original ones. To place the
object at different coordinates,
move it after this automatic place-
ment.

*] An area where text, graphics, or both, that have been Cut or Copied, are temporarily
stored. The contents of the Clipboard can be “pasted” (copied from the Clipboard)
using the Paste function. However, once the Copy/Cut command is executed, the data
stored in the Clipboard is replaced; therefore, only the data from the most recent Copy/
Cut command can be Pasted.

GP-PRO/PB III for Windows Ver. 5.0 Operation Manual 2-157



2.4 Object Editing Chapter 2 - Base Screens

@ Duplicate ]

This command allows you to easily make multiple copies of any object. The
address of the copies can be set up so as to increment automatically from
copy to copy, or simply reuse the address of the original object.

B Duplicate Setting Dialog Box

When this command is used, the Duplicate dialog box for entering the copy
specifications, will appear as shown below.

Enter the When copying Parts or Tags
number of that require addresses, click-
copies in the ing here will automatically
XandY assign new, incremented
directions addresses for each copy
The device comment corre-

Enter the @ng;s,?jfnm sponding to an address
line spacing, £ irecion assigned by the automatic
in dot units storeer [T || Ao ] address increment is reflected

I\J oo Device Comment in the Description field.

“Alias addresses are not incremented.

€ Number of Copies

Here, how many times an object will be copied in the X and Y directions is
entered. When “1” is entered for either direction, copying will not be
performed in that direction.

The number of copies is also limited by the copied object’s location, size,
the Duplicate dialog box’s Spacing settings, and any other related settings.

@ Spacing

Enter the spacing interval of dot (screen pixel) units to be used when the
object is copied for both the Horizontal and Vertical directions.

& Address Increment

To copy multiple tags and parts, specify the direction of the automatic
address increment. According to the automatic address increment, consecu-
tive Addresses will be assigned in the designated direction. When the
original object’s Address is a Bit Address, the automatic address increment
is performed in the unit of bit, and when it is a Word Address, the automatic
address increment is performed in the unit of word.

If the automatic address increment is not used, tags and parts will be copied
using the same address as their original ones.

E.g.) When duplicating with the settings shown below:

Duplicate

Humbe of Copye———)

7] Caimng E%
7] Rows E}%

Hoizontal[JE_ = Filsl
vetical g J ekl
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ﬁg\te:
X2l

2.4 Object Editing

When Duplicating an object, its positioning will be decided based on the top
left handle of the copied (master) object. However, if a Bar Graph’s handles

are located in a graph display area, the object will be placed based on the
graph display area, not the graph’s border. Therefore, when setting the
spacing, be sure to not overlap any of the graphs’ borders.

@ Reflection of Device Comments

When the [Apply Device Comment] check box is marked with a check, the
device comment corresponding to an address assigned by the automatic
address increment will be reflected in the Description Field. For tags desig-
nating multiple Addresses and Parts, however, the device comment corre-
sponding to an Address designated as the Reflected Description Address is
reflected. The Reflected Description Addresses for different tags and parts
are shown in the table below:

<Reflected Description Address Table>

Object name Automatic input Object name Automatic input Object name Automatic input

address address address

A-tag Monitor w ord P-tag Word address Word Switch Word address
address
a-tag Monitor w ord Q-tag Function Switch
address
C-tag R-tag Toggle Switch Operation bit address
D-tag Word address S-tag Word address Lamp Bit address
d-tag Word address T-tag (bit) Bit address 4-state Lamp Lamp Address 1
Etag Word address T-tag (word) Word address Bar Graph Word address
F-tag Word address T-tag (special) Pie Graph Word address
G-tag Word address t-tag Bit address1 Half-pie Graph Word address
g-tag Word address Tih-tag Tank Graph Word address
Htag Start bit address Tiw-tag Meter Graph Word address
J-tag Word address U-tag Word address Trend Graph Channel 0 word
address
K-tag Word address U-tag (high-speed) |Bit address Keyboard
k-tag v-tag Keypad Input Word address
Display
L-tag Start bit address W-tag (bit) Bit address Alarm Word address
(direct/indirect)
L-tag (without Word address W-tag (word) Word address File Name Display
indirect start bit)
L-tag (state) Word address W-tag (special) Start bit address Data Logging Block number
Display designated address
1-tag Word address X-tag (bit) Bit address Numeric Display |Word address
M-tag Start bit address X-tag (word) Textscreenword |Message Display |Address
address
M-tag (without Word address Trend channel Word address Date Display
start bit)
N-tag Word address Data sampling Sanpling address Time Display
n-tag Bit Switch Operation bit address|Graphic Display Address
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B Duplicating

Chapter 2 - Base Screens

PROCEDURE

REMARKS

<When Duplicating a Switch 5 times in both
the X and Y directions>

(1)Select the desired object.

(2)Select the pull down [Edit] menu’s [Duplicate] com-
mand.

(3)Enter the number of copies to make in the X and Y
directions, spacing between copies.
If desired, click on the Address Increment check box, to
increment addresses automatically.

Duplicate |
=Mumber of Copy
L s Enter 5
Cancel
P e =]
——
Enter 5
-5 pacing—————————
HmizﬂntalE}% [Firels]
Weilical [Pirels]
E “Address Increment
1% W Direction
12V -Direction
I =
¥ Apply Device Comment
*flias addresses are not incremented.

(4)Click on the button to duplicate the object.

When duplicating an object, posi-
tioning will be decided based on the
top left handle of the copied (mas-
ter) object.

To cancel the duplication, click on

the icon.

To stop duplicating, press the
key.
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2.4 Object Editing

@ Delete

)

Here, the procedure for deleting an object is explained.

B Deleting an Object

PROCEDURE

REMARKS

(1)Select an object.

1

(2)Select the pull down [Edit] menu’s [Delete] command.

Instead of selecting the [Delete]
command, the computer
keyboard’s key can also be
used.

To cancel the deletion, click on

the

71| icon.
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@ Align ]

Here, the procedure for aligning and centering object(s) are explained.

B Alignment Dialog Box

Alignment
Resets the X axis
Shows the [SFF——] .
current align- |:| — settings
ment settings — — Aligns above the
A X axis
O — Aligns on the X
axis
Resets the Y - — 1 |~ Aligns below the
axis settings IE Aln X axis
/
Aligns to the left Aligns on the Y Aligns to the right
of the Y axis axis of the Y axis
B Aligning Object Positions
PROCEDURE REMARKS
(1)Select all ihe desired objects to be aligned. OO 2.4.1 Selecting

_________ _.
Objects

(2)Select the [Edit] menu - [Align] command, or click

on the icon.

(3)Select the type of alignment from the Alignment dia- | While an individual label can be
log box. aligned, groups of labels cannot.
In this example, select the icon (X-axis: Bottom) | (Click on an object to select its

handles and then click on its Label

and do not select any vertical (Y-axis) position.
to select the Label’s handles.) Text

el characters on both Numeric or other
[ o types of Displays can be aligned in
the same manner.
kO To align objects, combine the se-
lections shown below:
- len Horizontal position: Up, Center,
Bottom
(4)Click on the button to align the objects. Vertical position: Left, Center,
i ff’_a___g_Ef‘i H_E_:i_f___g_[_:fl_'_l ﬁ_éi_i_ﬁ__ﬁ_f_:ﬂ_':i!; To cancel the alignment’ click on
e By =

the E icon.
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m Rotate Left/ Rotate Right ]

With this command, an object can be rotated in 90° increments. However,
loaded Screens and Marks, some Tags, and grouped objects cannot be
rotated.

B Rotating an Object Counterclockwise (Left)

PROCEDURE REMARKS
(1)Select an object. ST 2.4.1 Selecting

Center Objects
The center point of the object is

) where two lines, connecting the
(2)Select the [Ed_lt] menu - [Rotate Left] command, or opposite handles (other than the

click on the icon. corner handles), cross.

The object will be rotated counterclockwise 90 degrees, . Center
relative to its center point; if necessary, repeat the com- ! point
mand. LT

|
90° Rotation To cancel the rotation, click on the

‘\ icon. (Clicking on the || icon

one time reverses one 90 degree ro-
tation.)

If an object is moved outside the
drawing area by rotating, the object
will not be displayed on the GP
screen.
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B Rotating an Object Clockwise (Right)

PROCEDURE REMARKS
(1)Select a desired object. ST 2.4.1 Selecting
Objects

Centar ) ) )
The center point of the object is

where two lines, connecting the
(2)Select the [Edit] menu - [Rotate Right] command, or | opposite handles (other than the

click on the icon. corner handles), cross.

The object will be rotated clockwise 90 degrees, relative : Ce_ntter
to its center point. If necessary, repeat the command. T PO

To cancel the rotation, click on the

icon. (Clicking on the [«] icon
once reverses one 90 degree rota-
tion.)

If an object is moved outside the
drawing area by rotating, the object
will not be displayed on the GP
screen.
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2.4 Object Editing

m Mirror X/ Mirror Y

)

An object can be moved symmetrically around its center line with respect to
the X or Y axis. The display position of Tags, Parts, Text, Load Screens, and
Load Marks can only be moved symmetrically.

B Moving Symmetrically along the X-axis

PROCEDURE

REMARKS

(1)Select an object.

/ Center

(2)Select the [Edit] menu - [Mirror X-axis|] command,
or click on the E icon.
The object will move symmetrically with respect to the

X-axis.

SOOI 2.4.1 Selecting
Objects

The center point of the object is
where two lines , connecting the
opposite handles (other than the
corner handles), cross.

Center Point/Line

A

| |
If an object is moved outside of the
drawing area by using the Mirror
X function, the part of the object

outside the drawing area will not
be displayed on the GP screen.

To cancel the change, click on the

icon.
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B Moving Symmetrically along the Y-axis

PROCEDURE REMARKS
(1)Select an object. BTN 2.4.1 Selecting
| Objects
———— Center The center point of the object is
<:| where two lines, connecting the
opposite handles (other than the

| corner handles), cross.

Center Point/Line
(2)Select the [Edit] menu - [Mirror Y-axis|] command,

or click on the @ ] icon.
The object will moves symmetrically around the Y axis.

If an object is moved outside of the
drawing area by using the Mirror
| Y function, the overflowing part of

the object will not be displayed on
the GP screen.

To cancel the change, click on the

icon.
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m Group/ Ungroup ]

This function can be used to “group” multiple objects, enabling you to
manipulate the “group” as a single object, even after changing screens or
using a different editing function.

B Grouping Objects

PROCEDURE REMARKS
(1)Select the objects to be Grouped. DY Reference G NW| Selecting
Objects

(2)Select the [Edit] menu - [Group] command, or click | To cancel the Grouping, click on the

on the icon. icon.

%{e; * When a Part is included in a group, its handles appear as[ ], so that the
2 individual Part cannot be scaled up/down independent of the group. Thus,
you must first ungroup the objects in order to scale any individual object.

+ When a Part is included in a group, double click on the group to bring up
the Confirm Device Address dialog box, where address changes can be
made.

2.4.14 Changing Attributes
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B Ungrouping Objects

This function changes a Group of objects to a selection of multiple objects.

PROCEDURE REMARKS
(1)Select a group of objects. ST 2.4.1 Selecting
Objects

To select a group including tags,
place a check mark in the Tag check
box in the Select Tool Box.

(2)Select the [Edit] menu - [Ungroup] command, or click | To cancel the ungrouping, click on

on the IE icon.

the icon.
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m Bring to Front/ Send to Back ]

When graphics and Parts overlap each other, you can change the order of the
layers with these two commands.

B Changing the Order of Overlapping Objects

PROCEDURE REMARKS

In this example, you will move the oval, partially hidden 2.4.1 Selecting
by the rectangle, to the front. Objects

[Bringing an Object Forward]
(1)Use the cursor to select the filled oval.

(2)Select the [Edit] menu - [Bring to Front] command, | To cancel the movement, click on

or click on the icon. the icon.

[Sending an Object Behind]

(1)Use the cursor to select the black rectangle. SEOTTIK 2.4.1 Selecting
Objects

(2)Select the [Edit] menu - [Send to Back] command, or | To cancel the movement, click on

click on the icon. the icon.
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m Changing Attributes ]

Here, you can change any of an object’s attributes, i.e. its color, address, etc.
Also, with objects of the same type, you can change the same attribute of all
the objects of that type at the same time.

B Changing Attributes

PROCEDURE REMARKS
(1)First, select an object, to change its’ attributes. 2.4.1 Selecting

In this case, an unfilled rectangle drawn with a solid line. .
Objects

While the attributes of Grouped ob-
jects generally, cannot be changed,

(2)Select the [Edit] menu - [Change Attribute] command, | the same type objects can be

. . hanged at the same time. When
or click on the [gH]icon. ¢
Grouped Parts have been selected,

only their addresses can be
(3)Select a new attribute from the dialog box. Y

. changed.
Here, a dotted line is selected.
— TN 2.4.14 W Chang-
|:| gmu ing Attributes; Confirming Ad-
38 comlE | [ Coronl | dresses
EEEEE
[;i Eam mm e Instead of clicking on the [gF|icon,

simply double-click on the object

(4)Click on the button to register your change. | When selecti'ng it, to display the At‘
tribute Settings dialog box ( skip

T step {2}).

38 wonee B [ Cancel | To cancel the attribute changes,
H o click on the button in the
fo EEEEN O &0 dialog box.

Ba ) ) Bk

g Even after clicking on the

[ o], you can reverse the at-

tributes changes (only for the most
recent change) by clicking on the

|EJ icon.

%f €. You can select more than one object of the same type and change the at-
tributes of each, at the same time. With all the desired objects selected, click

on the Tool box’s button; then, proceed with step (2).

SEOOTTETIK 2.4.1 B Selecting Objects; How to Select Multiple Objects;
Selecting Objects by Type from a Multiple Selection
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B Confirming Addresses

2.4 Object Editing

If a Part that requires an address has been grouped, the Confirm Device
Address dialog box shown below will appear whenever its attributes are
changed; the Part addresses are changed here.

Allows you to view either the Bit or Word Addresses of
all the Parts in the currently selected group of objects

Confirm Device Address

 Bit Address

Part Addresses are —_|| _
displayed here ddiess

“Function

"Parts Name

“Part 1D

" Description

<D0

|Bit Se0peration Bit)

Bit Switch

B5_001

xoo42

Bit Set{0peration Bit)

Bit Switch

B5_002

Check this box to
automatically
change all the

addresses of the
Parts in this group

that have the same
Device Address

@ Bit and Word Addresses

Each Part’s address is displayed. To change an address, click on the inside
of each cell. As shown above, any Switches selected that have state changes
will have both their Operation Bit and their Monitor Bit addresses displayed.

@ Address Range Conversion

When an address is changed and this check box is checked, any other Part

with the same device address will be automatically changed.

In the example above, if the first bit address is changed from X00000 to
X00010, the following bit addresses will be changed as below.

Confirm Device Address
" Bit Adldress |
. s " Function "Parts Name “Part D "Description
Clicking on any | ARBO000____| Bit SetiOperation Bi)[ Bt Switch BS_001
cell other than the — | |04z Bit S et{Operation Bitl] Bit Switch BS5_002
changed one will
show the changed
address
0K I | Cancel | | Help
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m Changing Coordinates

)

Object positions and sizes can be changed by specifying their coordinates.

Check this check\

box to change
the size.

Change Position |
) Ehange size
Left-Tap

Right-Bottom

(XAxis i I veds [0 E]:J\

GMS 132 3: Vs (BT a': )—_

Enter the object’s
left top coordi-
nates.

"~ Enter the object’s

right bottom coordi-
nates.

B Using Coordinates to Change an Object’s Position

PROCEDURE

REMARKS

(1)Select a desired object.

%

(2)Select the [Edit] menu - [Change Coordinates] com-

mand.

(3)Enter the object’s left top and right bottom coordi-

nates.

Change Position |
IliChange size
Left-Top

Right-Bottom

(4)Click on the button to execute the command.

&

SEBOOTIETK 2.4.1 Selecting
Objects

To change the size, check the
Change size check box in step (3).

To cancel the coordinates change,

click on the button.

To undo the coordinates change,
click on the icon.
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m Editing the Node of a Multi-segment Line ]

Creating, Editing, or deleting a node can be performed on a multi-segment
line and a filled polygon.

JMode Edit

The [Node Edit] dialog
displays.

Deletes the selected peak.
i

— | Adds a node. The added

| node is the same as the

selected node. If the screen
capacity is exceeded by the
added value, the [Insert in
Front] and [Insert in Back]
buttons are highlighted and
| Cencel || | cannot be specified.

If the node edit is selected, the selected point
in the displayed dialog is marked with a
Cross.

B Editing a Node on a Continuous Line

PROCEDURE REMARKS

(1)Select the desired continuous line. 2.4.1 Selecting an

(2)Select [Node Edit(K)] from [Edit(E)]. Object

(3)Select the coordinate value that you want to edit.

(4)Click on the  Edt | button.

(S)Enter the X/Y coordinate values in the coordinate
change dialogs.

Mode Edit

‘

Cancel

(6)Click on the button to run the coordinate | To cancel the coordinate change,

change. Click on the button.
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m Convert (Import) Bit map ]

This section describes how to convert image data (bit map = BMP file),
created using other drawing software or imported using a scanner, for use on
a GP Image (I) screen (bit map conversion), which can then be placed on the
Base, Trend Graph, and Keyboard screens.

SEBOTHEIK For Bit Map Conversion data, refer to 3.5 Creating Image
Data - Image

B Converting and Placing a Bitmap

PROCEDURE REMARKS

(1) Select the pull down [Edit] menu’s [Convert Bitmap] [ Once a bit map has been converted
command. to an image, place the image on a
screen using the Load Screen func-

(2)Set all conversion settings and click on the tion.
button. OO 2.2.11 Load

Import Bitmap | Screen

Source | Effects Desl\nal\unl FOI' each Settll’lg 1tem,
Bitmap File
27024 bmp | [Bronse..] W Reference JEM] Creating Im-
= Source Bitmay

s age Data - Image

Size (bytes)

I — Before conversion, the image dis-
played in the Import Bitmap dialog

box is still compressed and may

appear different from the actual dis-

play (after conversion).

To cancel bit map conversion, sim-

ply click on the button.
(3)Click on the [ _s== | button.

The bit map is then saved as an Image screen.

ey [ ]
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PROCEDURE REMARKS
(4)Click on the button.

The Image screen’s border will appear on the current
screen.

T

(5)Click on the point where the Image screen is to be | To cancel the placement, click on

placed. the icon.
The Image screen will appear on your screen.

%t €. 1If the Image screen is placed outside the drawing area vertically, the portion
of the image that does not fit in the drawing area will not be displayed on the
GP screen. However, if the Image screen is placed outside the drawing area
horizontally, the portion that does not fit will be squeezed so that it is dis-
played on the GP screen.

E.g) On your PC's screen On the GP panel

Screen /

display

area \

B Pasting Other Software’s Bitmap Data

When another drawing software’s bitmap image is copied and the [Paste]
command is executed with the Screen Editor, the Paste bitmap dialog box
like the bitmap conversion one will automatically appear. In that case, start
from step (2) in the same way. However, since a Bitmap File name does not
need to be selected, the [Bitmap Conversion] tab will not be displayed. This
operation can be performed only for BMP file data. When using another file

format, be sure to use that software’s BMP file format save option to create
a BMP file.
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m Transferring a Screen to the Clipboard ]

The current screen is transferred as an image to the clipboard™. The trans-
ferred screen can be utilized by pasting it to other drawing software. The
screen types that can be transferred to the clipboard are the Base (B) screen,
Mark (M) screen, Trend Graph (T) screen, and Keypad (K) screen.

B Transferring a Screen to the Clipboard

PROCEDURE REMARKS

(1)Select the [Screen to clipboard] command from the
[Edit] menu.

The current screen will be transferred to the clipboard.

(2) Paste the screen to other drawing software.

|

I T T
o [

|F0r Help, click Help Topics on the Help M”ﬁfi@ "‘/);

*] The clipboard is a storage location where copied or cut data is temporarily stored. The
data stored on the clipboard can be copied or moved by pasting it.
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m Converting a Screen to a Bitmap File ]

The current screen is converted into a bitmap file, and then saved. The
screen types that can be converted are the Base (B) screen, Mark (M) screen,
Trend Graph (T) screen, and Keyboard (K) screen.

Usage Pattern

. Specify how to
. [Screen to [Setting the bit
[Bditl = pitmapfile] —  bitmapfile] > o oo

[Screen to [Setting

— [Edit] bitmap file] —  bitmap file]

B Designating a Bitmap’s File Name

Before converting the screen to a bitmap file, specify how to save the bitmap

file.
Specify a file Setting bitmap file name
name and output ~
destination to \‘@J Prompt for filename when saving
save the file. //Q:l Automnatically create file name |_ Specify how a
Automatically %Mﬁmw% o Ele narr;e(;s to
creates a file ) Tope Humber S5P e creae
name to save the ) Tope + Humber + Comment BWP automatically.
file. Dyt Pl

/ [D:APROPEDATABASE I| | Etoge ]

Specify an output -
destination of the | e B
file when a file

name is being
created automati-
cally.

@ Prompt for filename when saving

When the [Screen to bitmap file] command is executed, the Save As dialog
box will appear, where you can specify the location and name of the file to
be saved.

€ Automatically create file name

When the [Screen to bitmap file] command is executed, a file name will be
created automatically, and the file saved in a previously specified location.

Example: If the No. 1 screen of the Base (B) screen named “Menu” is
converted into a bitmap file:

Screen type + number.BMP —> B1.BMP
Screen type + number + screen title. BMP —> B1 Menu.BMP
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PROCEDURE

REMARKS

(1)Select the [Setting bitmap file] option for the [Screen
to bitmap file] command from the [Edit] menu.

(2) Select a method for saving the bitmap file, and es-

tablish it by clicking on the button.

Setting bitmap file name

153 Prompt for filename when saving
12 Automatically create fils name
Flles e tmes
1% Tepes Humber BRAP
13 Topes Hymber+ Eommen . BiP
Dintpt: Falbep
|D\PROPBDATABASE [

@[ o~ |[ Bor |

(3) Select the [Screen to bitmap file] option for the [Screen
to bitmap file] command from the [Edit] menu.
When a file name is created automatically, the bitmap
file is saved now.

(4) If [Prompt for filename when saving| was selected in
step (2), specify a file name and output destination,

and then click on the button.

Save As T]|
Save i I@ database E| % B
zmall.brmp
rmap.bmp
File name: I|test.bmp || Save
Save as type: IB|tmap file[* bp) |JZ” || Cancel
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2.4 Object Editing

m Redraw Screen

)

This command updates the current drawing area display to reflect the latest
drawing data. When the Auto Redraw feature is not used, filling and editing
objects can cause after-images to remain on the screen. Use this function to
remove these images and show the screen as it will appear on the actual GP

display.

B Redrawing a Screen

PROCEDURE

REMARKS

Sometimes, when removing an object’s filled color, only
the fill point area’s color will be removed, resulting in a
small, non-colored square.

Point —_| /
where fill E:>

began

Fill point is deleted

(1)Select the [Edit] menu - [Redraw] command, or click

on the icon.

The screen will automatically be refreshed and all the
fill color will be removed.
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m Undo ]

With this function, an operation can be “undone” and the screen display

returned to the previous condition. Every time the icon is clicked on,
depending on memory, previous operations will be undone, in succession.

m The Redraw Screen function cannot be undone.

Important

B Canceling an Action

PROCEDURE REMARKS

In this example, a circle has been accidentally deleted.
(1)Select the [Edit] menu - [Undo] command, or click | To cancel the Undo operation,

on the E icon. click on the [[cu | icon.

The circle will reappear and the screen is displayed as it 2.4.21 Redo
was prior to the deletion.

m Redo ]

With this function, an operation previously undone with the Undo command
can be “redone”, if performed immediately after the Undo command is used.

B Redoing the Previous Undo Command

PROCEDURE REMARKS

In this example, the undone circle deletion will be re-
done (i.e. deleted again).

(1)Select the [Edit] menu - [Undo] command, or click

on the icon.

The circle will reappear.

(2)Select the [Edit] menu - [Redo] command, or click on To cancel the Redo operation, click

the icon. on the icon.

The circle will disappear.
AN 2.4.20 Undo
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E Libraries

The objects you created can be registered. These registered objects are
called “Libraries”. You can call up and use the registered Libraries, when-
ever necessary. Like a pre-made Part Shape, the objects registered in these
libraries can be viewed and selected using the Browser function.

Multiple objects can be combined and registered, and Marks created on
Mark screens can also be registered.

3.1 Creating a Mark - the Mark Screen
These items are stored in a Library file (CPW file), separate from Project
(PRW) files . When library data is a Mark, it will be saved in a Mark Li-
brary (MRK) file. Moving from one Library file to the other allows objects
to be called up that were previously used in a variety of screens and Project
files.

To call up an item from a Library, or save an item to a Library, either select

one of the tool bar’s icons @E or use the pull down menu’s [Library]
commands.

* With both Base and Mark screens open, when the Base screen where the

Library Browser is remained open is changed to the Mark screen, the Mark
Library Browser cannot be open on the Mark screen. When changing the
screen, first close the Library Browser and change the screen, and then open
the Library Browser on the newly opened screen.

Objects called up via the [Load Screen] or [Load Mark] command, as well as
D-script cannot be registered.

W Library Browser

When either or icon is clicked on, the Library Browser will appear.

Displays the currently selected item’s registration number and title;
clicking on the triangle brings up a list of the items in the current

library
Menu Bar
Tool Bar
Reverse video Scroll
indicates that h°"° sh
this item is thrO:_?f
currently se- the differ-
lected |3: Rotary SW word ent items,
either left,
Displays the right, up,
item’s registra- or down
tion number
and title 4: Rotary SW bit3 |||5: Rotary SW word| | 6: Rotary SW bitd
Status Bar V\ewingAIIDbiects ﬁ
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B Editing Library Items

Three Library Item editing functions are available.

EE’,J Cuts a Library item (which is then moved to the Clipboard); the
Library item can then be moved to another screen using the [Paste]
function.

Copies the selected Library item to the Clipboard.

E Pastes the Library item Cut or Copied, and temporarily stored in the
Clipboard, to another screen. The Library item can also be Pasted to
another Library file.

You can remove a Library item using the Delete function. To do so, select
the [Delete] command from the Library dialog box’s pull down [Edit]
menu.

SEOETIK 2.5.3 Editing Library Items

B Changing the Library’s Display

The Library’s image display size and type can be changed. Also, you can
change from one Library file to another.

@ Library Size
When either the , [k, or @ icon is clicked on, or the pull down

[View] menu’s either [Normal], [Adjust to Fit], or [Full Screen] command is
selected, and the Library display size can be changed. When Normal is
selected, each Library size will be displayed relatively, allowing you to
check the relationship between Libraries for their size. When the Adjust to
Fit function is selected, the Library item will be enlarged until it fits inside
the Library window’s borders. When Full Screen is selected, the Library
item will be displayed in its actual (GP) screen size.

@ Library Type

When the pull down [View] menu’s [All Objects], [Part & Tag Objects], or
[Graphic Objects] is selected, the Library type(s) shown on the Browser can
be selected.

[All Objects] Displays all the Library items in the selected Library
file.

[Part & Tag Objects] Displays only those items that are either Parts or
Tags.

[Graphic Objects] Displays only those items which are neither Parts nor
Tags (i.e. drawn objects).
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B Switching Library Files

@ Creating a New Library File
When the icon is clicked on, or the pull down [File] menu’s [New]

command is selected, the Dialog box shown below will appear. When a

Description is input and the button is clicked on, a new Library
file will appear.

Description :

o

=N

@ Selecting (Calling Up) another Library File

When the icon is clicked on, or the pull down [File] menu’s [Select

File] command is selected, the Library file list will appear. By selecting
(dragging) the desired Library file from this list, other Library files can be

called up.

Shows the
currently
displayed file’s
folder

Lists all the
files in the
currently
selected folder

Moves up one file Creates a new
level folder

2.5 Libraries

Lists the files in
summary format

I~ Look jn: | &7 cpw

- Lists file
information

;;.,.-.,. Opd-objc.cpw
Opd-objd.cpw
Opd-obje.cpw
Opd-obif.cpw
Opd-obja.cpw Opd-objg.cpw
Opd-objb.cpw Opd-objh.cpw

wig, cpw

in detail

Flepame:  [Dpib]

=]

Filers: of tupe: |W’indows Library Files [ cpw)

Dieseription : J,D ata Input equipment

| Carcel

Displays the currently selected
file’s Description data (if any)

Currently selected
file’s name (If
desired, can be

Currently selected file’s

entered)
format (type)

Two types of Library files are available; the Library files created using the
GP-PRO/PBIII (DOS Version) (DOS Library file: *. CPL), and the Library
files created using GP-PRO/PBIII (Windows® Version) (Windows Library
file: *. CPW and *.MRK). Select either one.

Files created using Parts Box (*. CPL) can be converted into GP-PRO/PBIII
for Windows format (*. CPW).

SO 12.1 File Converter
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B Modifying Library File Names (Titles)

Library filenames can also be changed. Simply select a library from the file
list, then select [Property] from the [Edit] menu, and the Property screen
will appear. Type in the filename (title) that you wish to use and click on
OK.

Drescription : ok,

|38tate S word || || Cancel |

B Displaying the Browser at the Top of the Normal Screen

If the [Always on Top] option is selected from the [Window] menu, when-
ever the Library Browser is called up, it will be placed at the top of the
current window. If this option is not selected, selecting another screen will
place that screen over the Library screen, hiding it from view.
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@ Registering Library Items

2.5 Libraries

)

Here, the procedure for registering a Library is explained.

PROCEDURE

REMARKS

(1)Select objects to be registered as Library items.

(2)Select the [Library] menu - [Register Library] com-
mand, or click on the @ icon.

<A. When registering a new Library item to
the currently open Library file:>

(3)Enter the Library’s registration number and descrip-

tion.

In the Cell Number area, the smallest of the currently
open Library file’s unused numbers will be automati-
cally displayed. To change it, simply enter the desired

number.

Save Library

Cell Mumber :

]

D escription :

<]

[

|switch

(4)Click on the button to register the number.
The registered Library will then be displayed in the

Browser.

& [100: switch

F]

e |||47: Volume SW se

t1]||50: Numeric Input |

|48: Volume SW cir

: switch

2.4.1 W Selecting
Objects; Registering Library Items

If the Library Browser is already
showing, click on either or

icon in the screen editor

drawing area, and the icon in

the Library Browser, which will
perform the function of step (2).

The following procedures will
differ depending on the Library
file registered.

* When registering a new Library
item to the currently open
Library file:

* When no Library file is dis-
played:

* When registering a Library item
to a new Library file:

* When registering a Library item
to a Library file other than the
currently open one:

Up to 200 Library items can be
registered in one file.
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PROCEDURE

REMARKS

<B. When no Library file is displayed:>

(3)The “New” dialog box will appear.
]

Description :

When registering a Library item to a new Library file.
<C. When registering a Library to a new Library file>’s

step (5)
When registering a Library item to an existing Library file:

Click on the button.

<D. When registering a Library item to a Library file
other than the currently open one>’s step (4)

<C. When registering a Library item to a new
Library file:>

(3) Click on the button.

Save Library |

o ]
=N

Cell Nurnber :

Description :

‘Untitled ||

(4)Via the Library Browser, select the [File] menu - [New]
command, or click on the icon.

(5)Enter a comment and click on the button.

Drescription :

|production ||

(6)Via the Screen Editor, select the [Library] menu -
[Register Library] command, or click on the @ icon.

Enter the file name when the
Library file is saved.

2.5.4 Saving Li-
braries and Quitting B Saving a
Library File Under Another Name

A comment of up to 60 characters
can be entered.

Enter a description up to 60 char-
acters.

Enter the file name when the Li-
brary file is saved.

2.5.4 Saving Li-

braries and Quitting B Saving a
Library File Under Another Name
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PROCEDURE REMARKS

(7)Enter a Cell Number and Description.

Save Library |

E_IB" MHumber :
] =

Dezcription :
|sw1 "
(8) Click on the button. A maximum of 200 Library items
The newly registered Library item will appear in the | €30 be registered in each Library
Browser. file.

(il [?.cpw : production]
File Edt “iew ‘window Help

= _ if you attempt to create or select
] :
2| [¥[=el [} another Library file without first

saving the item via the [Save
As...] function, a prompt will
appear, asking whether the newly
created Library item should be
prYSE—— saved or not.

For the proce-

dures for saving a Library item, re-
fer to 2.5.4 Saving Libraries and
Quitting

After creating a new Library item,

<D. When registering a Library item to a
Library file other than the currently open one.

(3)Click on the button.

Save Library <]

C;II Murnber ;
Description : @W

|Untitled ||

(4)Via the Library Browser, select the [File] menu - [Se-
lect File] command, or click on the icon.
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PROCEDURE

REMARKS

(5)Select the desired Library file from the list, or input
the Library file name in the file name area.

Select

Lok jre |@ cpw El ':‘f%“f’

L2 b1_‘Eﬂ;~1 d-objc.cpi ViEt. cpw

Opd-ib2.cpw Opd-objd.cpw

Op#ib3.cpw Opd-obie. cpw ||

Optibdopn  [=] Opd-cbi.cpe — Select “Op4-
Opd-obia.cpw Opd-obig.cpw . »
Opd-objb.cpw Opd-obih.cpw I 1 b1 .CpW .

File pame:  [Dpdibt ] [ e |

El | Cancel

Files of type:  [windows Librany Files ['.cpw]

Deseription:  [Diata Input equipment

(6)Click on the button to display the selected
Library file.

(sl [Dp4-lib1.cpw : Data Input equipment]
File Edit “iew ‘Window Help

[Ol=] [2[le [ = F

(7)Via the Screen Editor, select the [Library] menu -

[Register Library|] command, or click on the E’ icon
on the Draw Tool Bar.

(8)Input a Cell Number and Description.
In the Cell Number area, the smallest of the currently
open Library file’s unused numbers will be automati-
cally displayed. To change it, enter the desired number.

Save Library |
Cell Wurnber :
=
Description ;
|switch "

2.5 Libraries &
Switching Library Files

When selecting a Library file in an-
other directory, use the [Look in:]
window.

In step (5), simply move the cursor
to the desired Library file name and
double-click on it to open it. By
doing so, the (Step 6) but-

ton does not need to be used.
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PROCEDURE REMARKS

(9)Click on the button to register the item. Up to 200 libraries can be regis-
The registered Library item will appear in the Browser. | tered in one file.

pmertt ____|
2] [100: switch I

t1]||50: Numeric Input |

B Using the Cut, Copy, and Paste Functions

Library items can be Cut, Copied and Pasted from the screen drawing area
to Browser. First, select the desired Library item in the drawing area, and
then either Cut or Copy it; then, Paste it to the current Library Browser.
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@ Placing Library Items

)

Here, items registered in a Library file are placed on a drawing area.

PROCEDURE

REMARKS

(1)Via the Screen Editor, select the [Library] menu -

[Call Up Library] command, or click on the icon
on the Draw Tool Bar.

(2)Select a Library Item to be read out from the Browser.

w0 [Op4-obig.cpw : Unusged Plain Keypad Parts]
File Edit Yiew Window Help

(3)Drag the Library item to the desired position in the
drawing area.
The Library item can be placed on any open screens,
and will be displayed in the drawing area. If desired use
the sizing handles to alter the item’s size.

Fails Gpegial Libap MWindow Help

oy Off State v

arts  Special Libray  Window Help

RN
Off State [~

Library items Cut, Copied, or
Pasted between the screen and the
Browser. Simply select the desired
Library item and perform the com-
mand.

When calling up an item from a file
different than the currently dis-

played file, click on the E icon to
bring up a file list.

2.5 Libraries
B Switching Library files

The Library item’s top left corner
is the placement point.

To cancel the placement, click on
the screen editor’s icon.

To change a Li-

brary item’s size, refer to 2.4.3
Scaling Up/Down

Items called up are automatically
grouped. They can be freely edited
after ungrouping them by clicking

on the icon.

2.4.12 Group/
Ungroup

Grouped library items containing
Parts cannot be scaled up or down.
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When a Library that contains Parts is called up, the Confirm Device Address
screen will appear. After entering each Part’s address, click on the

button. To cancel these settings, click on the button.
2.4.14 Changing Attributes, B Address Confirmation

When the Library placed on the screen is double-clicked on, the Confirm
Device Address dialog box shown below will appear, allowing you to
change the Part’s previously entered addresses.

Confirm Device Address |
Bit Address |
[ Addrezs [ Furiction [ Partz Name [Part 1D [ Description
P00 0 | Bit Set [C) Bit Switch BS_012
x00042 Bit Set [C] Bit Switch BS_013
Q] Addrezs Range Conversion
|| QK. | || Cancel | || Help |

) |\ ~ After a Tag is registered in a Library, if multiple identical librar-

,,,,p:,fa,;, ies are then placed on the screen, their Tag names will be dupli-
cated. After placing them, be sure to change their Tag names
via either their attribute dialog boxes, or the Tag List; especially
if a common start up bit has been created for a K-tag.

SOOI For Changing Attributes, refer to 2.4.14 Changing Attributes
For Tag List, refer to 2.9.6 Tag List

For K-tags, refer to Tag Reference Manual, 2. 11 K-Tag
(Keypad Input)

B Using the Cut, Copy, and Paste Functions

Library items can be Cut, Copied, and Pasted from the screen drawing area
to the Browser. First, select the desired Library item in the drawing area
and Cut or Copy it; then, Paste it to the Library Browser.
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EXE) Eiting Library items ]

Library Items can be edited, Deleted, Copied, Cut, or Pasted.
B Editing a Library Item

Here, a registered Library item is edited.

PROCEDURE REMARKS
(1)Select and double-click the Library item to be edited | In order to call up a Library item
from the Browser. from a Library file which is differ-
T — ent from the currently displayed

2] [1o0: evitch ] file, click on the [[&2] icon.

2.5 Libraries
B Switching Library Files

When double-clicking on a
Library item’s title, the title
editing screen will appear. (Title
Change Screen)

" “ Cancel |

(3)Via the Screen Editor, select the [Screen] menu - [Save] [ ) I‘ {

A
command, or click on the icon on the Main Tool | /mPortant ) ) )
Bar Once an item is edited, it

cannot be Undone.

] [100: switch =]

11]||50: Numeric Input |
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B Deleting a Library Item

Here, a registered Library item is deleted.

PROCEDURE REMARKS
(1)Select the Library item to be deleted from the | In order to call up a Library item
Browser. from a Library file which is differ-
et | ent from the currently displayed

&] [100: switch F[ file, click on the [[&] icon.

2.5 Libraries
B Switching Library Files

t1]||50: Numeric Input |

(2)Select the [Delete] command from the Library
Browser’s [Edit] menu.
A dialog box appears to confirm your command.

Delete |

@ Are you zure you want to delete 7

|| ] 4 ||| Cancel |

(3)Click on the button, and the Library item | /4

will be deleted. Important _
Once an item is deleted, it
e |

cannot be Undone.

\
N

] [100: switch =
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B Cutting a Library Item (from a Library File) and Pasting
Here, a registered Library item is Cut and Pasted.

PROCEDURE REMARKS
(1) Select a Library item to be cut (out) from the Browser. | In order to call up a Library item
prentl from a Library file different than
&) [100: switen Fl the currently displayed Library file,

click on the E icon.

2.5 Libraries
B Switching Library Files

‘e |||47: Volume SW se |[|48: Yolume SW cir

(2)Via the Library Browser, select the [Edit] menu - [Cut]

command, or click on the icon.
The selected Library will be cut.

] [100: switch =]

(3)Open a desired Library file and, via the Library | To register the Library item to a
Browser, select the [Edit] menu - [Paste] command, | new Library file, click on the

or click on the icon. icon.

To register the Library item to a Li-
brary file different from the cur-

, o rently displayed one, click on the
(4)Input the Item’s Cell Number and Description. =] icon.

In the Register Number area, the smallest number in the
currently open Library file’s empty numbers will be au- 2.5 Libraries
tomatically displayed. To change it, input the desired | B Switching Library Files

number.

The following steps are the same as those used for a
Library Item registration.

Save Library

Cell Murnber :
5 ok,
=

|sw‘| ”

Drescription

2-194 GP-PRO/PB III for Windows Ver. 5.0 Operation Manual



Chapter 2 - Base Screens

2.5 Libraries

PROCEDURE

REMARKS

(5)Click on the button to register the Library
Item.

The registered Library will be displayed on the Browser.

100: switch

B Copying a Library Item

Here, a previously registered Library item will be copied.

PROCEDURE

REMARKS

(1)Open the desired Library Item’s Library file and se-
lect the Library item from the Browser.

poentt _____|
I]

] [100: switch

(2)Via the Library Browser, select the [Edit] menu -

[Copy] command, or click on the icon.
The Library item will be copied to the Clipboard.

(3)Open the destination Library file and select the [Edit]
menu - [Paste] command, or click on the Library

Browser’s icon.

DY Reference .4

In order to call up a Library item
from a Library file different than the
currently displayed Library file,

click on the E icon.

SAOOTNETIK 2.5 Libraries
B Switching Library Files

To register the Library item to a new
Library file, click on the icon.
To register the Library item to a Li-
brary file different than the current
one, click on the E icon to call up
a list of Library files.

2.5 Libraries
B Switching Library Files
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PROCEDURE REMARKS

Hereafter, steps are the same as Library Item Registra-
tion.

(4)Input the Item’s Cell Number and Description.
In the Register Number area, the smallest of the currently
open Library file’s unused numbers will be automatically
displayed. To change it, enter the desired number.

Save Library [=]
Cell Mumber :
1
L] =
D escription :
|sw1 ”

(5) Click on the button to register the Item.

The registered Item will appear in the Browser.

|_;_ﬁ| [?.cpw - production]
File Edit Yiew indow Help

100: switch
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2.5 Libraries

@ Saving Libraries and Quitting ]

When a Library file’s contents are changed, the changed data will automati-
cally overwrite the old data and be saved. However, if the Library file has
been newly created, when you attempt to create or select another Library
file, a prompt will appear asking if whether the new file is to be saved or

not. When is clicked on, the [Save As...] Dialog box will appear.
2.5.4 Saving a Library File Under Another Name

W Saving a Library File Under Another Name

Here, the Library File will be saved under a different name.

PROCEDURE

REMARKS

(1)Select the [Save As...] command from the Library

Browser’s [File] menu.

(2)The currently selected Library file name and its com-

ment data, if any, will appear.

Input a new file name and change the desired settings.

Save As
Save | &7 Cow l|i”
] CP4-ib5. oo Opd-objb. cpu pd-ohih cpw
@ Opd-ib1. cpw Opd-objc. cpw
[ Opd-ib2. cpw Opd-abid. cpw
Q Opd-ib3. cpw Opd-ohie. cpw
[ Opd-ibd. cpw Opd-objf.cpw
@ Opd-obja.cpw Opd-objg.cpw
File name: |Dp4-|ib1.cpw || || Save I
Save as bwpe: |Wind0ws Library Files [*.cpw) [E” | Cancel |
Description : |Data Input equipment ||

(3)Click on the button to save the Library.

When a project with the same name already exists, a
prompt asking whether the new name should overwrite

the old name will appear; to do so, click on the
button. When you do not want to overwrite, click on the

button.

CAPoPBEWIn \cpwitest, cpuw
This file already exists.

Replace existing file™

(= =

The file name can be input within
255 characters, including a path and
extension.
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B Quitting the Library Browser

PROCEDURE REMARKS

(1)Select the pull down menu [File]’s [Exit] command. Clicking on the Library Browser’s
If a newly created Library file has not been saved yet, a | top right mark can also be
prompt asking whether the new Library file should be | ysed to quit.

saved, will appear. When the button is clicked,
the “Save As..” dialog box will appear, and when the Saving a Library

button is clicked, the Library file will not be | File Under Another Name

saved and the Library Browser will quit. Then, a Li-
brary file creation or selection screen will appear.

Library Browszer
@J Do wou warnk to zave changes 7
Eres || Mo ][ Cancel
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m Registering Windows

To display a window during the GP’s RUN mode, you must first register it;
the window can be either all or part of a Base screen.

There are two types of window displays, Global and Local, and both are
registered and deleted using the same methods.

SEOTEIK 1.1.5 Using Windows, Tag Reference Manual, 2.26 U-tag
Window Display

) K, U and V-Tags, Trend Graph (T screen and Part), Keypad Input
imporant Display, and Data Logging Display do not function in windows.

Usage Pattern

[Window ﬁ\/lddd"f or
Screen - ; : - odity, or — the
[ ] Registration] Delete key [Esc]

An example of the Popup Window Setting dialog box, used to add, modify,
and delete windows, is shown below.

Adds new win-
" dow registration

Mo, Screen  Size Description l M adify \ data
Lists the —— R | - Modifies window
registration Size

Popup Window Setting

!
B
[x

I
[=%
o

dapudls

Fiegistered Wwindaw List:

Window’s Delete g
. . and/or Descrip-
registration .
. . tion
information
© Close Copies a regis-

tered window

" Heb

Deletes a regis-
tered window

B Registering Windows

Here, an additional window can be registered. When clicking on the

button, the window registration setting dialog box will appear.

Refer to next page: B Registering a Window
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B Deleting Windows

This command deletes a registered window. Use the above dialog box to

select the window to be deleted, then click on the button and a
dialog box will appear to confirm your command. Click on the

button to delete the window; click on the button to cancel the
command.

Delete Window Setting

@ Delete Registration Mumber 17

NIEEE

B Editing Windows
Screens registered as a window can be edited, and their names can be

changed. First, select the window to be changed from the list; then, click on
the button. The coordinates of windows are changed in the same
manner as adding a window. After the window’s coordinates have been
designated, the [Add To List] Dialog box will appear and the title can be
changed. When the button is clicked on, the changed items will
be registered. To cancel the changes, click on the button.

SEBOTTTIK B Registering a Window, steps (3) to (5),
B Copying a Window

If a registered window is copied, the same area (location) of another window
can be registered as a window. Any registration number, screen number
being registered, and title can be changed.

2.6 B Copying a Window Registration

B Registering a Window

Here, part or all of a screen is registered as a window.

PROCEDURE REMARKS

Open the screen to be registered as a window.
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2.6 Registering Windows

PROCEDURE

REMARKS

(1)Select pull down menu [Screen]’s [Window Menul].

(2)Click on the [ 2| button.

Popup Window Setting

Reqistered Windaw List:

Ma. Screen  Size Dezcription

(3)Designate the area that you wish to register by Left-
dragging the cursor to enclose it.

(4)Enter the Registration No. and title, and then click

on the button.

The window will be registered.

Add to List

o

“ Cancel |

Reqistration Na.: ‘
[t ked I

Descrption:

Mo, Screen  Size  Description

— Enter 1

— Enter set key

When you are working on a new
screen that has not been saved, and
you attempt to Add (register) a win-
dow, the [Save As...] dialog box
will appear. First, you must save the
screen, then you can register the
window.

1.7.3 Opening /

Saving Screens B Saving a Screen
Under Another Name, step (2)

2.2.3 Square/

Rectangle B Drawing a Square/
Rectangle

The x coordinates for the window
display can only be set up in 8 dot
intervals, 1.e. the cursor will snap
from one 8 dot unit to another. You
can set up the Y coordinates any-
where you wish.

A = A
Important

The K-tag, U-tag, V-tag,
Trend Graph (T screen or
Part), Keypad Input Display,
Data Logging Display, Date
Display, and Time Display
do not function in a window.

The Description entered can be up
to 30 characters.
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PROCEDURE

REMARKS

(5)Click on the button to finish registration.

When registering another window on the same screen,

do not quit here, rather, start again from step (2).

[-TO7x]
Fegistered Window List:

Mo, Soreen Size

Description
A, Data Eriny Fevpany| |

i B?:Untitled1

ooEEs
anank
Bon

Shows the Window’s
registration data

W

B

Windows can be registered up to
1189 for each Project File.

By changing Size in the Registered
Window List of the Popup Window
Setting, a larger number of regis-
tered items can be displayed.
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B Copying Window Registration Data

2.6 Registering Windows

If a registered window is copied, the same area (location) of another window can be

registered as a window.

PROCEDURE

REMARKS

(1) Select the [Screen] menu - [Window Registration]

command.

(2) Select a window to be copied, and then click on the

Ma. Screen Size Description ) Idmdifiy

Fegistered "Window List: © Add.

(3) Enter the registration number of a new window, the
screen number to which the window is to be copied,

and that screen’s title.

Copy window
Title JSetting Entry Keppad ]

(4) Click on the [}

Popup Window Setting

Fegisterad ‘Window List: ’

Ma. Screen  Size Drescription
1 1 564059 Data Eniry Keypad |

2 12 056=059 Setting Entry K.eppac

" Help

To select multiple windows at a
time, drag through the windows
being selected on the list, or select
those windows by clicking on them

while holding down the[Shift] or
key.

If multiple windows have been se-
lected in step (2), specify the start
window number and screen num-
ber of the destination. The window
numbers and screen numbers will
be assigned relatively so that the
smallest window number among
those of the source windows corre-
sponds to the start window num-
ber.

Copy window
Start window number
B
I=]
Screen Number

1
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B How to Display Windows

The method used for calling up a registered window will differ depending
on whether the window’s type is global or local.

@ Global Window Display
You can use the “Global Window”area in the GP panel’s [Initial Settings]
area to set up the display; or you can use the Global Window dialog box,

located in the GP-PRO/PBIII Project Manager screen’s “Setup” function’s

“Expansion” screen. Click on the “Global Window” button to bring up this
box.

Chapter 6 GP INITIAL AND SYSTEM SETTINGS or in
the GP Series Users Manual’s 5.3.3 Global Window Setup

@ Local Window Display
Here, a U-tag is used on a Base screen to display a window.

Tag Reference Manual’s 2.26 U-tag (Window Display)
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m D-Script/Global D-Script

The GP-PRO/PB III provides a special feature that enables you to create a
program to execute functions, in addition to tags. This feature is given by D-
Scripts/Global D-Scripts. The display load on the PLC can be reduced
significantly by creating and registering a program with D-Scripts/Global D-
Scripts. D-Scripts are used on each screen and serve as programs that are
only effective on that screen. Global D-Scripts serve as programs that are
effective on all the screens.

Using D-Script, you can program separately the trigger used and the action it
performs. Then, when the trigger conditions are satisfied, the script is
performed. The procedures for writing a program with Global D-Scripts are
the same as those for writing a program with D-Scripts.

For more detailed information about D-script and Global D-script, refer to
the Tag Reference Manual.

Tag Reference Manual; 3.1 D-Script/Global D-Script
D-Scripts and Global D-Scripts cannot be registered as Library items.

A

Al » D-script and Global D-script cannot be registered as Libraries.

Important 1o select [Global D-Script], open any Base screen in advance.

Usage Pattern

_ [D-Scrptl Add, Modify, or thE or
[Special] ~—  or[Globa =  Delete - e [Esc
D-Script] key

An example of the D-Script dialog box (the initial screen) is shown below.

D-Script List Adds a D-Script
D-Seript Deletes a
Lists the D- ; i T — = reg[stered D-
Script ID —T Script
numbers and |_— Allows you to
descriptions edit the con-
tents of a D-
C
[ L] gorint
Copies the
contents of a D-
Script
Belp Pastes the
copied contents
of a D-Script
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B Registering D-Script Settings

Here, additional D-Scripts can be registered. When the button is
clicked on, the D-Script Editor will appear.

Enter the D-Script’s ID No. (from 00000 to 99999)

Enter _a . =it D-5cript Editor - Untitled
description — s
here Desoiption: 9E Timer Duration .
Displays the L Tlor o~ 1 = —— Trigger
D-Script's //ShowToo\bnx i et LI wE area
command Formula: Functions:
tool box
— 1| Displays
T:‘aenf::d defined
‘S‘]actions” function
names
(commands)
of the D- DataType:  [Bin [ Data Length: ]W tode+- 1O [Call |[MNew
Script Enier an expressian. Fress HELP for examples [Edit |[Delete
Paste
Message _ ||
area
(window) o | [ cowe | [ ootons. | Hem

B D-Script Tool Box

The D-Script tool box contains icons for D-Script commands and State-
ments and constant input icons.

Tag Reference Manual; 3.1 D-Script/Global D-Script
When the tool box check box is checked, the following tool box will appear.

D-Seript Toaol Bax

= perands=—— = Statements =
[ Jrodffne] TR
[l
=Calc. =Diraw
+[= %] || ]
xI71=] |lICIO
=Compare=—— =bit-0peration=
=[5
Elcfel | AT
== | =@

=Copy 510 Operation=
EE |E=
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M Definition of Functions

2.7 D-Script/Global D-Script

Programs to be used for D-Script are defined as functions. The defined
functions can called up to the activated program and used. Also these

functions can be nested up to 10 layers. When the icon is clicked on in
the D-Scrip Editor, the D-Script function setting screen will appear.

Enter a function

name \

Enter the D-
Script’s action
(program) to
perform

Message area — | |

(window)

Displays the D-Script command tool box
when this check box is checked

D-Script Function : Untitled

| |

~ Function Name:

Show Toolbox

)Y

B

DataTwpe:  [Bin || Data Length 168t ||| Code+/-

o0

Enter an expression. Fress HELP for examples,

/

Call

Edt

Copy

T
ai
7]
o+
o]

~Displays
defined func-
tion names

%{e; Only alphanumerics and the “_(under bar)” can be used for function names;

up to 20 character

s can be entered.

H Deleting D-Script Settings

Here, existing D-Script settings can be deleted. After selecting the D-Script

settings to be deleted from the listing, and clicking on the button,
the Confirm Script Delete dialog box will appear. When the
button is clicked on, the D-Script settings will be deleted. When the

button is clicked on, the deletion command will be canceled.

Co

nfirm Script Delete

Do you want to delete this seript?
id: 00000
desc; warning wiew

No
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B Editing D-Script Settings

Here, registered D-Script settings are changed. After selecting the D-Script
settings to be changed from the D-Script list and clicking on the

button, an additional registration screen will appear. Click on the
button to change the D-Script settings. To cancel the Change command,

click on the button.

A - It is not possible to use the Project Manager [Utility]’s [Con-
! \ vert Address] area to modify addresses used in a D-Script.
Important — Apy D-Script program that requires address conversion will
need to be edited manually.

If the [Save As..] function has been used to change a project
file’s PLC type, the D-Script program will not be able to auto-
matically change those addresses.

Be sure to not use D-Script to perform any life-threatening, or
possibly damaging actions!
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B D-Script Settings: Copy and Paste

PROCEDURE REMARKS

(1)Select the pull down [Special] menu’s [D-Script] com-
mand.

(2)Click on the button.

D-Script List

D-Seript

00007 Pump ON

Add

’ Delete

Cloze

Help

(3)When the button is clicked on, the D-Script | This D-Script can also be copied to
copied in step (2) will be added. The D-Script’s ID another screen.
number will automatically be assigned to the small-
est number currently available.

D-Seript
00001 FumE 0N T add

Cloze

© Hep
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B Registering D-Script settings

The method for registering D-Script settings is shown below.
e N
For a temperature controller, D-Script detects the PLC’s error bit and dis-
plays alarm messages when the temperature rises to 70 °C or above, or has
fallen lower than 30°C. Also, the number of the errors detected are counted.

When error bit M0O001  If the temperature has risen to ALARM

turns ON... higher than 70°C, screen B100 Over 70 deg. !!
le is displayed.

Dm:l:l If the temperature has fallen to ALARM

' lower than 30°C, screen B101 is Under 30 deg. !!

displayed.
Also, the number of occur-
rences is counted. Above 70 I:l

Below 30 :l
» Temperature data is stored in D200.

* When the temperature is 70 °C or more, the number of Alarms is stored
in LS300.

* When the temperature is 30 °C or less, the number of Alarms is stored in
LS301.

* The alarm display screen number is stored in LS302.

\- J

To display the above mentioned alarm messages, L and N-tags are used as
follows:
(1) Create the alarm message screens, B100 and B101.

(2) Setup an L Tag to display the Alarm message screen. (Direct designa-
tion, word address: LS302)

(3) Set up an N-tag to display the number of the errors counted when the
temperature rises to 70 °C or more. (Word address: LS300)

(4) Setup an N-tag to display the number of the errors counted when the
temperature falls to 30 °C or less. (Word address: LS301)

For details concerning each Tag, refer to the Tag
Reference Manual; 1.3 Tag List.

PROCEDURE REMARKS

(1)Select the pull down [Special] menu’s [D-Script] com- | The number of D-script registra-
mand. tions will be limited depending on

each GP memory capacity.
2)Click on the| 4d¢d. |button.
@) Tag Reference

Manual 3.1.4 D-Script/Global D-
jj Script Limitations

[~

D-Script List

D-Seript

Delete
Edit
Copy

Baste

IR
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2.7 D-Script/Global D-Script

PROCEDURE

REMARKS

(3)Perform settings for each item such as ID, Trigger,
Formula, etc.

Enter 00000

E}ter Alarm Display Enter M0001

«*t D-Script Editor - Alarm Display, [x]

] pe

Edge Bit hddress

Moo I

|

uncions:

Formul
ifw:D00200[>=70} \

WL S0302[=100
L 50500/ |w L 50300|+1

Setting to “bit
rising”

o H Options. H Help }

(4) Click on the button.

Enter an expression. Press HELP for swamples

N

14\

Cancel H Options H

(5)Click on the button to quit registration.

D-Script List [x]

D-Seript

1 bk
I | The current
- registration
egistratio

information is
shown here.

A description can be entered of up
to 20 characters.

Tag Reference
Manual; 3.1 D-Script/Global D-
Script

Program
if ((W:D00200] >=70)

{

[W:LS0302] =100

[W:LS0300] =[W:LS0300] +1

¥
endif

if ((W:D00200] <=30)
{

[W:LS0302] =101

[W:LS0301] =[W:LS0301] +1

¥
endif

In the area, the Syntax

Assistant and Syntax Check
functions can be used.
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m Data Sampling

Address data designated in the PLC is sampled and stored (backed up) in the
GP unit. When using this function for a graph (Tag or Part)’s channel,
Trend graph data can also be stored (backed up).

Up to 20 sets of Data Sampling can be entered, including the number of
channels; the setting attributes can also be confirmed in the Tag List (Data
Sampling).

For more detailed information about data sampling, refer to the Tag Refer-
ence Manual.

Tag Reference Manual; 3.2 Data Sampling Settings

Usage Pattern

-Elme
Add, Edit, or or

[Special ~— [DataSampling] — pgjete - tkr:;

An example of the Data Sampling Setting dialog box is shown below.

Registers additional
— Data Sampling
Add Settings
Lists the - [ e h— Changes the Data
registered Data " Delate Sampling Setting
ga:“fplmg_r attributes
€ 'ngs’ ag _ Cloze

name and F Deletes the regis-
description tered Data Sampling

Settings
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B Registering Data Sampling Settings

Additional Data Sampling Settings are registered.

When the button is clicked on, the Data Sampling Setting screen
will appear. For each item’s setting, refer to Tag Reference Manual.

Tag Reference Manual; 3.2 Data Sampling Settings

Channel Setting |_— Enters a Data
Sampling Tag name
of up to 5 charac-

Eieneral“ Data Farmat || Samplingh
\S

Switches the — 1 TagMame o [0o00 ters
setting screens Descrintion | — .
P ——— Enters a descrip-
/Eampling Address D000 ™ tion of up to 20
characters
Trigger Bit Address 0000
Top Address L500z0 .
. 11— Displays the
Sampling Lount 1 current setting
Graph Back Up Ma attributes
Q}lnchmnuus tode - /
Sampling Type ahc; B0 zeconds
|| QK | || Cancel | || Help |

H Deleting Data Sampling Settings

Here, the registered Data Sampling Settings can be deleted. Select a Data

Sampling to be deleted from the list. When the button is clicked
on, a dialog box will appear to confirm your command. If you click on the

button, the Data Sampling will be deleted; if you click on the
button, the deletion will be canceled.

Data Sampling Setting

@ Selected Screens will be deleted |

B Editing Data Sampling Settings

Here, the registered Data Sampling Setting attributes can be changed. Select

a Data Sampling to be changed from the list. When the button is
clicked on, the Add (registration) dialog box will appear. If you click on the

button, the D-Script setting attributes will be changed, and if you
click on the button, editing will be canceled.
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B Setting Up Data Sampling

The Data Sampling setting method is shown below.

PROCEDURE REMARKS

(1) Select [Data Sampling] from the [Special] pull down

menu.
(2) Click on the button. Up to 20 Data Sampling sets, in-
cluding Trend graph channels, can

be entered.
ﬂ. =
Edit

(3) Perform the data sampling settings. After the settings | Enter a Tag name of up to 5 char-
are all completed, click on the button. acters.
Channel Setting
' General | D ata Format I Sampling 1
TegName o IO | Tag Reference
Dessition | Manual; 3.2 Data Sampling Set-
Sampling Addiess 000D tings

Trigger Bit Address 000000

TopWwiite Address oozo

Mo, of Sampl. Addr. 1
Graph Backup Mo
Synchronous Mode
Sampling Type Period. No; 60 seconds
|. [a]:4 kl | Cancel ] | Help ]

(4) Click on the button to quit the registration.

0_0000 .......

— Displays the

registered items

EEN
" Heh
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2.9 Efficient Drawing Techniques

m Efficient Drawing Techniques ]

This section explains how the use of grids, changing display states, and the
help function can all help to increase your drawing efficiency.

@ Grid/Snap

Grid Points are placed at regular intervals on your screen and divide the
drawing area into a coordinate “grid” pattern; when the Snap to Grid func-
tion is enabled, objects that are drawn will automatically “snap” (be aligned)
on this “grid” pattern. Use the Grid Point Spacing command to adjust the
density of the Grid points, and to display the grid or not. Also, grid points
can be displayed as grid lines, not as dots. Grid Points are not shown on the

GP unit’s display.

Select the pull down menu [Option]’s [Grid/Snap] command.

B Grid/Snap Settings dialog box

Turns the display
of the Grid Points
ON or OFF

Designates the
Grid Point
display’s being
drawn on top of, or
under, screen
objects

Turns the Snap
function ON or OFF

Registers a Grip
pattern.

Registers the grid
pattern that has been
designated in Spacing
to the position high-
lighted in the Grid
Spacing List.

@ Display

Grid/Snap Settings

\E Dizplay

)j Snap
(Grid Spacing List:
A

2] 403 40
J8x16
41616
532K 32

%) Bottom £ Top

Spacing

SIEEIE BT =
vz [
[] Touch Area

Grid Shift Start Point=———

x B E

Style

%) Dot
i3 Line

Cancel | | Help

Designates the grid

display style, i.e. as dots

or grid lines.

Enters the
desired Grid Point
spacing

Sets up the grid
to the optimal 20
x 20 dot size

Enter the coordi-
nate for the start
point.

Set the start point
in a center area
that is to be the
start point for
calling up the
screen. (The start
point is set as the
default value.)

Sets the Grid Point display state (displayed or not displayed).

Grid pattern display can also be changed in the Grid Tool Bar’s grid pattern

selection list box.
€ Snap

When the Snap check box is checked, the cursor will “snap” to the grid;
objects can only be drawn on points (start & end) along the grid.
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Chapter 2 - Base Screens

ﬁ\f Turning the Snap function ON or OFF can also be performed via the Grid/
ote’

%te

2l Snap Tool Bar’s icons 0] and O .

Glid/Shap x|

1]120% 20 ~ _

€ Spacing

The Grid Point intervals are entered here. The unit is a dot. Input the

interval value for the X and Y axes, respectively. The default value is 20
dots.

When clicking on [Touch Area], a 20 x 20 dot spacing will be automatically
designated, which is most suitable for the touch panel.

Select a desired grid pattern in Spacing and click on the button.
Then, the selected grid pattern will be reflected to the current screen and will

also be displayed as the 6th selection of the Grid Tool Bar’s grid pattern
selection list.

@ Grid Spacing List

Clicking on the button changes Grid Spacing List’s highlighted set
value to Spacing’s set value and registers it.

The grid patterns registered here will be displayed on the Grid Tool Bar’s
grid pattern selection list box. A grid pattern selected from the grid pattern
selection list box will be reflected to the current screen.

Grid Mo Display

-] ]

& Start Point

Grid/Snap Setlings

) Display Spacing
=
Batom {Top | KGN @ [

) snap =
Y [2199) =
(Grid Spacing List m

DTouchAlea
240 40
JBXIE
H1E=1E

Grid Shift Start Pointe—=
x B

Style-
% Dot
3 Line

[u] 4 | ‘ Cancel | ‘ Help |

532k 32

. When the GP type is changed to a model that has a different screen size, the

2] start point of the grid is the start point that is set in a center area
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€ Style
Select grid pattern display style from “Dot” and “Line”.

<When selecting Dot:> <When selecting Line:>
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@ Screen Property Settings ]

Here, the screen display’s environment is set up, which effects both the
method used to draw screens and displaying the Part and Tag addresses.
The user’s work environment can be modified whenever necessary, helping
to reduce the time required for drawing.

Select the pull down menu [Option]’s [Screen Property] command.

B Setting Screen Property - [Display]

The display state (displayed or not) of the items such as object Fill, Window
Mark, Tag Mark, and setting information on Tags and Parts can be selected.
Check the box of the items to be displayed. When a box is not checked, that
item will not be displayed.

The settings on this screen will be applied to all the screens. Properties
cannot be set up for individual screens.

Screen Property _

' Display [ Color 'DisplayArea]

i
T Fill Paint
Z] Multiple open with next! presw
E Dizplay in Load Screen Object
Load Sereen Double Click
% Change Attibute i) Edit Screen

) wdincdow Mark,

E] Tag Mark
Innfomation D ata

E] Tag Mame

) Pats ID

D Device Address

Infarmation Data Size

% Momal £ Small

Z] Move Tagname Separately
7] Used Hairline Cursar

|I ak. I| Cancel || Help |

%te,' The display state of ID numbers, Tag Names, Addresses, and Tag Marks can
also be changed via the [Option] tool bar icons.

@ Fill

When creating a screen, the drawing can be controlled so that any Fills used
will either be displayed or not. If the “Fill” check box is not checked, all
Fills are not shown. Using this feature will help you to speed up screen
redrawing time, and thus speed up screen creation.

) When the “Fill” check box is not checked, the actual screen
Important  shown on the GP unit may differ from the screen shown on your
PC. To be sure the display is correct, check the “Fill” check box
ON at least once, to verify the screen, before sending screen
data to the GP.
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@ Fill Point

When this feature is selected, specified Fill points will appear with an “X”
mark, which is especially useful when selecting Fill points.
If the Fill Points are not displayed, Fill cannot be performed while editing.

%I‘e.’ The X (cursor position) mark’s color can be designated in the system’s
[Color] area.

@ Multiple Open with Next/Prev

When selecting [Previous Screen]/[Next Screen] from the [Screen] menu, or

opening a screen with the Open Screen switch [« ] »], specify whether the
next screen is opened with the currently active screen open or after that
active screen is closed. Up to 20 screens may be opened continuously.

@ Display in Load Screen Object

You can specify whether tag and part addresses, ID numbers, tag names, and
tag marks on a screen which has been called up using the [Load Screen]
command are displayed or hidden.

@ Load Screen Double Click

Specify an edit method for editing a screen that has been called up on
another screen where the [Load Screen]| command was executed, or for
editing a screen on the Screen List.

If [Change Attribute] is specified, the Load Screen dialog box will be
opened, enabling you to select a screen to be called up (screen number).

If [Edit Screen] is specified, the screen that has been called up will be
opened, allowing you to edit the data.

€ Window Mark

Designates the window mark display state, i.e. displayed or not displayed.
The window mark shows an area that has been registered as a window.

2.6 Registering Windows
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¢

A-tag, a-tag (Type depends C-tag D-tag
on border settings)

Tag Mark

Designates whether or not the Tag Mark is displayed while a screen is being
drawn. Tag Marks show the point or area specified for a Tag. However, a/A/
D-tag marks and G/g-tag’s Pie/Half-Pie/Meter Tag marks will always be
displayed, no matter what this setting is.

<Example>

d-tags (display depends on %
and the data display’s ON/OFF
settings)

//

N EB200 Tag / /.
V2 T R Y o e
R . A E,K,N,
o ands-
. tags
o o)
Gtag T 77 N\ > =~ nEEEE F-tag
g-tag . . e et |: Lo
(1 R0 Pa——
'ﬁﬁﬁﬁﬁ'ﬁ'ﬁﬁﬁ..ﬁﬁM M-tag
n-tag — e S A I - S
P-tag (display dependson H, J,andL,l k,T,and R-tag
the designated display and W-tags t-tags
format and Tag mark)
X-tag
V-tag | T A
O N LT
REREN
| 4
S =
o | Q-
tag
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@ Tag Name

Designates whether or not the Tag Name is displayed while a screen is being
drawn.

@ Parts ID

Designates whether or not a Part’s ID number is displayed on the Base
screen.

@®Device Address

Designates whether or not Part and Tag Addresses are displayed on the Base
screen. Part Addresses appear below the ID number, and on Tags, below the
Tag Name.

@ Information Data Size

Selects the character size displayed from Standard (half size) and Minimized
(1/4 size) for ID No., Tag names, and Address.

@ Move Tagname Separately

Whether or not the Tag Name and Address display position is also moved
when Tag Marks are moved is designated during screen creation. If this
function is selected, when Tag Marks are moved, Tag Names and Addresses
will be not moved.

& Used Hairline Cursor

Changes the arrow cursor to the hairline cursor.

GP-PRO/PB III for Windows Ver. 5.0 Operation Manual 2-221



2.9 Efficient Drawing Technmiques Chapter 2 - Base Screens

B Setting Screen Property - [Color]

Select the Grid, Fill Point, and Screen Background colors here. When the
drawn image data’s and system’s colors are the same, the screens will be
hard to see. Here, these colors can be changed to remedy that.

Screen Property |
.' Display | Color | Display Area |
Gid Color N
Fill Paint Color RN N

Sereen Background Pattern

fo IEEDEECINE
ts MEEDEEINE

|I ak I| Cancel || Help

@ Grid Color
Selects the grid point’s color.
@ Fill Point Color

Fill Points designate the point where a fill will begin; this setting determines
the color of the fill point.

@ Screen Background

Select the Base screen’s background color; the color selected here is also
displayed on the GP.

\ If any background color is specified for the screen to be
importan loaded, no on-screen object will be displayed on the GP unit.

To load a screen whose background color was specified,
specify the loading position at the center of the screen.
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Bl Setting Screen Property - [Display Area]

The screen display area borders will be displayed on the Screen Editor when
a GP unit with a different resolution level from the current GP’s is used. You
can select a GP unit with a lower level of resolution than the current one.

If the screen display area is different between GP units with different resolu-
tion levels, part of the screen may become invalid. With this function, you
can confirm the screen area that can be displayed on a different resolution
GP unit beforehand.

Screen Property |

.Displa_l,l Colar _. Display Area ]

Il ep550

) GPa7o/z70

Ok ” Cancel || Help

@ Preview Screen ]

With this feature, you can confirm how an image will appear on the GP unit.
This image will differ depending on each GP display device type.

If your PC’s screen color palette settings are specified to other than 256
colors, monochrome and blinking displays cannot be shown.

Select the [View] menu’s [Preview] selection.

Select the icw - [B7 Uniilc -
type of ———(@ Backrwiite 59 Coor ) [ Tos= |
display used
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@ Screen Data List ]

The currently displayed screen’s object locations and setting attributes are
listed in the Screen Data List.

B Screen Data List

An example of the Screen Data List is shown below.

I Screen Data

Displays the object

L_0aad oooodad placed on the

F_0000 0000 0ooood

T 0000 0ooooo currently displayed
TS_001 000000 000000 screen
5G_001 0000

Designates the
type of the object
to be displayed in

CE Patz:  [¥i Tags Wi Objects >/ the Screen Data
Edits the object List
selected from f Segedir | [ Bsbe - pejetes the objet
. =] selected from the
P o Change Order
List ﬂ Link Sefect ':] ? Screen Data List
Highlights an Changes the order
object selected on of drawing objects
the screen.

B Screen Data Display

The designated type of object(s) data is displayed. If a grouped object
contains at least one object whose type has been designated, it is displayed
as an grouped object.

The Screen Data List displays the following information:

Drawing ................ Type and coordinates of a drawing object

Tag .coooveviieiene Tag Name and Address

Part....ccooeviiinne ID Number and Address

Grouped object ...... Grouped object’s coordinates and each grouped object’s
information

%[e_' D-Scripts are displayed as tags. Each D-Script shows ID and description
information.

Bl Selecting an Object

The object selected from the list will be displayed with handles (i.e. se-
lected) in the Screen Editor. To select multiple objects from the list, Left-
drag them, or hold the or key down and click on desired ones.

& Link Select

Normally, when any object is selected with the Screen Editor, it will not be
displayed on the list. If the check box for [Link Select] is marked, an object
selected with the Screen Editor will also be selected (highlighted) on the list.
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B Editing an Object
To edit an object, select it from the list and click on the button; or
simply double-click on the object.
If the object is D-Script, D-Script Editor will be actuated.
Clicking on the[Delete| button deletes the selected object.

€ Change Order

Objects are displayed on the list in the order where they have been drawn. If
the order of objects on the list is changed, the overlapping order of drawn
objects and the executing order of tags and parts can also be changed.

€ Copying

Any object on the list can be copied by pressing the +[C | key, or pasted
by pressing the [Ctrl ]+ [V ]keys. Multiple objects can be copied at a time by
selecting them.
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@ Part Reference List

)

The settings for each Part placed on the currently edited screen are listed
here, for each Part type. Part settings can also be changed on the Part

Reference List.

Usage Pattern

Select

Part

When either modifying or deleting...

After selection,
[View] — [Parts List] — desired — either modify or
delete the Part

"~ [Esc]key

or the

An example of the Part Reference List on a screen is shown below.

Reflection of device comment
The device comment corresponding to an
entered device address overwrites the Descrip-

tion field.
Changes Part’s
settings
Shows a list of Deletes the
the Parts on the selected Part
currently
selected Copies a part
screen. Simply
click on the Pastes a part
desired Part Stores the
Parts list
information as
o) a CSV file.

Use this scroll bar
to view all the data
on a long screen

Closes the current screen.

(The [Esc]| key can also be

used)

%te,' The tab width for each item can be adjusted by placing the mouse pointer on

the border between items and then dragging it.

B Editing Items on the Part Reference List

Part setting data can be changed directly on the Part Reference List.

Click on the left-most number of a Part to be changed, and it will be high-
lighted; then, click on the button, and the Part’s Dialog box will
appear and its settings can be changed.

Setting items, such as the Description and Address areas, can be changed via
the Part Reference List. Also, items displayed in gray can be changed in the
dialog box by double-clicking on the inside of their border.

|I [ Part 1D | Dezcription [Datatddiess Dizp... [ Char Size

(1 [wo_oo|f |Dooz1 5 8416
I

\
Can be edited directly Can be edited by
double-clicking
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ﬁg\te; For the labels and messages of more than one line, use “\\” as the carriage
return.

RESET | 4 g fee———
suTTon] <> |Reset\Button

Bl Deleting Items from the Part Reference List

Parts can be deleted directly from the Part Reference List.
Click in the middle of a Part to be deleted, and it will be highlighted. Then,

click on the button, and a dialog box will appear. Clicking on the
button will delete the Part from the Part Reference List. To close
the box without deleting the Part, click on the button. When
multiple Parts are selected, all the Parts will be deleted by clicking on the

button, and by clicking on the button, the box will be

closed.

Confirm Delete

g Are pou zure pou want o delete: BS_0017Y

Fves | || Ve Al ||| Ma ||| Mo Al ||| Cancel

B Copying a Part on the Parts List
Any part can be copied on the parts list.

Select the left-most number for the part being copied by clicking on that
number. The selected part will be highlighted. After this selection, click on

the button and then the button. The part will be copied to

the bottom line of the list.

H Reflecting a Device Comment on the Parts List

The device comment corresponding to an entered device address can be
entered on the parts list by clicking on a specified button. This can be done
in either of the following two ways:

1. Select the address setting field and click on the [Apply De-
vice Comment] button.

The device comment corresponding to the selected address will be
reflected in the Description field.

2. Select a part by its line and click on the [Apply Device Com-
ment] button.

If there are multiple address setting items for that part, the descrip-
tion corresponding to the address specified in the [Address Table
for Automatic Input of Device comment] will be reflected in the
Description field.

2.4.7 ® Reflection of Device Comments
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B Exporting a CSV File
The Parts list information can be saved as a CSV file.

You can also select whether the currently selected page (tab)’s information
will be exported or the entire page will be exported.
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@ Tag List

)

Tags and their setting attributes (type of data) specified on the current screen
or in a Project File can be listed; the setting attributes can also be changed
on the Tag List. The Tag List will be displayed separately for Local Setting
(Tags specified for each screen) and for Data Sampling Settings specified
commonly for all the screens. When using a GP-H70 unit, the Global
function keys will also be displayed. The Tag List for Local Setting and Tag

data setup for each screen will be displayed.

Usage Pattern When editing or deleting...

[Local]
or

[View] — [TaglList] — -
[Data Sampling]

Select Edit
g — or

Delete the key

- or

The following is the Tag list (local) screen example.

The edit method of this list is the same as that of the Parts list.

SAEETTTIK 2.9.5 Parts List

Lists all the Tags used on the currently open screen.
Select the desired Tag to list its type of data

Al [aTag|[CTag| G Tag|n Tag]

e J

Using Device ~—_
Comment

Here, the device  ——r

comment that

3 |6 0001 |||[Pump ON

Del

4 |n o001 |||Motor Test

corresponds to
an device ad-
dress is auto-
matically written
in the Descrip-
tion field.

Pass

HIE
e
=1
=I5

Click on Clase 1

it

to close the Tag (o] [ O]

List screen

Pressing tr If Tag has been grouped, an asterisk will
key will also close appear here.

the screen

2.4.12 Group/Ungroup

Opens the
selected Tag
for editing

Deletes the
selected Tag

Copies Tag
Pastes Tag

Moves Tag
one position
higher on the
list

Moves Tag
one position
lower on the
list
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<Individual Tag List Screen>

Tag List

[P0 AToo [CTag |6 Tag| rireg)

s Commen:

1 MoritorWor.. | No. of Mo.._ | Display Fo.. | Test Screen .. | Text Soieen [/ Blank Lin... | DisplapSt... [|| [T Edit
JDoooog h |Direst h | lon h |

— Saves the Tag
H Listin a CSV file

Scrolls the
display left, right,
up and down
when the Tag List
is bigger than the
screen size

%&% + The tab width for each item can be adjusted by positioning the mouse
pointer on the border between items and then dragging it.

- For GP-H70, Tag names specified via the Local function keys will become
“OQP_*_***” op “F*_* **%”_ thereby allowing you to distinguish in the Tag
List whether the Tag was set up via the Local function keys or on the

2.10.1 Function Keys

B Changing the Tag Setting Order

The Tags will function in the order that they have been set up (the order
displayed on all the pages of the Tag List) on the GP screen. To change this
order, click on either the [ MeveUp | or [MoveDown| key. When multiple Tags are
grouped, that group will be moved up or down.

B Exporting a CSV File
The Parts list information can be saved as a CSV file.

You can also select whether the currently selected page (tab)’s information

ed or the entire page will be exported.
2.9.5 Parts List; B Exporting a CSV File
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@ Cross Reference List ]

The Cross Reference List feature is useful when displaying the current
address condition of Tags and other items. Here, the exact address used for
each Tag can be checked.

Cross reference will be displayed for local settings (each screen’s Tags, D-
scripts, and Parts), and data sampling and global D-scripts registered for all
the screens. If you use the GP-H70, the global function key settings will also
be displayed. For the global cross reference, setting display will not be
sorted for each functions and screens, but the address designation conditions
will be displayed for the entire Project File.

%{e; + Since, to display the global cross reference, address information for all the
screen will be acquired, it can take a long period of time.

- The global cross reference does not display the condition of addresses that
have been designated via [GP System Settings].

+ After changing the GP model (GP type), addresses specific to the previous
GP model (type) may be displayed. (For example, when changing GP-H70
to the other model, this may occur.)

B Cross Reference (Local, Data Sampling, Global D-script)

Usage Pattern

[Local]
Select either

[Cross Refer- or _ _
ence List] - [Data — Word or Bit — Confirm — or

[View] —
Sampling]  UNits the [Esc]key

An example of the Cross Reference List dialog box (in the case of Local) is
as shown below.

Select whether to display by Bit
Address or Word Address

Cross Reference List [ Local )
Bt Address | word Address | | Click to change the
Address [ Tags [ Parts " fiddiess,., Dlsplay Start Ad-
Hogoao [¥_oooo | dress

Selects the Address
Display condition

Addresses=—
%) Used
23 4l
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B Global Cross Reference

The global cross reference has two display methods, i.e. list display same as
the standard cross reference and address map display.

Usage Pattern

[Utility]

[Global Cross
Reference]

— Bit Address. = Confim = [Esc] key

[List]
or —  Start address search.
[Map]

Select either Word or or

The following is the overview for the global cross reference screens.

€ List Display

For local settings, which screen is used, and for global settings, function
type will be displayed, respectively.

Selects whether setting conditions are dis-
played for Bit Addresses or for Word Addresses.

Global Cross Reference List |
"Bl Address | word dedress | Changes the display
-
— — wins, | s?art address to be
00000 Bi1 displayed.

#0000

»®0000z2

»00003

E1.B11 Addresses=
B1.B11 o
B1.611 ) Used
oa T
™ Selects the range of

Addresses to be
displayed.

€ Address Map Display

When selecting Word Address, the table cells from Word Address Bits 0 to
15 (for 32 bit device, from 0 to 32) will all be filled. When selecting Bit
Address, only bit cells currently used will be filled.

setting condi-
tions are dis-
played for Bit
Addresses or for

Word Addresses.

Address Used Mapping

Selects whether 7‘__“”“‘1‘1‘*“ Bit Fosition [WUsed  [Tunused Displays the Bit
Address i
Do0o0o IS N I S O N N N N I Iocatlon "
000001 | [ [ rrrrirrrirriri]

000002 | [ [ rrrrrrrrrrrii
D003

DODO03

000005

DO000E L I
000007 L
Do000g

000003

00010

Do0011 -
BIIE]

CIIE

Do0014
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%I‘e,’ * Among the tags and parts, the ones corresponding to both bit addresses and
word addresses are cross-referenced with both of those addresses on the
Cross Reference List even if they were placed by specifying their bit ad-
dresses.

Example: A tag (part) placed at bit address, X0000F is displayed as word
address, X00000.

¢ In the case of the GP-H70, tag names on the setting list can be used to
distinguish tags added with local function keys from ones added on screens.

The tags added with local function keys are named as “OP_*_***” or
“F* * *7‘:*”-

2.10.1 Function Keys

B Changing Display Addresses

For cross reference and global cross reference list display, when selecting
[Used], addresses that have been used for the Tags and Parts used in the
currently open screen or Project will be displayed. When selecting “All
Addresses”, all the addresses beginning with the Start Address will be
displayed. To change the Start Address, click on the button, and
the Dialog box shown below will appear. Set the Start Address and click on
the button, and the display will show from that address on.

Start Address |

Start Address

Enter the Start — 00007

Address

Cancel

" Help

For the global cross reference’s address map display, the map display start
address can be designated when toggling Bit and Word display.

When clicking on [ward sddress | or | Bit Address |, the following dialog box will
appear. After selecting Bit or Word, designate the start address. Then, click
on the button and the cross reference display will start from the
designated start address.

Start Address |
) wiord 1 Bit UK
Start Address | Canszel
Enter an —||D00ooo .
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@ Load Screen List ]

The Load Screen List will be displayed on the currently edited screen. With
this list, you can check the setting attributes of a screen to be loaded and
also can change its loading location.

Usage Pattern When editing or deleting...
-Elnse
Vi Load Screen Select a screen Edit or or
[View] — List — tobeloaded ™ Delete =
SC

General Load Screen Summary List

Lists all the screens loaded on the currently open screen. Select the
desired screen to show its setting attributes.

Load Screen List

Base ]) Changes Load
Click on to close Screen List
the Load Screen Settings
List screen. [ [Ser.. [ Posiion = [Fosiion 't [ Titie [ Ed.
Pressing the Esc FE 305 B Statistics A L
key will also 3 |4 || [122 [Blam & — Deletes a Load
close the screen Screen List

B Editing via the Load Screen List

Screen settings can be changed using the Load Screen List.

Clicking on the left-most number of a screen to be changed will select
(highlight) it. Then, clicking on the [Edit] button will bring up the [Load
Screen] dialog box or the currently called-up screen, allowing you to edit the
screen. The procedure for calling up and then editing a screen varies de-
pending on the settings in the [Load Screen Double Click].

2.9.2 B Screen Property Settings — [Display Settings]

Any coordinate setting can be changed directly via the Load Screen List.
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B Deleting from the Load Screen List
Screens can be deleted from the Load Screen List.

Clicking on the left-most number of a screen to be changed will select
(highlight) it. To delete multiple Load Screen Lists simultaneously, simply

drag the cursor to select the screen numbers. Then, click on the
button, and the dialog box will appear to confirm the command. If you click

on button, the screen will be deleted. To cancel the request, click
on the button. When selecting multiple screens, click on the
to delete all of them, and click on to cancel any dele-

tions.

Confirm Delete

Mo || Moal || Cancel
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@ Display of Screen Level Change Structure ]

The nesting of Load Screens that have been set up on the currently edited
screen is displayed. In this way, a multiple nesting condition can be viewed.

2.2.11 Nesting

Select the [View] menu - [Load Screen Nesting Display] command.

Load Screen Mesting [<]

Each screen will be displayed via the following symbols:

Screen Type Symbol
Base screen B
Mark screen M
Trend Graph screen T
Keypad screen K
Image screen I
Image screen - CF card I(CF)
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m GP-H70 Screen

An example screen, when using the GP-H70, is shown below.

Screen Edt View Option Draw lags Pats Special Libray Window

[EEER s [£ERE =] &

BN B S E

Creates an
Operation
Switch

General setting area

m Function Keys ]

There are 12 Function Keys (six on each side), you can set up each one as a
Tag (T-tag, t-tag, k-tag) for touch input.

These Function Keys can be specified for Local Use or Global Use. With
the Local Function Key Setup, the Function Keys are only used by the
current screen. With the Global Function Key Setup, the Function Keys are
commonly used by all screens.

The number of Tags that can be registered on a GP panel as Global Function
Keys is limited to a total of 24 T, t, and k-tags. Registering a single t-tag as
a Global Function Key, however, requires 2 Tags.

Up to 128 Tags (together with other Tags) can be used for a single screen’s
Local Function Keys.

If a Function Key is set up for both Global and Local use, then the Tags
specified as Global will be performed first.

All Tags registered as Function Keys cannot use the AUX output or Reverse
Video features.

B Function Key Settings

An example of the Function Key Setting screen is shown below.

Registers
additional
Function Key Setup Function Key
Function Key -» OF Settings
Lists the regis- Deletes the
teredSFunctlon — | registered
Key Settings Function Key
Edi
Settings
Changes the
registered
Hel
Function Key

Setting attribute
data
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B Setting Up Local Function Keys

The Local Function Key Setting procedure is described below.

PROCEDURE REMARKS

(1)Double-click on any of the Function Keys displayed.

2)Click on the [Function Key Settings] screen’s | Multiple Tags can be assigned to a
y g p g g

button. Function Key; however, there is a

limit to the number that can be used.
Function Key Setup

Function Key -» OF

Add
L3

[ oo

For details of each
Tag’s setting data, refer to the Tag
Reference Manual.

(4)Enter the Tag setting data. After all the attributes

have been entered, click on the button to

register the entered data.

T Tag Setting
General Info. | Mode || Option: |
Tag Name 7
Mode Bit
Addresses: X0000
Action: Bit Gt
Sereen Level Change Direclion -
Reveise Videa:
Buzzer on
AL Dutput
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2.10 GP-H70 Screen

PROCEDURE

REMARKS

(5)Click on the button to quit the Function

Key registration.

Function Key Setup
Function Key -» OF :
unction Kep - --.- 5 / D|Sp|ays the
o | registered
item

W Setting Up Global Function Keys

To register another item, DO NOT
quit here, rather start again from

step (2).

The Global Function Key Setting procedure is described below.

PROCEDURE

REMARKS

(1)Click on the [Special] menu’s [Global Fn Key].

(2)Double-click on any of the Function Keys displayed.

H70 Global Function Key Settings

(3)Click on the button.

Function Key Setup

Function Key -» OP

! |

Drelite:
Edil;

Cloze

il

Help

Before this selection, open any
Base screen.
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PROCEDURE

REMARKS

(4)Click on the Tag Name to be used.

———
Select Tag Function

Selector Sw - tag)

Feyboard [k - tag)

I Cancel I || Help |

(5)Enter the Tag setting data. After all the attributes

have been entered, click on the button to

register the entered data.

T Tag Setting

General Info. | Mode || Options |

Tag Mame: T

Drescription: | ||
Mode: Eit

Addresses: »*0oao

Actior: Bit Set

Screen Level Change Direction:

Reverse Video:
Buzzer: On
Al Output:

|| Cancel ||| Help |

(6)Click on the button to quit the Function Key

registration.

Function Key Setup

Function Key - OP

| __— Displays the

registered
item

Multiple Tags can be assigned to a
Function Key, however, there is a
limit to the maximum number.

SABOTETIK For details of each

Tag’s setting data, refer to the Tag
Reference Manual Chapter 2 Ac-
tive Image Function.

To perform the registration continu-
ously, DO NOT quit here, start from
step (3) again.
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m Setting Up the Operation Switch ]

The GP-H70 has two Operation Switches, one on the front face and the
other on the rear face.

Front Face Operation Switch Rear Face Operation Switch

Each switch can be enabled or disabled via the [GP System Settings] area or
with the GP in the offline mode.

When a switch has been specified as [Enabled], the front face’s Operation
Key or the rear face’s switch must be pressed and held down for the H-70’s
touch panel or function keys to operate. If this switch has been specified as
[Disabled], the front face’s Operation Key can be used only as a Function
Key, and the rear face’s switch is disabled.
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A
m

7 U

Important

m DXF Conversion

This feature allows you to convert DXF (Drawing Interchange File) file data
into Base screen data, and to convert Base screen data into DXF file data.
(A DXEF file is on Auto Cad® drawing file)

DXF filenames must be alphanumeric.

DXF can be used for the Release 12 program. If a newer
version’s data is used, that data will not be converted.

When each object’s coordinates are converted, errors may
occur, thereby slightly changing them.

Once a DXF file data is converted into Base screen data, even if
the Base screen is again converted back into the original DXF
file, or vice-versa, the resulting data my be unusable.

When converting data, be sure that the screen’s width and
height ratio will be the same for both the Base screen and the
DXF file (Screen size settings: $LIMMAX, $LIMMIN). If this ratio
is different, after data is converted, object locations or shapes
will also be different from the original.

m Conversion from DXF File to Base Screen (DXF — PRW) ]

DXEF file data is converted into Base screen data.

GP PRO/
DXF file |:> |:> PBIIl Base
screen

Convert

B Requirements and Restrictions when Converting Data

(DXF — PRW)
* Grouped objects (Blocks) can be nested up to 10 layers (levels deep).

* The DXF file data format is ASCII. Both “CR LF” and “LF” can be used
as line feed characters and will be converted correctly.

* During conversion, when the resulting output file’s size reaches
16Kbytes, the conversion will quit, and subsequent data will not be
converted.

* Three dimensional data cannot be converted.

» Ifthe X,Y coordinate screen boundaries (SLIMMIN, SLIMMAX) are not
set up correctly in the DXF file, after the data created in the DXF file is
converted into Base screen data, it may go beyond the Base screen’s
display area.
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» After DXF file data is converted into Base screen data, the DXF file
name is used as the Base screen’s description.

* When a layer’s attribute has been turned OFF, that layer’s data will not be
converted, and only ON layer data will be converted into Base screen
data.

* Fill and Oval/Arc data cannot be converted.

W Option (DXF — PRW)

Here, select and enter the color and size used when converting data. Ac-
cording to the specified DXF and Base screen size, data will be relatively
magnified or minimized when converted.

Option [ DXF -> GP ) DXF size
Convert Color Selects a DXF file
o Carvvert Calar size

Data is converted as

colored = Corvert DF Size

159 Use SLIMMIN $LIMM2S
£ Use SEXTMIN SEXTMAX

| _=Corvert GP Size

—
Screen Size £ B40xd80

Designates the A £ B40x400
screen size used

; v -m] £ 3205240
after conversion

i) 200xE00

|| ar. ||| Cancel ||| Help |

@ Convert Color

When this box is checked, DXF file data is converted as colored. When this
box is not checked, DXF file data is converted as monochrome.

2.11.1 W Color Conversion (DXF — PRW)

@ Convert DXF Size

The DXF file data conversion range is selected.

When “Use SLIMMIN, SLIMMAX” is selected, data in the DXF file’s
maximum screen area (X,Y coordinate screen boundaries) will be converted.
When “Use SEXTMIN, SEXTMAX” is selected, only data in the DXF file’s
object area will be converted.

@ Convert GP Size

The Project File screen size (GP screen size) used after conversion is speci-
fied.
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B Color Conversion (DXF — PRW)
When the [Option] dialog box’s [Convert Color Data] check box is checked,

the DXF file’s color data will be converted as follows:

DXF File Color No. Base Screen

1 (red), 1X (red-based) Red

2 (yellow), 5X (yellow-based) Yellow

3 (green), 9X (green-based) Green

4 (light blue), 13X (light blue-based) Lightblue

5 (blue), 17X (blue-based) Blue

6 (purple), 21X (purple-based) Purple

7 (white) White

Other colors White

The background color will be converted into Black.

Each DXF file’s line type will be

B Line Type Conversion (DXF — PRW)

converted as follows:

DXF File Base Screen
CONTINUOUS Solid line
DASHED - - -- Broken line
HIDDEN - - -- Broken line
CENTER — - — Adot-dash-line
PHANTOM — - - — Two dot-dash-line
Other — Solid line

The user defined line types will be converted into solid lines.

B Object Conversion (DXF — PRW)

The DXEF file’s objects will be converted as follows.

Colors and line types will be converted as shown above. Tiling patterns will

be converted into solid Fill.

DXF File Base Screen
LINE Straight line
POINT (dof) Straight line (The start_and end are the
same point)
CIRCLE Regular circle
ARC Arc
TRACE (thick line) Filled polygon
SOLID (filled object) Filled polygon
TEXT (characters and signs) Text
DIMENSION (dimension indicator) Straight line

INSERT (inserting object)

Conversion breaks down complex
objects into component parts (objects)

ATTRIB (attribute)

Conversion breaks down complex
objects into component parts (objects)

POLYLINE(polyline/donut-shaped/
oval/polygon/rectangle)

Continuous straight line

VERTEX

Vertex coordinates of a continuous
straight line

Objects other than the above will

not be converted.
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Each object’s elements, other than colors and line types, will be converted as
follows:

@ POINT (dot)

A dot’s pattern will be converted into “0” (point), and its display size will
be converted into “0,0”.

A dot will be converted to a straight line, with the start and end coordi-
nates at the same point.

@ TEXT (characters and signs)

A rotation angle will be converted into an angle closer to 90°, 180°, 270°,
or 360°. (in 90° units)

The character size will be converted into a size closer to either 1, 2, 4, or
8 x magnification.

Special characters that will be converted are %%d (°), %%c (¢), and
%%p ().

When text contains more than 100 characters, it will be divided every
100 characters into records of data and then converted.

When more than 100 character text is divided into records of data, groups
of overflowing characters after the first 100 characters will be dislocated
toward the right bottom for a few dots.

Tilting angles, character fonts, and character spacing will not be con-
verted.

Text will be converted based on the ASCII code; therefore, the character
style (Standard, Bigfont, etc.) or font file settings will be ignored.

When text with half-sized and full-sized characters mixed in vertical
lines is converted, the half-sized characters will be centered.

€ DIMENSION (Dimension Indicator)

During conversion, the breaking down of a grouped object (Block) is
performed by referring to the Block’s sections, which indicate the Block’s
component parts (objects). However, dots will not be converted.

@ INSERT (Inserting Object)

A grouped object defined in the Block section will be broken down into
each drawing object and converted.

Up to 10 layers of nested data will be converted. However, since all the
data will be converted into a single layer on a single screen, the objects
over the limit (file capacity) will not be converted.

Although the rotating angles, and the number of lines and columns can be
converted (lines and columns of the objects over the limit will not be
converted), their ratio (scaling) will not be converted.

The grouped object created in Layer “0” will be converted based on the
inserted layer’s colors and line types, however, a grouped object created
in an other layer level will not be converted based on the inserted layer’s
colors and line types. In this case, if BYBLOCK is specified to the
grouped object, the inserted layer’s colors and line types will be used.
Simulated object sectioning (hatching) data cannot be converted, since,
when the Block section’s hatching data pattern is converted into each
drawing object, that data size can exceed the GP file capacity.

If another file’s grouped object has been inserted or another file is re-
ferred, that grouped object will not be converted.

@ ATTRIB (attribute)
ATTRIB (attribute) data is part of INSERT data.

Attribute data will be converted in the same manner as TEXT conversion.
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€ POLYLINE (polyline/donut-shaped/oval/polygon/rectangle)

*POLYLINE data will be converted connecting the following VERTEX’s
coordinates with a continuous straight line. Only data whose polyline flag
is either “0 (default)”, “1 (closed polyline)”, “2 (adding the fit curve ver-
tex)”, or “4 (adding the spline curve vertex)” will be converted.

*When the number of vertices exceeds 100, data will be divided every 100
vertices and converted.

*When the converted data’s coordinates are repeated at the same point, the
following coordinates will be omitted.

*When a polyline has curved sections, they will not be converted. There-
fore, donut-shaped lines and curved polylines will be converted into con-
tinuous straight lines, connecting each coordinate point.

€ VERTEX

Top coordinates of a polyline.
* A polyline’s width will not be converted.

B Converting DXF File Data to Base Screen Data

PROCEDURE REMARKS

(1) Select the pull down menu [Utility]’s [Convert DXF
] command.

(2) Click on the | 0U=F-FRwW | button.

#4DXF<->PRW Converter

N

e | veb |

(3) Designate the source (DXF file) and the destination| To designate a folder, click on the
(Project File), and enter the Base screen number. [Select | button.

File Convert [ DXF - PRVf )

From:
Di<F File: |C:IProPEIwINIDatabase'LDraw1 dﬂ“ Select |

T

: Project Fille: |C:\ProPBWin\Database\DDeration |”| Selec:t|

ScreenMo: B ‘10 '} "

|| Corvvert | || Cancel | ” Help
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2.11 DXF Conversion

PROCEDURE

REMARKS

(4) Click on the button and enter the conver-

sion conditions.

File Convert [ DXF - PRV )
From:

DXF File: [:\ProPBwINDatabase) Draw? o[ Selset |

" Project File: [C-PioPBwin\Databass"Operation [ select

To:

|| Corwert | || Cancel ‘ H Help

(5) After all the attributes have been entered, click on

the button to registered the entered data.

Dption [ DXF - PRVF |

Corwent Colar

Corvert DXF Size

159 Ulse SLIMMIN $LIMMEX
3 Use $EXTMIN SEXT MAX

Corvett GP Size:
£29 B40x450

d 1 a0
v £ 3204240

) 8004800
(6) Click on the button to start conversion.
File Convert [ DXF - PRV )

From:

DXF File: | CiproPBwINDatabaselDrawi.df | Select
To

Project File: [C-\ProPBwinDatabasevOperation ||| Solect
Option

@k ‘ Cancel | Help

(7) After the conversion is completed, click on the
button. The [DXF<->PRW Converter] dia-
log box will reappear.

File Convert { DXF - PRV )

Project File: |C-PraPBwAniD atabase PHOPEZ.0. || Select

JEump\ele ‘
Feading D (5656ine)

Converling [100%)

\iiling Screen (341 abigcts)

Complate

| e ‘ Cancel J ‘ Help 1

Y.

(8) Click on the button to quit.

“"‘J DXF<->PRW Converter

[HF -> PRW
FRW -» Di<F

2.11.1 W Option
(DXF — PRW)

If the designated screen number al-
ready exists, a prompt will appear,
asking whether the new number
should overwrite the old number.

When the button is clicked

on, the new number will overwrite
the old one, and when the
button is clicked on, the new num-
ber will not overwrite the old one.

Overwrite

This screen aleady exists!

Do you want bo ovenarite?

Cancel

To convert another DXF file, DO
NOT cancel here; rather, start from
step (3) again.
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m Conversion from Base Screen to DXF File (PRW — DXF) ]

Base screen data is converted into DXF file (Drawing Interchange File) data.

d -~
GP-PRO/ _
PBill Base | > > | oxriile

\.screen e

Convert

Can be used for

CAD software for a
personal computer,
such as AUTO-CAD

B Requirements and Restrictions when Converting Data
(PRW — DXF)

* Only Base screens can be converted.

» Image screens called up on the Base screen will not be converted.

» Tag data will not be converted, so for example, M-tag’s Marks will not be
displayed after conversion.

*  When text is converted, the character size and position may differ from
the original due to font type difference and errors created during conver-
sion.

» Since Load Mark will be converted into a simple straight line (i.e. no
width), if it has been magnified, it will be displayed differently from the
original after it is converted.

E | E If you try to convert a filled polygon that has four peaks, one of
,,/,,p;,,a,,, which introverts, into a DXF file, this polygon will not be con-
verted properly.
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B Option (PRW — DXF)

Here, select and enter color and size data used when performing data con-

version.
Screen Size S Option  PRW -> DXF J [<]
DeSIgnateS the GP =Convert Screen Size—————
screen size after conver- "
sion Y
=Canvert DxF Sizeem—m—m—m—m———— P rt st t
) B40x480 arts ate
. ® £ 5400400

DXF size ; £ 320240 Selects and enters the Part
Designates the DXF £ 2004600 State when converted
screen size when Base [Foe .
screen data is converted gg'f | ggf
into DXF file data 10

21

" oK H Cancel || Help ]

@ Convert Screen Size
The screen size of a GP unit specified in the Project File.

@ Convert DXF Size
The DXF file size used after data is converted using data conversion is
selected. The default values are the same as the Screen Size values men-
tioned above.
@ Parts State
Bit........ When Part display states (ON/OFF) are specified, that Part will be
converted for each display state.

Word .. Picture Display and Message Display will be converted with the
display state specified here.

H Color Conversion (PRW — DXF)

Base screen’s drawing data colors will be converted as follows:

Base Screen DXF File Color No.
Black 250 (gray)
Blue 5 (blue)
Green 3 (green)

Light blue 4 (light blue)
Red 1 (red)
Purple 6 (purple)
Yellow 2 (yellow)
W hite 7 (white)

The blink settings will not be converted.

With a 64 color GP unit, colors on the color palette will be converted as

follows:
Black Blue Black Black Blue Blue Green Green
Light blue | Light blue Green Light blue Black Black Blue Blue
Black Black Blue Blue Green Green Light blue | Light blue
Green Green Light blue | Light blue Red Red Purple Purple
Red Red Purple Purple Yellow Yellow White White
Yellow Yellow White White Red Purple Red Red
Purple Purple Yellow Yellow White White Yellow White
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B Line Type Conversion (PRW — DXF)

Base screen’s line types will be converted as follows:

Base Screen DXF File

1-dot solid line CONTINUOUS
————— 1-dot broken line DASHED
- 1-dot one-dot-dash line CENTER
— -+ — 1-dot two-dot-dash line PHANTOM
m— 2ot solid line CONTINUOUS
- == = 2.dot broken line DASHED
= = = 2-dot one-dot-dash line CENTER
- = = 2-dot two-dot-dash line PHANTOM
——— 3-dl0t solid line CONTINUOUS
s 5-(lot solid line CONTINUOUS

The line thickness will be converted in the same thickness for all the lines,
regardless of the line types.

B Object Conversion (PRW — DXF)

Base screen’s drawing data will be converted as follows.

Colors and line types will be converted as shown in the previous page’s
table. The background colors will not be converted. Tiling patterns will be
converted into solid Fill.

Base Screen DXF File
Stra_lght _Ime/Contmuous LINE/POLYLINE
straight line

Square/Filled Square POLYLINE/SOLID
Regular Circle/Filled

. CIRCLE/CIRCLE + SOLID
Regular Circle
Oval/Filled Oval POLYLINE/POLYLINE + SOLID
Arc/Pie ARC/ARC + POLYLINE
Division Collection of lines
Filled Polygon SOLID or POLYLINE

Broken down into each Part

Load Screen object and converted

Text TEXT
Load Mark POLYLINE

Broken down into each part and
Part

converted

Data other than the above will not be converted.

@ Straight line/Continuous straight line

*  When the number of coordinates is “2”, a straight line or continuous
straight line will be converted into LINE. If this number is other than 2, it
will be converted into POLYLINE.

* When a line has an arrow at one end, a solid filled triangle will be drawn
at the end coordinates, and when a line has arrows at both ends, solid
filled triangles will be drawn at both ends.

@ Square/Filled Square

* Any line will be converted into POLYLINE.
* Any Fill will be converted into SOLID.
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@ Regular Circle/Filled Regular Circle

 Filled regular circle’s border will be converted into CIRCLE and its
filling will be converted into SOLID.

@ Oval/Filled Oval
* Any lines will be converted into POLYLINE.
 Filled oval’s border will be converted into CIRCLE and its filling will be
converted into SOLID.

@ Arc/Pie
» Pie’s straight line section will be converted into POLYLINE.
@ Divisions
*  When the divisions are marked on a straight axis, their coordinates will
be calculated based on their start and end coordinates, direction, and the
number of divisions, and will be converted into LINE.
*  When the divisions are marked on an arc axis, their coordinates will be
calculated based on their start and end angles, external circle’s radius,

internal circle’s radius, number of divisions, and will be converted into
LINE.

@ Filled Polygon
» Fill will be converted into SOLID. However, if the number of vertices is
more than 5, Fill will not be converted and only its trace will be con-
verted into POLYLINE (CONTINUOUS).

@ Load Screen
e The screen will be retrieved from its attributes, and screen number and if
it exists, and each drawing data will be converted.
* The called up screen’s data will be converted in the same layer as other
drawing data.
* Only Base, Keypad, and Trend Graph screens will be converted.

€ TEXT

* Characters written horizontally will be converted into BIGFONT. Those
written vertically will be converted into TATEGAKI (vertical type of
BIGFONT).

* 1/4-sized characters will be all converted into half-sized characters.

» Half-sized (1/4-sized) characters written horizontally will be converted
with a relative scale of 1/2 in the X direction, and other size characters
will be converted with a relative scale of 1.

* Both half and full-sized characters written vertically will be converted
with a scale of 1 for their height and width. Therefore, the half-sized
characters will become the same size as the full-sized characters.

* Character types of “Bold” and “Raised” will not be converted.

* Due to font difference and other elements, text will be different from the
Base screen, after conversion.

& Load Mark
e The Mark screen will be retrieved from the screen number, if that screen
exists, the dot pattern will be converted into POLYLINE (CONTINUOUS).

@ Part
* Each Part’s data will be converted into drawing data.
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Chapter 2 - Base Screens

B Converting Base Screen Data to DXF File Data

PROCEDURE

REMARKS

elect the pu own menu |Utility]’s onver-
(1)Sel he pull d [Utility]’s [DXF C

sion] command.

(2)Click on the | FRw>DXF |\ button.

P
-}

DXF<-»PRW Converter

Di=F -» PRW

Bt | | Hep |

(3) Designate the source (Project File) and Base screen | To designate a folder, click on the
number and designate the destination (DXF file). button

File Convert [PRY/> DXF )

Tar

From:

Praject File: |C:\F‘roF‘BWin\Database\Dperation HH Select |

SocreenMo: B ‘1 "

DXF Fie: [DF1 N |[5etect]
|| Corwert | || Cancel | ” Help |

(4) Click on the button and enter the conver-

sion conditions.

File Convert [PRY/> DXF )

From:

Tar

Praject File: |C:\F‘roF‘BWin\Database\Dperation HH Select |

SocreenMo: B ‘1 "

DXF Fie: [DF1 |[5etect]
N
R
|| Corwert | || Cancel | ” Help
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2.11 DXF Conversion

PROCEDURE

REMARKS

(5) After all the attributes have been entered, click on

the button to registered the entered data.

Option [ PRW > DXF )

= Convert Screen Size

<p]
]

= Convert DXF Size-

25 B40n450

® £ B404400
M £ 3205240

£ 8004600

e Parts States

Bit word 4 State Lamp

£ 0f it
£50n D a0
310
2

L Em

(6) Click on the button to start conversion.

File Convert [PRV> DXF ]

Frarm:

Project File: |C:\PrDPBW’\n\Database\Dperation "“ Select |

ScreenNo: B |'I

Ta

DX File: [P24F1

” “ Select |

” Cancel | ”

Help |

(7) After the conversion is completed, click on the
button. The File Convert (GP — DXF) dia-

log box will reappear.

File Convert [PRVf> DXF ]

Frarm:

Project File: JF'IUF'BWin \Database\PROPE2.0. prw‘“' Select |

Screen No: B J1

1

Te

DXF File: |0 1. 24

“ Select

JEompIete

Reading Screen [171objects)
Converting [100%)

"whiting DF [E932lne)
Camplete

|I Correert | | EanceII}J

Help |

(8) Click on the button to quit.

“"‘J DXF<->PRW Converter

DF -» PRW

i

PR -» DiF

2.11.2 W Option
(PRW — DXF)

If the designated DXF file name
already exists, a prompt will
appear, asking whether the new
name should overwrite the old

name. When the button

1s clicked on, the new name will
overwrite the old one, and when

the button is clicked on,

the new name will not overwrite
the old one.

To convert another Base screen,
DO NOT stop here; rather, start
again from step (3).
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p DRAWING APPLICATIONS - CREATIG nd USING SCREENS

‘ : P-PRO/PB III for Windows provides various screens for specific
purposes (for example: for creating marks and messages), in

addition to the Base screens which are the fundamental screen used for all

drawing modes. Other screens can then be loaded onto Base screens as
libraries. Also, you can load them directly onto the GP series panel using

specified tags.

This chapter describes the procedure for creating these screens and their

applications.

K 20 Creating a Mark: the Mark Screen
3.2 ... Creating a Trend Graph: the Trend Graph Screen
K K T, Creating a Keypad: the Keypad Screen

K 25 T Creating an Image: the Image Screen

Text Input: the Text Screen
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3.1 Creating a Mark: the Mark Screen Chapter 3 - Drawing

Creating a Mark: the Mark Screen

Create a mark (dot pattern) on a “Mark” screen. Using the [Draw] menu -
[Load Mark] command, you can load the created mark onto a Base screen,
“Tend Graph” screen or “Keyboard” screen. Also, you can animate the
created Mark screen by specifying the M-tag.

Usage Pattern

Draw a mark

[Screen] a) [New] —s by tuming on/ scar\éz ;r]he Mark
off each dot. '
Click on to open a Mark screen.

General description of the Mark screen:

Editing
Tool Bar 3 [0|@) [+)%] [F] $|elr]2[o)]

_ Tl ] [ on eIl | _t—~ Mark
Drawing = drawing
Tool Bar | area of 48 x

Origin | 48 dots.
Indicates the o : :
. | This areais
size of the e]
] composed
mark loaded a :
]  of 6 (verti-
on the base s
screen (1 x 1) = cal) x 6
= (horizontal)
&l  blocks
(Each
block: 8 x 8
Displays the dots)
current
cursor 2]a]e[B AEE[G[O[HIKIk LN [MN[a[PQTR]S [T ¢ [Tulu U]V WIX]|

23 2027 JReady 8 [AnalLINK] ] [

coordinates,
based on the

origin (0, 0) Screen capacity

B Drawing Tools

The Drawing Tool Bar icons and their corresponding drawing objects are as

follows:
Icon Drawing Tool Description
Dot Specifythe ON/OFF status of each dot by clicking on each
dot or dragging the mouse within a specified area.
Li Specifythe startand end points of a line and draw a line by
ine

clicking on desired points.

Square (Rectangle) Draw a square or rectangle by clicking and dragging to the

Filled square  |desired size on a diagonal axis.
(Filled rectangle)

Circle/Oval Draw a circle or oval by clicking and dragging to the desired

Filled circle size on a diagonal axis.
(Filled oval)

gifslicliclEla
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3.1 Creating a Mark: the Mark Screen

Icon Drawing Tool

Description

[¢a] Fill

Fillin an area with a desired color by clicking in the area
(enclosed within lines and shapes).

E Text

Enter the text to be displayed in the mark drawing area.

Call Up Mark

Library

Selecta Mark from the Mark Library

i Register Mark
= Library

Register a created Mark as a Mark Library.

B Editing Tools

The Editing Tool Bar icons and their corresponding functions are as follows:

lcon Editing Tool Description
Used to delete an entire Mark screen and store itin the
E Cut clipboard*1. Using the [Paste] command, you can then paste
the Mark screen onto another screen.
Used to copy the data of the selected Mark screen in the
Copy .
L clipboard.
— Past Used 1o paste the data temporarily stored in the clipboard
aste
@ onto a desired place.
5 Duplicate Used to duplicate a Mark screen’s specified area.
@ Delete Used to delete a mark.
— Used to cancel the command executed immediately before,
ey Undo , i
and return to the previous condition. (Undo)
a— Used to redo the command canceled with the [Undo]
| Redo
L= command. (Redo)
Used to move the dot pattern synmetrically relative to the
% Mirror X vertical axis. The symmetry axis is the vertical line that divides
' the screen into two equal sections.
_ Used to move the dot pattern symmetrically relative to the
Ap Mirror Y horizontal axis. The symmetry axis is the horizontal line that
divides the screen into two equal sections.
M= Turn ; o
@ counterclockwise Used to turn the mark counterclockwise by 90°.
Turn clockwise  [Used to turn the mark clockwise 90°.
I+ Reverse Used to reverse the white/black area of a mark.
Transparent/ Ifno dots are turned ON in a block (3 x 6 dots), this block
Background color [becomes transparent.

*] When the [Copy] or [Cut] command is used, the copied or cut data is temporarily

stored in the clipboard.

When you use the [Paste] command, the data stored in the clipboard are pasted to

the selected position.
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3.1 Creating a Mark: the Mark Screen Chapter 3 - Drawing

B Mark Drawing Area Structure

The mark drawing area has the following structure. When you edit a mark,
you can use this for your reference.

—— |+ Rotation Center Point

Origin\ %
mN
¥

+4+—|— -

Mirror ¥ Axis

Mirror X Axis

m Drawing a Mark ]

When drawing a mark you can use GP-PRO/PBIII for Windows’ standard
drawing functions. Here, the procedures for using each function are described.

B Drawing with Dots

You can draw a mark by turning ON/OFF each dot. When you click the left
mouse button in the mark drawing area, each dot turns ON (white). When
you click the right mouse button in the mark drawing area, each dot turns
OFF (black).

A mark is created with dots, and displayed in a block (8 x 8 dots). If at least
one dot is turned ON in a block, the whole block is displayed when the
Mark screen is loaded onto a Base screen. In this status, the ON dots are
displayed in the current display color (Fg), and the OFF dots are displayed in
the background color (Bg).

A A
< This dot is ON.
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Chapter 3 - Drawing 3.1 Creating a Mark: the Mark Screen

B Freehand Drawing

PROCEDURE REMARKS

(1)Select the [Draw] menu - [Dot] command, or click on

the icon.

(2)Draw a mark by clicking on each dot or by dragging
the mouse in the mark drawing area.
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3.1 Creating a Mark: the Mark Screen

B Drawing a Line

Chapter 3 - Drawing

PROCEDURE REMARKS
(1) Select the [Draw] menu - [Line] command, or click
on the icon.
(2) Click on a start point in the mark drawing area and
drag the mouse.
(3) Click the end point in the mark drawing area. If you press and hold the key

A line is defined.

in step (2), you can draw a line at
an angle of 0°, 45°, and 90°.

3-6

GP-PRO/PB Il for Windows Ver. 5.0 Operation Manual



Chapter 3 - Drawing 3.1 Creating a Mark: the Mark Screen

B Drawing a Square (Rectangle) or Filled Square (Filled Rectangle)

PROCEDURE REMARKS

(1) Select the [Draw] menu - [Square/Rectangle] or
[Filled Square/Rectangle] command, or click on the

or icon.

(2) Click on a point (a) and drag the mouse on a diago-
nal axis in the mark drawing area.

+
T

(3) Click on the end point (b).

If d hold the [Ctrl| k
A square or rectangle is defined. YOU press and ae’e fe y

in step (2), you can draw a square.

|IENENCEEEEEEEEEEEEEEEEE

_,]II'\JIIIIIIIIIIIIIIIII

=2
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3.1 Creating a Mark: the Mark Screen Chapter 3 - Drawing

B Drawing Circle (Oval) or Filled Circle (Filled Oval)

PROCEDURE REMARKS

(1)Select the [Draw] menu - [Circle/Oval] or [Filled
Circle/Filled Oval] command, or click on the or

icon.

(2) Click on a point (a) and drag the mouse on a diago-
nal axis in the mark drawing area.

i
ta
(3) Click on the end point (b). If you press and hold the[Ctrlkey in
A circle or oval is defined. step (2), you can draw a circle.
a T
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Chapter 3 - Drawing 3.1 Creating a Mark: the Mark Screen

B Filling a Mark

PROCEDURE REMARKS

(1)Select the [Draw] menu - [Fill] command, or click on
the icon.

(2)Click inside the area to be filled.
The specified area will be filled.

If you click on a line, the filling
mode cannot be executed. Be sure
a8 2k to click inside a completely en-
closed area, if you do not, the en-
tire mark screen may be filled.
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3.1 Creating a Mark: the Mark Screen

B Entering Text

Chapter 3 - Drawing

The “Text” mode allows you to enter text on a Mark screen.

PROCEDURE REMARKS

(1)Select the [Draw] menu - [Text] command, or click

on the icon.

(2)Enter character(s) and select either 8 x 16 dot font or

Windows font.

Text

B

£ windaws Font

i I | Cancel 1 | Help

(3)To use the Windows font, click on the and

click on the button.

Font style:

Fegular

=\ | Italic
Bold
Bold [talic

e [ —

AaBbYyZz

Script:

(4)Click on the button.

An outline corresponding to the entered character(s) will

appear.
EE—L

JArlaI Black

]

| I

m " Cancel ) Help
D
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3.1 Creating a Mark: the Mark Screen

PROCEDURE

REMARKS

(5)Move the box to the desired position where the char-
acter pattern will be displayed.
The character pattern is displayed in the position where
you click. A Mark can be created using this pattern.

If you move the character pattern
to a position where another char-
acter pattern has already been cre-
ated, the new pattern will overwrite
the existing pattern, and the exist-
ing pattern will be deleted.
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Chapter 3 - Drawing

m Special Mark Characters ]

B Creating Special Characters on a Mark screen

A

Important

When the European character set has been selected, you can register (create)
any kind of the special character you wish. These special characters are
handled by Mark screens M8001 to M8128, so up to 128 special characters
can be created. The data (characters) on these "special" screens are can then
be inserted into any text string, using special reference codes. For example,
to call up Mark screen M8001's special character, we need to input the
corresponding reference code 80h, and to call up screen M8002, we would
enter 81h, etc. However, since these codes are in Hex format, and in GP-
PRO/PBIII 's text input mode we can only enter decimal data, we need to
use the Hex code's decimal equivalent, shown on the table on page 138.

When any kind of character is "registered" on Mark screens M8001 to
MS8128, the GP will interpret it as a "special" character. Thus, when the GP
encounters one of the abovementioned special reference codes, it automati-
cally searches for the corresponding Mark file. If the file exists (i.e. has been
registered and sent to the GP), it replaces its default GP character with the
special character Mark.

This feature is useful when you need to change the GP's default character
font addresses to match those used by your PC's OS.

* The number of special characters that can be used is limited to
the number of Mark tags available, i.e 128.

* When creating a special character Mark screen, start from
point 0,0 (Base point) and use only two 8x8 dot squares.

Base Point———— 11

B Displaying (Calling up) a Special Character

The method for displaying a registered special character is as follows.

PROCEDURE REMARKS

The character "[1I", previously registered in
Mark screen M8010, will be displayed on the

GP.

(1) Open the Base screen where you want to display
the special character, and click on the icon.

@] [E1 A A EIE

A

L]

K
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PROCEDURE REMARKS

(2) Hold down the [Alt] key and use your PC’s
numeric keypad inputting the ASCII code that

corresponds to the desired Mark screen. '/'\
The (ASCII) character code that corresponds to screen =
Important

M&8010 is 89h, however here, since the code entered

must be decimal, enter the corresponding Input . .
. et since it is only for reference,
code, 235. This should cause the character "€" to will be different from the

o appea;-_ _ N e Wb desired "l11". After the Base
( nelap Pr cation Zf this Sfélcj‘}; O%Lj;{e; CO: eto screen and the Mark file are
place it after the text "GP- - dnthat case, | gant to the GP, the correct

simply enter "GP-PRO/PB" followed immediately character will be

by the Input code) automatically displayed.
(3) After placing this text on the Base screen, saving

the screen, and then sending the data (i.e. the

Base screen and the Mark file) to the GP, instead

of the ""e" character, the Mark screen's "III"

will appear.

The character displayed,

A
] Characters used by the GP may sometimes differ from those
important Used by GP-PRO/PB lll for Windows. Please be sure to check all

characters after they are sent to the GP.

If the corresponding Mark file is not sent with the Base screen
to the GP, the GP will substitute one of its regular characters.
(0x80 to OxFF)

Special characters can not be rotated.

B Character (Reference) Codes
The GP displays characters from the chart shown here. (Code Page 850 character codes)

|81 23456789%abcdef
ISR R R BN EEEREERERERE .
imainnnninnnnnnni 89h=¢
2 LI S A R B
3IB123456789: ; £ = ?
4P A BCDEFGHIJEKL 1]
SIPQRSESTUVUXYZETL N ~
6| abcdef ghid mn o
Plrgr =t uwvwx € ' 3™
Blciiéaaaace@hRiiidd
olJEEds6co0oboy0oidete < F
alaionfnHEeLEB 44 ==
NER B BEEFEELEEREEERE £
cltt s bt-4+adbtpds f=gu
d[EPEEE "III-! rBmiI™
el gdosdprbhPO00ge "~
Fl- =3NS+ _ e .1 3134
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B Hex/Decimal Corresponding Character Codes
When inputting reference codes for special Mark screens, use the chart below.

Mark Char Code Input Code Char Code Input Code Char Code Input Code
Screen | code Page 850 | (ALT+code) | Code Page 850 | (ALT+code) | Code Page 850 | (ALT+code)
M8001 80h 0199 BOh 0130 EOh 0211
M8002 81h 0252 B1h 0131 E1h 0223
M8003 82h 0233 B2h 0132 E2h 0212
M8004 83h 0226 B3h 0133 E3h 0210
M8005 84h 0228 B4h 0134 E4h 0245
M8006 85h 0224 B5h 0193 E5h 0213
M8007 86h 0229 B6h 0194 E6h 0181
M8008 87h 0231 B7h 0192 E7h 0254
M8009 88h 0234 B8h 0169 E8h 0222
M8010 89h 0235 B9h 0135 E9h 0218

8Ah 0232 BAh 0136 EAh 0219
. 8Bh 0239 BBh 0137 EBh 0217
. 8Ch 0238 BCh 0138 ECh 0253
. 8Dh 0236 BDh 0162 EDh 0221

8Eh 0196 BEh 0165 EEh 0175

8Fh 0197 BFh 0139 EFh 0180

90h 0201 COh 0140 FOh 0173

91h 0230 C1h 0141 F1h 0177

92h 0198 C2h 0142 F2h 0159

93h 0244 C3h 0143 F3h 0190

94h 0246 C4h 0144 F4h 0182

95h 0242 C5h 0145 F5h 0167

96h 0251 C6h 0227 F6h 0215

97h 0249 C7h 0195 F7h 0184

98h 0255 C8h 0146 F8h 0176

9%h 0214 C9h 0147 F9h 0168

9Ah 0220 CAh 0148 FAh 0183

9Bh 0248 CBh 0149 FBh 0185

9Ch 0163 CCh 0150 FCh 0179

9Dh 0216 CDh 0151 FDh 0178

9Eh 0128 CEh 0152 FEh 0247

9Fh 0129 CFh 0164 FFh 0160

AOh 0225 DOh 0240

A1h 0237 D1h 0208

A2h 0243 D2h 0202

A3h 0250 D3h 0203

Adh 0241 D4h 0200

A5h 0209 D5h 0153

A6h 0170 D6h 0205

A7h 0186 D7h 0206

A8h 0191 D8h 0207

A9h 0174 D9h 0154

AAh 0172 DAh 0155

ABh 0189 DBh 0156

ACh 0188 DCh 0157

ADh 0161 DDh 0166

AEh 0171 DEh 0204

AFh 0187 DFh 0158
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EXE) Editing a Mark ]

To edit a mark, you can use the following editing functions. This section
describes the operating procedure for each function.

B Cutting a Mark
The “Cut” command deletes the data of the selected screen and stores it in the clip-
board™!. (The deleted screen can be moved to another screen, but cannot be moved
to the original screen.) The “Cut” command can be executed for the entire screen.

PROCEDURE REMARKS

(1) Select the original Mark screen to be cut.
This description assumes that several screens have al-
ready been opened.

(2) Select the [Edit] menu - [Cut] command, or click on To delete the Mark screen, perform

the icon to store the Mark data in the Clipboard. | steps (1) and (2) only.
Data of the original data screen will be cut.

[l M?: Untitiedl

*[ When the [Copy] or [Cut] command is executed, the copied or cut data are temporarily
stored in the clipboard.
When you execute the [Paste] command, the data stored in the clipboard will be pasted
to the selected position.
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PROCEDURE REMARKS

(3) Select the mark screen (destination) to which the se-
lected Mark screen will be pasted.

(4) Select the [Edit] menu - [Paste] command, or click

on the icon.

Data of the Mark screen will be pasted.
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B Copying a Screen

3.1 Creating a Mark: the Mark Screen

The selected screen data are copied in the clipboard. Unlike the [Cut] command, the

original screen data will not be deleted.

ﬁ(k)\te; To copy a mark into the original screen, use the [Duplicate] command.
X2l

PROCEDURE

REMARKS

(1) Select the original Mark screen to be copied.
This description assumes that several screens have al-